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Symbols and definitions

For information on the origin of these symbols, see the Welch Allyn symbols glossary: welchallyn.com/

symbolsglossary.

Documentation symbols

illness, injury, or death.

WARNING The warning statements in this manual identify conditions or practice that could lead to

black and white symbols.

CAUTION The caution statements in this manual identify conditions or practices that could result in
damage to the equipment or other property, or loss of data. This definition applies to both yellow and

WARNING Hot surface. Do not touch.

Etdls

Follow instructions for use (IFU)—mandatory action.

%)

7d
paxtercom A cOpY Of the IFU is available on this website.

A printed copy of the IFU can be ordered from Baxter for delivery within 7 calendar days.

Power symbols

Stand-By

Equipotential Ground

Power plug

Battery absent or faulty

Alternating Current power present, battery fully charged

Battery charge level

Alternating Current power present, battery is charging

Battery

Alternating current (AC)

Rechargeable battery

IMEIEIEIRS

Rated power input, DC

Rated power input, AC

Lithium-ion battery

L
L.
o
S

| &l 0] B %<

Direct current (DC)

Protective Earth (PE)

G,
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2 Symbols and definitions

Connectivity symbols

Connex Spot Monitor

9“—9 Bluetooth®

ﬁ Ethernet

._%' USB

O' Nurse call

m Wireless signal strength

- Best (4 bars)

« Good (3 bars)

« Fair (2 bars)

«  Weak (1 bar)

+ No signal (no bars)

« No connection (blank)

cellaneous symbols

>

Defibrillation-proof Type BF applied parts

Product Identifier

Serial Number

Reorder Number

Mis

I Manufacturer
]
(Rer]

China RoHS markings for control of pollution
caused by electronic information products. XX
indicates Environmentally Friendly Use Period
in years.

@ Do not reuse, Single use device

Separate collection of Electrical and Electronic
Equipment. Do not dispose as unsorted
municipal waste.

((( ))> Non-ionizing electromagnetic radiation

Mg O

Call for maintenance

S Task Light

R, onLY

Prescription only or "For Use by or on the order
of a licensed medical professional”

TT This way up

Fragile
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IPX2 IP = International Protection Marking
X = No object ingress rating

2 = Protected against vertically falling
water drops when enclosure tilted up to

&

Symbols and definitions

Australian Communications and Media
Authority (ACMA) Radio Compliance Mark
(RCM).

3

Japan's PSE approval symbol for

Medical device

15°
/ﬂ/ Temperature limit Global Trade Item Number
% Stacking limit by number ., Keepdry
| l
Humidity limitation "‘ Recyclable

Category A

Atmospheric pressure limitation

s | @

obile stand symbols

™

Maximum safe working load limits Ii

Mass in kilograms (kg)

CAUTION The caution statements in this manual identify conditions or practices that could result in
A damage to the equipment or other property, or loss of data.

Screen symbol

4
i\

Process indicator for activities like acquiring measurements and connecting to a laptop




Safety

All users of the monitor must read and understand all safety information presented in this manual before using
or repairing the monitor.

United States federal law restricts this device to sale, distribution, or use by or on the order of a licensed medical
practitioner.

Warnings and cautions

el B BB DB DPBPPB P

WARNING Safety risk. Make frequent electrical and visual checks on cables, sensors, and electrode
wires. All cables, sensors, and electrode wires must be inspected and properly maintained and in proper
working order to allow the equipment to function properly and to protect patients.

WARNING Safety risk. Place the monitor and accessories in locations where they cannot harm the
patient should they fall from a shelf or mount.

WARNING Fire and explosion hazard. Do not operate the monitor in the presence of a flammable
anesthetic mixture with air, oxygen, or nitrous oxide; in oxygen-enriched environments; or in any other
potentially explosive environment.

WARNING Inaccurate measurement risk. Dust and particle ingress can affect the accuracy of blood
pressure measurements. Use the monitor in clean environments to ensure measurement accuracy. If you
notice dust or lint build-up on the monitor’s vent openings, have the monitor inspected and cleaned by a
qualified service technician.

WARNING Defective batteries can damage the monitor. If the battery shows any signs of damage or
cracking, it must be replaced immediately and only with a battery approved by Welch Allyn.

CAUTION Before disassembling the device or installing options, disconnect the patient from the
monitor, power down the device, and disconnect the AC power cord and any attached accessories (for
example, SpO2 sensors, blood pressure hoses and cuffs, and temperature probes) from the device.

CAUTION Do not exceed the maximum weight limits for your mobile stand with basket or bins. See the
"Specifications" section of the device’s Instructions for use for the basket/bin and mobile stand maximum
weight limits.

CAUTION To ensure that the monitor meets its performance specifications, store and use the monitor in
an environment that maintains the specified temperature and humidity ranges.

CAUTION The monitor may not function properly if dropped or damaged. Protect it from severe impact
and shock. Do not use the monitor if you notice any signs of damage.

CAUTION Do not connect more than one patient to a monitor or connect more than one monitor to a
patient.

CAUTION Do not operate the monitor in the presence of magnetic resonance imaging (MRI) or
hyperbaric chambers.

General safety considerations

« If the monitor detects an unrecoverable problem, it displays an error message. For more information, see
“Troubleshooting.”

« To ensure patient safety, use only accessories recommended or supplied by Welch Allyn. (See the accessories
list in the Appendix of the Instructions for use or https://direct.hill-rom.com/hillromUS/en.) Always use
accessories according to your facility’s standards and according to the manufacturer’s recommendations and
instructions. Always follow the manufacturer’s directions for use.


https://direct.hill-rom.com/hillromUS/en
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+  Welch Allyn recommends that only Welch Allyn service personnel or an authorized repair center perform
warranty service. Performing unauthorized service on a device that is within warranty may void the warranty.

Electrostatic discharge (ESD)

A
A\

CAUTION ATTENTION

SENSITIVE ELECTRONIC DEVICES | |  OBSERVE PRECAUTIONS
DO NOT SHIP OR STORE NEAR STRONG FOR HANDLING
ELECTROSTATIC, ELECTROMAGNETIC, ELECTROSTATIC
MAGNETIC OR RADIOACTIVE FIELDS. SENSITIVE DEVICES

CAUTION Electrostatic discharge (ESD) can damage or destroy electronic components. Handle static-
sensitive components only at static-safe workstation.

& CAUTION Assume that all electrical and electronic components of the monitor are static-sensitive.

Electrostatic discharge is a sudden current flowing from a charged object to another object or to ground.
Electrostatic charges can accumulate on common items such as foam drinking cups, cellophane tape, synthetic
clothing, untreated foam packaging material, and untreated plastic bags and work folders, to name only a few.

Electronic components and assemblies, if not properly protected against ESD, can be permanently damaged
or destroyed when near or in contact with electrostatically charged objects. When you handle components or
assemblies that are not in protective bags and you are not sure whether they are static-sensitive, assume that
they are static-sensitive and handle them accordingly.

« Perform all service procedures in a static-protected environment. Always use techniques and equipment
designed to protect personnel and equipment from electrostatic discharge.

« Remove static-sensitive components and assemblies from their static-shielding bags only at static-safe
workstations—a properly grounded table and grounded floor mat—and only when you are wearing a
grounded wrist strap (with a resistor of at least 1 megohm in series) or other grounding device.

+ Use only grounded tools when inserting, adjusting, or removing static-sensitive components and assemblies.

«  Remove or insert static-sensitive components and assemblies only with monitor power turned off.

« Insert and seal static-sensitive components and assemblies into their original static-shielding bags before
removing them from static-protected areas.

« Always test your ground strap, bench mat, conductive work surface, and ground cord before removing
components and assemblies from their protective bags and before beginning any disassembly or assembly
procedures.



Overview

Purpose and scope

This service manual is a reference for periodic preventive maintenance and corrective service procedures for the
Welch Allyn Connex Spot Monitor. It is intended for use only by trained and qualified service personnel.

Corrective service is supported to the level of field-replaceable units. These include circuit-board assemblies and
some subassemblies, case parts, and other parts.

c WARNING When performing a service procedure, follow the instructions exactly as presented in this
manual. Failure to do so could damage the monitor, invalidate the product warranty, and lead to serious
personal injury.

Q CAUTION No component-level repair of circuit boards and subassembilies is supported. Use only the
repair procedures described in this manual.

Find instructions for functional testing and performance verification in the Welch Allyn Service Tool help files.

This manual applies only to this device. For servicing of any other vital signs monitor, see the service manual for
the specific device.

Service work not described in this manual must be performed by qualified service personnel at the factory or at
an authorized Welch Allyn service center.

Related documents

When using this manual, refer to the following:

« Connex Spot Monitor Instructions for use (on the user documentation CD)
+  Welch Allyn Service Tool:

https://www.hillrom.com/en/services/welch-allyn-service-tool/
«  Welch Allyn Service Tool Installation and configuration guide:

https://www.hillrom.com/en/services/welch-allyn-service-tool/
«  Welch Allyn Braun ThermoScan® PRO 6000 Themometer Instructions for use CD
«  Welch Allyn Braun ThermoScan® PRO 6000 Charging Station Instructions for use CD

«  Welch Allyn 9600 Plus Calibration Tester Directions for use https://assets.hillrom.com/is/content/hillrom/
80020333LITPDFpdf

+  Welch Allyn website: hillrom.com

Technical support services

Welch Allyn offers the following technical support services:

« Telephone support

+ Loaner equipment

« Service agreements

« Service training

+ Replacement service parts
«  Product service

For information on any of these services, go to this site:

https://www.hillrom.com/en/services/.


https://www.hillrom.com/en/services/welch-allyn-service-tool/
https://www.hillrom.com/en/services/welch-allyn-service-tool/
https://assets.hillrom.com/is/content/hillrom/80020333LITPDFpdf
https://assets.hillrom.com/is/content/hillrom/80020333LITPDFpdf
http://hillrom.com
https://www.hillrom.com/en/services/
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Service loaners

For warranty or non-warranty repairs not covered under a support agreement, loaners are available for a nominal
charge, subject to availability. Payment is required prior to shipment for all loaners not covered under a support
agreement. The loaner fee can be found on the Welch Allyn loaner price list.

Welch Allyn Service Centers that provide repair service for this product can, on request, loan a device for use
while the device is being repaired. Loaned devices are provided free of charge for products repaired while under
a support agreement that includes a free loaner provision.

Service options

SmartCare services for maintenance and repair

While product warranties provide basic assurance of Welch Allyn hardware quality, they may not include the
full range of services and support you need. Welch Allyn offers premium service and support through our
SmartCare program. Whether you service your own devices and require a minimum of support or rely on us to
service your device, Welch Allyn provides a program that will meet your needs. A list of available service and
support agreements is presented in the "Field replaceable units" section of this manual.

For more information, call your sales representative or visit our website:

https://www.hillrom.com/en/services/ .

SmartCare Remote Management

SmartCare Remote Management is a secure cloud-based portal that offers biomeds access to manage their
Welch Allyn connected devices remotely in a centralized portal.

For more Information and a complete list of compatibility information, refer to the SmartCare Remote
Management Instructions for use.
Warranty service

All repairs on products under warranty must be performed or approved by Welch Allyn. Refer all warranty
service to Welch Allyn Product Service or another authorized Welch Allyn Service Center. Obtain a Return
Material Authorization (RMA) number for all returns to Welch Allyn Product Service from our website:

https://www.hillrom.com/en/services/explore-our-self-service-tools/repair-status-request/ .

A CAUTION Unauthorized repairs will void the product warranty.

Non-warranty service

Welch Allyn Product Service Centers and Authorized Service Providers support non-warranty repairs. Contact
any Welch Allyn regional service center for pricing and service options.

Welch Allyn offers modular repair parts for sale to support non-warranty service. This service must be
performed only by qualified end-user biomedical/clinical engineers using this service manual.

Service training is available from Welch Allyn for biomedical/clinical engineers. For information, go to this site:

https://www.hillrom.com/en/knowledge/technical-training/ .

Repairs

A Welch Allyn Service Center or Authorized Service Provider must perform all repairs on products under
warranty unless you are a properly certified technician that has successfully completed a Welch Allyn Technical
Training course. More information on Technical Training can be obtained from your sales representative or by
visiting https://www.hillrom.com/en/knowledge/technical-training/.


https://www.hillrom.com/en/services/
https://www.hillrom.com/en/services/explore-our-self-service-tools/repair-status-request/
https://www.hillrom.com/en/knowledge/technical-training/
https://www.hillrom.com/en/knowledge/technical-training/
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& CAUTION Unauthorized repairs will void the product warranty.

Qualified service personnel or a Welch Allyn Service Center should repair products out of warranty.

If you are advised to return a product to Welch Allyn for repair or routine maintenance, schedule the repair with
the service center nearest you.

Welch Allyn Technical Support

If you have a problem with the device that you cannot resolve, call the Welch Allyn Technical Support Center
nearest you for assistance. A representative will assist you in troubleshooting the problem and will make every
effort to solve the problem over the phone, potentially avoiding an unnecessary return.

If your product requires warranty, extended warranty, or non-warranty repair service, a Welch Allyn Technical
Support representative will record all necessary information to issue an RMA number. The support representative
will provide you with the address of the Welch Allyn Service Center to send your device to.

Technical support is available during local business hours.

Returning products

When returning a product to Welch Allyn for service, ensure that you have the following information:

+  Product name, model number, and serial number. This information may be found on the product and serial
number labels on the back housing.

O«

%UDUHDD

|,

« A complete return shipping address.

« A contact name and phone number.

+ Any special shipping instructions.

« A purchase-order number or credit-card number if the product is not covered by a warranty.
« Afull description of the problem or service request.

1. Obtain an RMA number. Either contact Welch Allyn and request an RMA number or visit us on the web:

https://www.hillrom.com/en/services/explore-our-self-service-tools/repair-status-request/.

NOTE Welch Allyn does not accept returned products without an RMA.

2. Ship the device to Welch Allyn, observing these packing guidelines:

a. Remove from the package the battery, all hoses, connectors, cables, sensors, power cords, and other
ancillary products and equipment, except those items that might be associated with the problem.

Recommendations for returning Lithium-ion batteries

Use ground transportation to return batteries.

If returning multiple batteries, package each battery individually.

Do not consolidate multiple batteries in a single package.

Use packaging provided by Welch Allyn or the battery manufacturer.

Do not pack a defective battery in checked or carry-on baggage if traveling by air.

Packaging
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d.

« If you return the battery with the device, remove the battery, seal the battery in an antistatic plastic
bag, and place the battery in the position reserved for the battery near the device in the original
shipping carton.

« If you return the battery separately, package the battery in the replacement battery’s plastic bag and
shipping box.

If the original shipping carton or replacement battery shipping box is unavailable, consult the
manufacturer website for information about shipping Lithium-ion batteries.

& WARNING Safety risk. Do not ship any battery that has been physically damaged or shows

1)

signs of leakage unless you receive specific instructions which meet the requirements for the
shipment of Lithium-ion batteries. Dispose of damaged or leaking batteries in an environmentally
safe manner consistent with local regulations.

NOTE In the United States, the applicable regulations can be found in the Code of Federal
Regulations (CFR). Refer to 49 CFR 173.185 for shipping Lithium-ion batteries by air or ground.
Use 49 CFR 172.102 sections A54 and A101 to find the special provisions for shipping Lithium-ion
batteries.

Clean the device.

NOTE To ensure safe receipt of your device by the service center and to expedite processing

and return of the device to you, thoroughly clean all residues from the device before you ship it to
Welch Allyn. For decontamination and cleaning requirements, see: Decontamination and cleaning
requirements for returns in the Cleaning requirements section.

If a returned device is found to be contaminated with bodily fluids, it will be returned at

the owner’s expense. United States federal regulations prohibit the processing of any device
contaminated with blood-borne pathogens. Welch Allyn thoroughly cleans all returned devices
on receipt, but any device that cannot be adequately cleaned cannot be repaired.

Put the device, enclosed in a plastic bag with a packing list, into the original shipping carton with the
original packing materials or into another appropriate shipping carton.

Write the Welch Allyn RMA number with the Welch Allyn address on the outside of the shipping carton.

Recommended service intervals

To confirm that the device is functioning within the design specifications, perform periodic service as indicated
in the following table. Customers who have the Standard unlicensed edition of the Welch Allyn Service Tool
can perform the basic functional verification and calibration procedures referenced in the table by following the
instructions in this manual.

Component Service interval Service procedure
NIBP module Annually Basic functional verification
SpO2 module Annually Basic functional verification
SureTemp Plus Annually Basic functional verification
Braun ThermoScan®PRO 6000 Annually ! Basic functional verification
Battery Annually? Replace the battery
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Component Service interval Service procedure

1 In addition to this annual service interval, Welch Allyn recommends cleaning the contacts of the Braun
thermometer and dock every 4 months because debris that accumulates in the contacts can interfere with
data transmission. See "Clean the Braun ThermoScan®PRO 6000 contacts" later in this manual.

2 Battery performance is a function of clinical use and charge/discharge patterns. Welch Allyn recommends
replacing the battery after 1 year or when its remaining capacity no longer meets workflow requirements.

If you have the Gold edition of the service tool, use the tool to perform a complete functional verification and
calibration of the device in lieu of performing the basic tests. Perform a complete functional verification and
calibration of the device whenever any of the following conditions exist:

« The device does not meet specifications (based on the basic functional verification)
« The device has been dropped or otherwise damaged

+ The device is malfunctioning

« The case has been opened

« Aninternal part has been replaced (battery excluded)

:'1] NOTE For instructions on using the Gold edition, see the Service Tool help files.

Maintenance

For device maintenance information, see “Maintenance and service” in the device’s Instructions for use. This
section covers the following topics:

« Perform periodic checks

+ Replace the monitor battery

+ Replace the APM work surface battery
+ Cleaning requirements

EII NOTE Service-related cleaning is addressed in the service manual as well.

The Welch Allyn Service Tool

The Welch Allyn Service Tool is available in the following editions:

« Standard unlicensed: Accompanies your device.
« Gold: Required to perform complete functional verification and calibration. This edition requires an additional
license. For more information about acquiring this license, contact Welch Allyn.

gl NOTE To qualify for the Gold license, you must attend the Welch Allyn technical training course or
complete online training for the device.

Clinicians and technical service personnel can use the service tool to manage and maintain supported Welch
Allyn products. You can use the service tool to do the following:

+  Review device information. When connected to the device, the service tool lists installed modules, installed
firmware and hardware versions, warranty and repair information, status, and usage history.

+  Receive notifications when periodic maintenance is needed. The service tool can help you manage and maintain
your entire inventory of supported Welch Allyn products. Through the remote service function, the service
tool can connect to Welch Allyn Customer Service. With this functionality you can automatically receive
firmware updates and feature upgrades for your supported products, including software upgrades for the
service tool.

« Install updates and upgrades. The service tool can read the firmware version for each module and check for
available updates or upgrades.
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i:_l] NOTE For the Welch Allyn to support updates and upgrades, adjust your firewall settings to permit

access for IP address 169.254.10.10 (the local feed server for the software upgrade process).

« Create a work list. The work list provides information about service actions—referred to as work orders—that
are waiting for you to perform on your maintained devices. Work orders may include periodic calibrations,
upgrades, or license installations.

« Schedule periodic maintenance. You can use the service tool to set the service interval for each maintained
device.

« View and save logs. You can download and save log files from the device for analysis to help diagnose and
identify reported issues.

«  Create user accounts. Administrators can create user accounts and set permission levels to control access
to the features, allowing one group to perform administrative tasks and another to perform service tasks.
Restricting access prevents the service tool from being used to make unauthorized changes on a connected
device.

«  Perform functional verification and calibration. The service tool can check any device requiring calibration and,
if necessary, calibrate the device to match the design specifications. This feature is not supported for all
products and requires the service tool, Gold edition, for each supported product.

«  Recover devices. In the rare case where a device can no longer boot because of corrupted firmware, the
service tool can connect the device to Welch Allyn Technical Support to reinstall the firmware.

« Extensible. The service tool software accepts new plug-ins to support future Welch Allyn products.

Some of these features are enabled for any user (Standard unlicensed edition). Others require special user
account privileges or a Welch Allyn service contract (Gold edition). If you require gold-level support for a Welch
Allyn product, please contact Welch Allyn technical support.

Battery performance
About the batteries

The device uses a rechargeable, 2-cell, Lithium-ion smart battery supplemented by an optional, rechargeable,

9-cell Lithium-ion battery in the Accessory Power Management (APM) work surface. Internal circuitry enables the
batteries to report their condition to the device and the APM work surface. The device displays the battery status
via the LED power indicator, icons on the screen, and status messages appearing in the Device Status area of the
display. The APM battery indicates the percent of total charge to user on the front of the work surface as follows:

Number of LEDs Percent of total charge

1 0-19

20-39

40 -59

80-95

2
3
4 60-79
5
6

96 - 100

The battery status indicator on the device displays the remaining total charge of both batteries combined if the
configuration has both an internal battery and an extended battery in the APM.

Battery information may be collected using the service tool.

New batteries are shipped from the manufacturer with a 40 percent charge to extend shelf life. After installing
a new battery in the device, you must plug the device into AC power to wake up the battery. If AC power is not
applied to the device, the new battery appears discharged.
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The Device Status area displays a low-battery status message when 30 minutes of power remain and again when
5 minutes remain. The 30-minute message is a very low priority technical alarm. The alarm message appears on
a cyan background in the Device Status area. This alarm is dismissable by the user, and all functions of the device
remain available. The 5-minute message is a high priority technical alarm that appears on a red background in
the Device Status area, is not dismissable, and prevents acquiring vitals measurements or performing any other
function until the device is plugged in to AC power.

If AC power is not applied to the device after it triggers the high priority technical alarm, the device will shut
down at or close to 0 minutes of remaining battery charge.

Battery charging is provided by the device’s power supply. The power reserve threshold is determined by the
device's software.

For a complete list of battery specifications, see the device’s Instructions for use.

Follow best practices to extend the life of the battery

The following practices help to extend the life of the battery and the device.

WARNING Safety risk. When handling and storing Lithium-ion batteries: Avoid mechanical or electrical
abuse. Batteries may explode or cause burns if disassembled, crushed, or exposed to fire or high
temperatures. Do not short or install with incorrect polarity.

«  Whenever possible, keep the monitor plugged in to charge the battery.
Remove the battery when storing the device for an extended amount of time.
« Replace batteries that trigger a low battery status message when fully charged.
« Do not use damaged or leaking batteries.
- Store batteries with a 30 to 50 percent charge.
Store batteries within the temperature range indicated for each period:

°  For storage less than 30 days: Maintain temperature between —4 °F and 122 °F (-20 °C and 50 °C).

> For storage between 30 days and 90 days: Maintain temperature between -4 °F and 104 °F (-20 °C and 40
°Q).

> For storage more than 90 days up to 2 years: Maintain temperature between -4 °F and 95 °F (-20 °C and
35°QC).

+ Recycle batteries where ever possible. In the United States call 1-877-723-1297 for information about
recycling your Lithium-ion battery or go to the Call2Recycle website at http://www.call2recycle.org for
additional information.

When recycling is not an option dispose of batteries in an environmentally safe manner consistent with local
regulations.

Factors affecting battery operating time

The following table presents settings and conditions that affect the battery operating time and
recommendations to maximize battery life.

Setting / Condition Recommended setting
Display brightness setting 5
Sleep mode setting 1 minute

Automatic power-down setting 15 minutes
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Controls, indicators, and connectors

:_'1] NOTE Your model might not contain all of these features.

Front-Left view

No. Feature Description
1 LCD screen 7" color touchscreen provides a graphical user interface
2 Thermometry Secures the SureTemp unit to the monitor
3  Battery charge and The LED indicates the charging and power-up status when connected to AC
power-up status power:
indicator + Green: The battery is charged
«  Amber: The battery is charging
+ Flashing: The monitor is powering up
4 Power button Blue button on lower-left corner of the monitor:

- Powers on the monitor

« Places the monitor into Sleep mode, except when an alarm condition is
active (brief press)

+  Wakes up the monitor from Sleep mode
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Back-Bottom-Left view

No. Feature

Description

1 Battery compartment (behind

Houses the battery (captive screw secures cover to monitor)

cover)
2 NIBP Connects NIBP cable to monitor
3 USBclient port Provides a connection to an external computer for testing and software
upgrades
4  USB port Connects APM work surface to monitor
5  Power connection Connects APM work surface or any accessory to the monitor
6  Ethernet RJ-45 Provides a hardwired connection to the computer network
7 Nursecall Provides a connection to a hospital nurse call system
8 SpO2 Connects chosen SpO2 system to monitor
9  Thermometry Configuration shown features SureTemp module and probe connection

port

APM

This section applies only to devices with an Accessory Power Management (APM) stand. The APM is an accessory
stand with work surface, power supply for enhanced device run time, and organizational bins to arrange sensors

and cables for available parameters.
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Controls, indicators, and connectors
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Front-Top-Left view

15

No. Feature

Description

1 Battery compartment (behind cover)

Houses the battery

2 Battery charge status indicator

Indicates charge level of battery

3 Light power switch

Powers light under APM work surface

Back-Bottom-Right view

No. Feature Description

1 USB ports (2) Connect optional accessories

2 USBcable Connects APM work surface to monitor

3 APM power cable Connects APM work surface to monitor

4  Power connection Provides an external AC power connection

5  Ground lug (equipotential terminal) Provided for electrical safety testing and for connecting a potential-

equalization conductor
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Controls, indicators, and connectors

Connex Spot Monitor

No.

Feature

Description

Recess for mounting

Secures the APM work surface when it is mounted on the APM stand
(with 4 screws)

Battery cover screw

Secures APM work surface battery cover

APM light

[lluminates accessory bins and path for APM stand
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Advanced settings

Advanced settings provide access to device settings and service menu information with an access code. This
section covers the following primary tabs:

+ General. Settings for system language as well as date and time, plus open source software disclosure.

« Parameters. Settings for physiological parameters, averaging, and intervals.

«  Network. Settings for the internal Ethernet and security, as well as WiFi radio and Bluetooth subsystems.
Service. Settings and features that support installation and on-device troubleshooting.

:-‘l NOTE Changes made in Advanced settings take effect immediately, but they do not change the

T configuration file and cannot be used to clone settings from one device to another. Follow the
instructions in "Device configuration and setup" to create, edit, download, and install any settings you
want available on multiple devices.

Access Advanced settings

"l] NOTE You cannot access Advanced settings if sensors or physiological alarms are active or if vital sign
measurements are displayed.

NOTE Create or change your advanced settings passcode using the Configuration Tool per the device
configuration and setup instructions in this manual.

—_

From the Home tab, touch the Settings tab.
2. Touch the Advanced vertical tab.
3. Enter your advanced settings password as the access code and touch OK.

é_l NOTE This access code is configurable and could be different at your location. Welch Allyn
recommends changing the default password.

The General tab appears.
4. Perform service tasks by making selections or touching other tabs.

-
?_I] NOTE Service tasks and how to do them are detailed in this section.

5. When you are done, touch Exit.

The Home tab appears.

General tab
Specify the language

When you first access Advanced settings, the General tab appears, displaying the Language tab.

1. Selectalanguage.
2. Do one of the following:

+ To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.

Specify profile settings

Profiles support multiple clinical workflows.
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CAUTION Switching from the Office profile drops the Bluetooth® connection. Switching to the Office
profile clears both patient information and current readings. Switching to another profile retains
patient information, but current readings are cleared.

1. In Advanced settings, touch the General > Profiles tabs.
2. Specify settings.

Setting Action/Description

Profile types Select the profile types to display: Intervals, Office, and Spot.
Primary profile Select the primary profile.

Custom profile name If desired, modify the profile names.

3. Touch Apply.
4. Do one of the following:

+ To continue in Advanced settings, touch another tab.
To exit Advanced settings and return to the Home tab, touch Exit.

Specify date and time settings

1. In Advanced settings, touch the General > Date / Time tabs.
2. Specify settings.

Setting Action/Description
Date format Select a date format for display.
Time zone Displays UTC time zone (read only)

Enable NTP (Network Enable the monitor to query the correct date and time from a trusted time server.
Time Protocol) When enabled, manual date and time entry on the Settings tab is disabled.

Touch the keyboard in the Domain field and enter up to 20 characters and then
touch OK.

3. Touch Test network connection.

Test results appear for the Time sync test, IP address, and DNS query status.
4. Touch OK..
5. Do one of the following:

« To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.

Review the open source software disclosure

1. In Advanced settings, touch the General > Open Source tabs.
2. Read Welch Allyn's disclosure about its use of "free" or "open source" software.
3. Do one of the following:

« To continue in Advanced settings, touch another tab.
To exit Advanced settings and return to the Home tab, touch Exit.
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Parameters tab

Specify advanced NIBP settings

1. In Advanced settings, touch the Parameter > NIBP tabs.

2. Specify settings.

Setting Action/Description
Defaultview  Select default primary and secondary views.
+ SYS/DIA as primary
+ MAP as primary
SYS/DIA only
Unit of Select the NIBP unit of measure for display.
measure . kPa
mmHg
Tube type Select the number of tubes that are connected to the NIBP cuff that is used with this
monitor. If you select Single, the device sets the algorithm to Step, disabling other options.
« Single
- Double
Algorithm Select the default algorithm used to determine NIBP measurements.
default . SureBP
+ StepBP

If SureBP is selected, the device inflates the cuff to the appropriate level, measuring the
blood pressure as the cuff is inflating. The systolic display shows the pressure in the cuff as
the blood pressure determination is in process. If StepBP is selected, the device will inflate
the cuff, then measure the blood pressure while deflating the cuff. If the device is unable to
determine a blood pressure while the cuff is inflating due to patient movement, excessive
noise, or an arrhythmia, the device will use the StepBP algorithm to inflate the cuffto a
higher pressure, then attempt to measure the blood pressure while deflating the cuff.

The default NIBP algorithm is SureBP.

3. Do one of the following:

« To continue in Advanced settings, touch another tab.
To exit Advanced settings and return to the Home tab, touch Exit.

Specify advanced temperature settings

1. In Advanced settings, touch the Parameter > Temperature tabs.

2. Specify settings.

Setting

Action/Description

Unit of measure

Select primary units of measure for the temperature display on the Home tab
. °F
. °C
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Setting Action/Description
Display temperature Enable to display primary units of measure and secondary units of measure for
conversion the temperature display on the Home tab.

3. Do one of the following:

+ To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.

Specify advanced averaging interval settings

Averaging intervals are available in the Office profile.
1. In Advanced settings, touch the Parameter > Averaging tabs.
2. Specify settings.

Setting Action/Description

NIBP averaging program Select the averaging program to view or modify. You can change the name of the
averaging program.

Readings to average Select which readings in a series to use for averaging (and the number of readings
to average as a result).

Delay to start (minutes) Enter the number of minutes to wait before the averaging program starts (after
touching "Start intervals") and the start of the first reading.

Time between (minutes) Enter the number of minutes to wait between readings.

Keepif + or- (mmHg)  Enter the range that the program uses as criteria to accept or reject readings and
establish the baseline reading.

Summary display box Displays currently selected settings.

3. Do one of the following:

« To continue in Advanced settings, touch another tab.
To exit Advanced settings and return to the Home tab, touch Exit.

Specify advanced program interval settings

1. In Advanced settings, touch the Parameter > Program tabs.
2. Specify settings.

Setting Action/Description

Program Select the program to view or modify. You can change the name of the program.

Intervals Specify up to five sets of interval readings for this program. For each set, specify the number
of minutes between interval readings and the number of times that each interval should run
(repetitions) before proceeding to the next set.

3. Do one of the following:

+ To continue in Advanced settings, touch another tab.
To exit Advanced settings and return to the Home tab, touch Exit.
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Network tab
Specify radio settings

This task is applicable only to monitors that have a wireless radio installed. Devices can be configured with a
wireless or a Bluetooth radio.

1. In Advanced settings, touch the Network > Radio tabs.
2. Specify settings.

Setting Action/Description

Enable radio Enable the radio for WiFi communications. When disabled, the radio is not available.

ESSID Enter the service set identifier (SSID) for the enterprise. Enter a maximum of 16
characters.

Radio mode Select the radio band.

Dynamic Frequency  Enable to allow the site to transmit data on changing frequencies for added security.
Selection This option applies most frequently to military or government enterprises.

Enable radio network Activate radio network alarms when an wireless dropout alarm condition occurs.

alarms When disabled, radio network alarms are not available.

Roaming Select the type of roaming (only available with WPA/WPA2 Enterprise).
Regulatory Display the WiFi regulatory certification information.

Update radio Touch Update radio to activate all new radio settings not selected previously.

Touch OK in the confirmation popup.

%—_l] NOTE None of the changed radio settings take effect until you touch
Update radio.

3. Do one of the following:

To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.

Specify security settings

1. In Advanced settings, touch the Network > Security tabs.
2. Select the encryption method to secure data transfer from the device.

:;_I] NOTE Network server certificates are required for all EAP security options. Use the Welch Allyn
Service Tool to load these certificates.

3. Select the preferred encryption option. Then specify any additional settings that appear. The default is
WPA2-Personal.

Setting Action/Description

Authentication type Select the preferred encryption option. Then specify any additional settings
that appear. The default is WPA2-Personal.

WPA-Personal and WPA2-  Enter a Passphrase (8 to 63 characters). The characters you enter appear as
Personal asterisks. Then click Update radio.

WPA-Enterprise and Specify the following settings and then click Update radio.
WPA2-Enterprise
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Setting Action/Description

Anonymous identity Enable this option to disable the User name field.

User name Enter the EAP identity (maximum of 32 characters). This is disabled EAP type
TTLS.

Password Enter the EAP password (maximum of 32 characters). This is disabled EAP type
TLS.

Enable server validation ~ Enable or disable server validation. This is disabled EAP type PEAP-TLS.

EAP type Select the authentication protocol (TLS, TTLS, PEAP-MSCHAPv2, PEAP-GTC,
PEAP-TLS, EAP-FAST).

Option Select more specific EAP settings (Inner EAP Setting: Auto or PAP, PAC
Provisioning: Auto or Manual).

Update radio Touch Update radio to activate all new radio settings not selected previously.

Touch OK in the confirmation popup.

%__I] NOTE None of the changed radio settings take effect until you touch
Update radio.

Enable FIPS mode Select Enable FIPS mode if you are connecting to a FIPS environment. Check
the Enable FIPS mode box, and then touch Update radio.

4. Do one of the following:

To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.

Specify server settings

m NOTE If the IP address and the TCP/IP port are not set up correctly, new downloads, new configurations

and new firmware will fail to load. When this failure occurs, there is no alert or error message and the
system will appear to be connected and synchronizing, but your connection and download will not
complete. If this happens, go into your IP port configuration settings and ensure that your IP address is
correct and that it is connected to the correct TCP/IP service host port 281.

1. In Advanced settings, touch the Network > Server tabs.
2. Select the method used to identify the IP address of the server with which the device will communicate.
3. Specify settings.

Setting Action/Description

Network Select the preferred method to connect to the server.
connectivity

method

Data encryption Turn the security data encryption on or off, and enable or disable the server
authentication.

Server Turn the server authentication on or off.
authentication

Host IP Enable the device to connect to a host or other server at a fixed IP address. In the
IP address entry field, enter the IP address. In the Port entry field and enter the port
number. The range of entry is 0 to 65535. Select either a Welch Allyn host or a direct
EMR connection.
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Setting

Action/Description

NRS

Enable the device to connect to a Network Rendezvous Service (NRS) at a fixed IP
address. In the IP address entry field, enter the IP address. In the Port entry field and
enter the port number. The range of entry is 0 to 65535.

DNS hostname

Enable the device to connect to a Network Rendezvous Service (NRS) by entering a
hostname to be sent to a Domain Name Server (DNS) to retrieve the NRS IP address. In
the Hostname field, enter the DNS name. In the NRS Service Port entry field, enter the
port number. The range of entry is 0 to 65535.

:;_l] NOTE The DNS option is only available in the following conditions:

- Theradiois disabled
« Noradiois installed

DHCP

Enable the device to connect to a Network Rendezvous Service (NRS) by entering a
port number and then connecting at a provided IP address. In the NRS Port entry field,
enter the port number. The range of entry is 0 to 65535. After successfully connecting
to the server, the NRS IP addresses and the Vendor class identifier appear onscreen.

Server connectivity Select the preferred server connection:

+  Welch Allyn host
« Direct EMR connection

4, Touch Test network connection.

The status of the server connections appears.

5. Touch OK.

6. Do one of the following:

+ To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.

Specify Bluetooth settings

This task is applicable only to monitors that have a Bluetooth radio installed. Devices can be configured with a
wireless or a Bluetooth radio. A configuration must be loaded to view regulatory information.

1. In Advanced settings, touch the Network > BLUETOOTH tabs.

2. Specify settings.

Setting

Action/Description

Allow Bluetooth
configuration

Enable the device to connect to a host or other server with the Bluetooth
radio.

+ Bluetooth
If enabled, Bluetooth Low Energy

Device name

Enter the 8-character device name.

Regulatory

Displays the Wi-Fi® regulatory certification information.

3. Do one of the following:

« To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.
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Specify device IP settings

A radio card must be installed and operational to specify the device IP settings.

1. In Advanced settings, touch the Network > Device IP tabs.
2. Specify settings.

Setting Action/Description
Ethernet Select Use DHCP or Static ID.
IP address If Static ID is selected, specify these settings.

Subnet mask

Gateway

DNS IP address Enter the IP address of the DNS server.

3. Touch Apply.
4. Do one of the following:

« To continue in Advanced settings, touch another tab.
To exit Advanced settings and return to the Home tab, touch Exit.

Specify Active Directory settings
Use the Active Directory settings to manage the device communication address and access settings.

EI NOTE See "Connex Direct" for further information.

1. In Advanced settings, touch the Network > Active Directory tabs.
2. Select Enable Active Directory.
3. Specify settings.

Setting Action/Description

Domain name Enter the domain name.

Group Enter the domain name group.

Clinician ID type Select the clinician ID type (User name, Account name, or Employee ID.

Authentication user name Enter the user name.

Authentication password Enter the password.

Search subtree Enter the subtree alpha-numeric characters.

4. Touch Test network connection.

The device displays the Active Directory test status.
5. Click OK.
6. Do one of the following:

« To continue in Advanced settings, touch another tab.
« To exit Advanced settings and return to the Home tab, touch Exit.
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Service tab

Ethernet status

In Advanced settings, touch the Service > Ethernet status tabs. This Ethernet status vertical tab displays
read-only data about the Ethernet connection:

Network

- MAC address
IP address

«  Subnet mask

+ Gateway

«  DHCP server
DHCP lease time

Network statistics

Rx bytes
«  Txbytes
«  Rxpackets
«  Tx packets
Rx multicast packets

Errors
Rx errors
« Txerrors

+ Rx packets dropped
«  Tx packets dropped

Radio status

In Advanced settings, touch the Service > Radio status tabs. This Radio status vertical tab displays the following
read-only data about the Wi-Fi or Bluetooth radio connection:

Network

«  MAC address

« [P address

- Subnet mask
Gateway

« DHCP server
« DHCP lease time

Network statistics

+  Rxbytes
«  Txbytes
Rx packets

«  Tx packets
«  Rxmulticast packets

Errors

« Rxerrors
« Txerrors
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«  Rx packets dropped
«  Tx packets dropped

Radio settings

« Version
+ Radio status string
- SSID

+  Access point MAC
+ Authentication type
RSSI

» Radio band

«  Channel

«  Power mode
FIPS mode

If the device cannot communicate with the radio through the internal radio IP address, the radio error 35002c
appears. A Mac address text field appears on the Radio status tab approximately three to four minutes after the
error message. Contact Welch Allyn for assistance in entering the correct Mac address in this field.

Enter general device information

1. In Advanced settings, touch the Service > General tabs.

2. Touch =====|and enter up to 20 characters in the following data fields to support device identification:

Asset tag
- Device location
- Device location ID

3. If desired, select Allow Display Lock.

The display lock prevents clinician input, which may be useful when cleaning the display.
4. If desired, select Disable USB ports.
5. Touch OK and repeat for each data field.

The General vertical tab appears.

5:_I] NOTE You can enter general device information in the Welch Allyn Service Tool as well.

6. To calibrate your touchscreen, touch Start in the right pane and follow the onscreen prompts.

The Home tab appears.

7. To synchronize with the Service Monitor, touch Sync now.
If the software version is 1.30 or greater, the screen displays information about the connection and whether a
new configuration or firmware is available.

8. Touch Close.

9. To verify the NIBP pressure valve accuracy, touch Close Valve.
The pressure displays in the NIBP Pressure Verification field. If the software version is 1.33 or greater, you can
check the functionality of NIBP accuracy on the device without use of the Welch Allyn Service Tool.

10. To stop the accuracy test, touch Open Value or navigate away from the screen.
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Review and update configuration information

1. In Advanced settings, touch the Service > Config file tabs.

i:_l] NOTE Loading the Config file sets the initial configuration. However, manually changing settings on
the device, overrides the configuration file settings.

2. Inthe left pane, review the following configuration information:
« Configuration file
« Active Config file name
Date of generation
+ Date loaded to device
« Supported features (examples include: RRp, Bluetooth Low Energy)
+ Licensed features (examples include: Bluetooth Low Energy, RRp)

3. Toload a new configuration from the network, touch Load in the right pane and follow the onscreen
prompts.

4. To save the current configuration to a USB drive, connect a compatible flash drive to the USB port, touch
Save to USB in the right pane, and follow the onscreen prompts.

55'1] NOTE Not all flash drives are supported. See "USB flash drive requirements" in the Appendix for
details.

Save service logs to a USB flash drive

This procedure enables you to save the last 14 active log files to a USB flash drive.

:-‘I NOTE The Welch Allyn Service Tool enables you to save only the 2 most recent log files.

1. In Advanced settings, touch the Service > Log file tabs.
2. Connect a flash drive to the USB port.

55'1] NOTE Not all flash drives are supported. See "USB flash drive requirements" in the Appendix for
details.

3. Touch Save to USB and follow the onscreen prompts.

Copies of the service log files are saved to the drive.

Restore factory default settings

El] NOTE This process does not restore the monitor to a custom configuration provided at delivery. Instead,
T it deletes all custom configuration data and restores factory default settings.

1. In Advanced settings, touch the Service > System tabs.
2. Reset to defaults:

« To restore radio settings to factory default values, select Radio settings only.
« Torestore all current settings to factory default values, select All settings.

3. Touch Reset and follow the onscreen prompts.
The factory default settings are restored.
If you selected Radio settings only, the radio reboots, and the device remains powered on.

If you selected All settings, the device reboots.
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Review firmware status and load firmware from the network

1. In Advanced settings, touch the Service > System tabs.
2. Intheright pane, review the firmware status information.

i:ﬂ NOTE If the firmware is up-to-date, take no further action.
3. To update the firmware, touch Load and follow the onscreen prompts.

::'1] NOTE You can also load new firmware by rebooting the device.
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Power-up sequence

Overview

The system performs a power-on self test (POST) of the software and internal hardware each time the device is
powered on. Specific tests performed include the following:

+  CVC-PIC tests

+ LED power tests

+  eMMC (memory) tests
EEPROM tests

If all tests are successful, the system completes power up and the user interface screen for the default
configuration appears (either the Home tab or a login/profile selection screen), and the system is ready for
operation.

If the self-check fails, an error message and an error code appear in the system status area at the top of the
screen to aid service personnel and engineers in diagnosing the problem. If a fault that could adversely affect
the product is detected, the system enters a safe mode and stops all monitoring functions. The system remains

in safe mode until it is turned off by pressing (I) or until the device shuts down automatically after a period of
inactivity.
To perform the POST:

1. Disconnect any patient cables connected to the system.
2. Insert a fully charged battery into the system.
3. Upon each power up, confirm the following:
a. The buzzer generates a sound.
b. A startup screen appears briefly and then disappears.
c. The power button flashes until the Ul is ready.
d. A beep sounds, followed by one chime.

é_l NOTE If no chimes sound, replace the speaker as specified in "Separate the speaker nest from the
NIBP pump tray" and “When reinstalling the speaker”

e. The Home tab or the login/profile selection screen appears.
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Bluetooth wireless technology

:_'1] NOTE Your model might not contain all of these features.

Bluetooth wireless technology is available in the Office profile.

Bluetooth status

A monitor with Bluetooth wireless technology displays the status between the monitor and the device in the
Status area.

Image Description

No image Bluetooth radio is OFF

Bluetooth icon appears in Status area Bluetooth radio is ON

Bluetooth icon is blinking on / off slowly The monitor is pairing with the device

Bluetooth icon is blinking on / off quickly The monitor is connecting with the device
Bluetooth icon appears with a border around the The monitor and the device are connected and the
icon in the Status area monitor is ready to transmit data

In order to transmit data, you must first pair and then connect the monitor and the device.

Enable Bluetooth pairing

You can pair a device and a PC configured with Bluetooth wireless technology.

1. In Advanced settings, touch the Network > BLUETOOTH tabs.
2. Touch Allow BLUETOOTH configuration to enable pairing.

Pair a device with Bluetooth wireless technology

When a monitor with BluetoothBluetooth wireless technology powers on and there are devices already paired
with the monitor, a pop-up screen appears showing the devices available for connection with the monitor.
Follow the directions below to pair an additional device with the monitor.

1. Touch * .

2. Touch Add new device.

3. For a laptop, select the monitor from the list of available devices in your Bluetooth program manager on
your laptop task bar.

fl NOTE For a tablet, select the monitor (WACSM device) from the list of available devices in your
Bluetooth program manager on your tablet. A message appears on the monitor that indicating
that "This device is now discoverable" and a confirmation number displays on both the device and
monitor screens. Touch Pair in the tablet device.



Service manual Bluetooth wireless technology 31

4, Confirm that the numbers match on the device and on the monitor, and then touch Accept in the laptop
device.

A message appears indicating that the monitor and device are paired.
5. Touch OK on the monitor screen.

Touch the keyboard icon in the Name this connection: field and begin to type the name to a preferred name
of the device.

6. After preferred name is entered, touch Save.

The new name appears in the Bluetooth device list of paired devices.

Connect devices with Bluetooth wireless technology and
download data

1. Inthe Bluetooth connection screen, select a laptop from the list of paired devices.

The Bluetooth icon in the Device Status area quickly blinks on and off as the monitor and laptop are
connecting.

When the monitor and the laptop connect, an information message briefly appears that names the
connected laptop. When the message disappears, the name of the connected laptop appears on the top
left of the screen, and the Bluetooth connected icon appears in the connection area.

2. Asthe laptop downloads data, the progress indicator spins in the connection area.
The Bluetooth connection remains active until the download is complete. After a successful download, the
system clears data from the monitor and disconnects the monitor from the laptop.

3. Repeat the process as needed, or touch Cancel to dismiss the Bluetooth connection screen.

Rename a device (applies only to standard Bluetooth)

You can rename a paired device from a system or generic name to a specific name.
1. Select the arrow button to the right of the device name you want to edit in the Bluetooth device list.

Touch the keyboard icon in the Name this connection: field and begin to type the name to a preferred name
of the device.

2. Enter the name, touch OK on the keyboard screen, and then touch Save.

The new name appears in the list of paired Bluetooth device list.

Bluetooth Low Energy (BLE) workflow

For more information, contact your sales representative.

Use the Welch Allyn Product Configuration Tool (version 1.9.0, or later) to allow and enable the Bluetooth Low
Energy (BLE) connection and update the Connex Spot Monitor (monitor) configuration file.

Refer to the “Advanced Settings” instructions on how to allow the Bluetooth Low Energy configuration.

1. Power on the Connex Spot Monitor.
2. Open the mobile application on the device. A list of Vitals devices appears.

3. Ifthis is the first time connecting the mobile device with the Connex Spot Monitor, select the vitals device in
the mobile application.
a. The Bluetooth Pairing request prompt appears: "WACSM... would like to pair with your ..."
b. Pair the device and the Connex Spot Monitor by touching OK on the Connex Spot Monitor at the prompt,
"A Bluetooth Low Energy device is attempting to connect.”
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¢. Atthe pairing confirmation screen, touch Pair on the mobile application.

The mobile application home screen appears.
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Disassembly and repair

These procedures provide instructions for device disassembly and board removal, as well as component
replacement and reassembly.

Each part’s disassembly instructions might include one or both of the following:

+ Reassembly notes: This subsection contains information specific to reassembly. At a minimum, these notes
indicate whether or not reassembly is the reverse of disassembly. The notes also list service kits of
replacement parts where applicable.

« When replacing the component: This subsection contains additional instructions related to installing a new
option or replacement part.

Each disassembly step includes drawings that illustrate the components to be removed. The reassembly notes
could be as short as one or two lines when reassembly is the reverse of disassembly. When reassembly is

more complicated, these notes alert you to any special care required to complete the repair or installation and
sometimes introduce separate reassembly instructions. Line drawings appear in the reassembly notes only when
they differ from the drawings in the disassembly instructions.

>

B> BB

WARNING Electrical shock hazard. Disconnect AC power before opening the device. Disconnect and
remove the battery before proceeding with disassembly. Failure to do this can cause serious personal
injury and damage to the device.

WARNING Risk of fire, explosion and burns. Do not short-circuit, crush, incinerate, or disassemble the
battery pack.

WARNING Safety risk. Do not attempt to service the device when the device is connected to a patient.

CAUTION Before disassembling the device or installing options, disconnect the patient from the
monitor, power down the device, disconnect the AC power cord and any attached accessories (for
example, SpO2 sensors, blood pressure hoses and cuffs, and temperature probes) from the device.

CAUTION If your device is configured with a SureTemp module, remove the probe well before
disassembly.

CAUTION Perform all repair procedures at a static-protected station.

CAUTION When the device case is opened, regard all parts as extremely fragile. Execute all procedure
steps with care and precision.

CAUTION Observe screw torque specifications, especially with screws that secure directly into plastic
standoffs.

CAUTION To avoid mismatching screws and holes, keep the screws for each piece with that piece as you
remove modules and circuit assemblies. It is possible to mistakenly install machine screws in locations
intended for plastite screws. Plastite screws have a Torx-pan head.

Required tools and equipment

«  Phillips #1 screwdriver
+ T-10 Torx screwdriver
+  3mm hex key
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Torque value table

Connex Spot Monitor

Use this table to determine how much torque to apply to screws by type and location when reassembling the

device.

Description Torque specification Bit type Where used

SCR,4-20X.31 PLASTITEPH 4.5 +/-0.5 in-lbs Torx Chassis and SpO2 Insert

TORX to Main CSM PCA. Radio/
Bluetooth PCBA to Chassis

SCREW 4-40.250 PAN 4.5 +/-0.5 in-lbs Phillips Sp02 boards

PHILLIPS STEEL ZINC

SCREW, M2 X 6 INTERNAL 2.5 +/-0.25 in-lbs Phillips Radio PCA to Radio

TOOTH SEMS PHP Interface PCA

SCREW, M4 X 10 PAN 7.5 +/-0.5 in-Ibs Phillips Front to Back Housing

HEAD W NYLOC and Temperature Module/
Dock

SCR, M4 PAN HD, PHD, 4.5 +/-0.5 in-lbs Phillips Battery Door

SHOULDER

Connector types

Disassembly and repair procedures require that you disconnect and reconnect the following connector types

inside the device:

« Locking (squeeze-release): Locking connectors use a latching mechanism to prevent accidental disconnection
during assembly and use. The latch is located on one end of a tab so it may flex and lock into place when
coupled with its matching connector. The tab provides a lever to release the latch. Some connectors have
multiple latches that require you to press multiple tabs to release.

To remove a locking connector, squeeze the tab(s) to release the latch(es) and remove the cable.

To connect a locking connector, push the mating pieces together until the latch(es) lock in place.
Friction: Friction connectors use a spring mechanism to create friction between the contacts.
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To remove a pressure connector, grasp each connector mating half and pull the halves apart.

CAUTION Do not use excessive force to disconnect the connector. Excessive force may result in
pulling the mounted connector off the circuit board.

To connect a friction connector, grasp each connector mating half and insert one half into the other.

ZIF (zero insertion force): The device uses flex cables and ZIF flex cable connectors. Flex cables and ZIF
connectors require special care when handling.

ZIF connectors use a sliding outer piece that latches and unlatches to secure and release the flex cable.
ZIF cables cannot be successfully connected or disconnected without properly unlatching and latching the
sliding outer piece.

CAUTION Do not use excessive force when releasing pressure on the connector. Excessive force may
result in breaking the sliding outer piece.

To remove a ZIF connector
A CAUTION Remove a flex cable only after the ZIF latch is open.

1. Using a suitable tool (for example, a paper clip, small flat-head screwdriver, or needle-nose pliers), slide
the latching piece of the connector away from the connector body.

( J

—

2. Remove the cable.

To connect a ZIF connector

1. Slide the latching piece of the connector away from the connector body.

2. Insert the flex cable into the connector. This may require using a suitable tool to keep the latching piece
elevated.
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3. Slide the latching piece toward the connector body until it locks into place.

O

+ Coaxial: Coaxial connectors, a type of pressure connector in this case, are components attached to the ends
of a coax cable—they make it possible to connect to other devices. The connector has a wire conductor in
the center, surrounded by an outer conductor, and an insulation between the two. In this device, the coaxial
connector connects the antenna to the wireless radio board.

if'l] NOTE This connector is labeled PB because of its location on the wireless radio board.

To remove a coaxial connector, lift the connector away from the board.

To connect a coaxial connector, align the connector over the mount on the board and press to snap it into
place.
«  FHY connector (Self-Lock mechanism): The device uses Self-Lock mechanism cable connectors.

A Self-Lock mechanism enables the cover to close by one-touch operation.

>

&
e O
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CAUTION Do not use excessive force when releasing pressure on the connector. Excessive force may
result in breaking the locking mechanism.

Y

O

To remove a Self-Lock mechanism
& CAUTION Remove a flex cable only after the FHY connector latch is open.

1. Lift the latching piece of the connector up off the connector body.
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2. Remove the cable.
To connect a Self-Lock mechanism

1. Lift the latching piece of the connector up off from the connector body.
2. Insert the flex cable into the connector.
3. Push down on the latching piece connector until it locks into place.

Disassembly overview

The following flow chart provides an overview of the complete disassembly of the device. Most disassembly
activities require that you complete a subset of the steps detailed here. The flow chart indicates the steps which
must be completed in sequence to remove a particular component. Because a different sequence of preliminary
steps is required to remove certain components, you should use this flow chart as a reference at the start of
every disassembly and component replacement procedure.
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Power Down

v

Remove Monitor

from Stand (Replacing Kit 105933 only) -
¢ P | Remove Nonin Board
I
Remove Battery ' (Replacing Kit 105942 only)
v el > Remove Speaker
| I
Remove Back Housing | - - - - He e -

(Replacing Kit 105936,
105937, 105938 only)

Remove Braun

L 3| Remove Wireless
Radio Board

Temperature
Module?

Remove SureTemp

Remove Bluetooth
Board

Remove Speaker |«

v

Separate PCAfrom L1 Remove Sp02 Insert
Front Housing

v

Remove Bezel

Remove Nonin Board

Remove Masimo Board

Configuration
with
Sp02?

Remove Nellcor Board

Remove Wireless
Radio Board

Remove Bluetooth
Board

Remove LCD

12

Remove Pump Assembly

NOTE After performing any of these procedures and before returning the device to service, you must
use the service tool, Gold edition, to complete the full suite of functional tests to ensure that all systems
are operating within the design specifications. For more information about these tests and the service
tool, see “Functional verification and calibration.” If you do not have the service tool, you can download it
from https://www.hillrom.com/en/services/welch-allyn-service-tool/.

Power down the monitor

You can power down the device as follows: 1) by briefly pressing the power button on the housing and then
following the onscreen prompts, or 2) by using onscreen controls alone.

Option 1. Press the power button. An onscreen dialog opens with the following options:

«  Power down. Device behavior is the same for all profiles.


https://www.hillrom.com/en/services/welch-allyn-service-tool/
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+ Sleep. The Sleep button clears the display and puts the device into Display power-saving mode.
« Cancel. The Cancel button dismisses the dialog.

Touch Power down and complete the power-down procedure as described in Option 2, steps 3 and 4.
Option 2. Use onscreen controls alone to power down the device:

1. Touch the Settings tab.

2. Touch the Device tab.

3. Touch Power down.

4. Select the desired option and then touch Power down.

The Power-down options dialog
The buttons in this dialog produce varied effects, as noted below:

«  Power down. The device clears all data onscreen and performs a complete software shutdown.
« Cancel. This button dismisses the dialog and returns you to the previous screen.

EI] NOTE If your monitor is configured with a Braun thermometer, avoid powering down the monitor
T between patient measurements to help maintain an adequate charge to the Braun dock.

Remove the monitor from the stand

1. Disconnect the power cord from the wall.

2. If the system has an APM, disconnect the power and communication cables from the monitor. If the system
has an external power supply, disconnect the power supply from the monitor.

3. Remove the 4 Phillips screws from the back of the stand mount to remove the monitor from the stand.

ﬂ] NOTE This artwork features the APM stand. Other stand mounts look slightly different.

Reassembly notes: Reassembly is the reverse of disassembly.

Exploded view diagram

The drawing below shows individual components of the device and their relationships to one another.

39
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Remove the battery

Before removing the battery, power down the monitor as described in this manual.

Place the unit face down on the table as shown.

1.
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2. Loosen the captive Phillips screw to remove the battery door.

Reassembly notes

Kit item:
Batt22, Srv Kit 2 Cell Lithium-ion Battery

:_'B NOTE Reassembly is the reverse of disassembly.

WARNING Defective batteries can damage the monitor. If the battery shows any signs of damage or
cracking, it must be replaced immediately and only with a battery approved by Welch Allyn.
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Remove the back housing

1. Remove the 6 Phillips screws on the back of the device to remove the back housing.
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Reassembly notes

Kit items:

105939, End cap
105923, Back housing (includes battery, speaker foam, 6 screws, and labels)

T parts to Authorized Service Personnel only. These limitations are required to maintain product safety or
maintain current regulations.

:'1‘] NOTE The back housing is not available for direct purchase. Welch Allyn limits availability of certain

::'1‘] NOTE Reassembly is the reverse of disassembly.

Remove the temperature module or housing

The monitor is configured with either a SureTemp or Braun ThermoScan® PRO 6000 temperature module.
Proceed with the disassembly steps that apply to your device.

Remove the SureTemp module

1. Disconnect the ribbon cable by lifting the connector.
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3. Lift the module out of the left side slot.

Reassembly notes

Kit item:

105940, SureTemp Plus module

w NOTE Reassembly is the reverse of disassembly.

Remove the Braun ThermoScan® PRO 6000 module

1.

Disconnect the ribbon cable by lifting the connector.
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2. Remove the Phillips screw that holds the module in place.

Service manual
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3. Lift the module out of the left side slot.

105941, Braun ThermoScan® PRO 6000 dock
w NOTE Reassembly is the reverse of disassembly.

Reassembly notes

Kit item:
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Disassemble the main PCA board

Remove the speaker

1. Disconnect the speaker wire.

Reassembly notes

Kit item:
105942, Speaker
:_]] NOTE Reassembly is not the reverse of disassembly.

When replacing the speaker

1. While holding the speaker, guide the wire through the hole in the pump assembly and drop the speaker into
place.
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Service manual

2. Connect the speaker wire to the main PCA board.

Separate the main PCA board from the front

housing

1. Disconnect the power switch flex cable from the main PCA board.

2. Lift the antenna board straight up out of its slot and let it hang.




Connex Spot Monitor

48 Disassembly and repair

3. Remove the main PCA board from the front housing.

N

IR

Remove the SpO2 insert

1.

w NOTE Reassembly is the reverse of disassembly.

Reassembly notes

Turn over the main PCA board and remove the 2 T-10 Torx screws attaching the sensor insert to the main

PCA board.
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2. Turn over the main PCA board again so that the SpO2 board is facing you; then disconnect the power harness
from the main PCA board.

3. Todisconnect the insert from the pump manifold, hold the black pump manifold with one hand and tilt the
top of the insert away from the main PCA board with the other hand.

Reassembly notes

Sp02 insert options are Masimo, Nellcor, Nonin, or none.

Kit items:

+ 105926, Masimo insert only

« 105927, Nellcor insert only
105929, Nonin insert only

« 105928, No SpO2 insert only

:_'1] NOTE Reassembly is not the reverse of disassembly, but it is the same for each insert.
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When replacing the SpO2 insert
Complete the following steps:

Attach the power harness to the SpO2 insert. (See "Attach the power harness to the insert.")
Install any new SpO2 board, if applicable. (See the reassembly notes in "Remove the SpO2 board.")

Attach the power harness to the insert

Align the power harness with the insert and secure it with 2 T-10 Torx screws (see the Torque Value Table).

Attach the SpO2 insert to the main PCA board

1. Align the insert with the edge of the main PCA board. Connect the pump tubing to the insert as shown and
press firmly. Adjust the insert to fit snugly along the side of the board.

N
QAT
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3. Turn over the board and secure the insert to the main PCA board with 2 T-10 Torx screws.

Remove the SpO2 board

The monitor is configured with one of the following SpO2 boards: Masimo, Nellcor, Nonin, or none. Proceed with
the disassembly steps that apply to your device.

Remove the Masimo board

1. Remove the 2 Phillips screws from the SpO2 board.
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3. Remove the 2 Phillips screws that hold the adapter board to the main PCA board.

4. Firmly grasp the adapter board and lift it straight up to disconnect the pins.

Remove the Nellcor board

1.

Remove the 2 Phillips screws from the SpO2 board.
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Disassembly and repair

2. Lift the SpO2 board to remove it from the adapter board.
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3. Remove the 2 Phillips screws that hold the adapter board to the main PCA board.

4. Firmly grasp the adapter board and lift it straight up to disconnect the pins.
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Remove the Nonin board

1. Remove the 2 Phillips screws that attach the SpO2 board to the main PCA board.

Reassembly notes

Sp02 board options are Masimo, Nellcor, and Nonin.

Kit items:

105931, adapter board, Masimo board, and 2 Phillips screws (4-40 0.250 pan steel zinc)
105932, adapter board, Nellcor board, and 2 Phillips screws (4-40 0.250 pan steel zinc)
105933, Nonin board and 2 Phillips screws (4-40 0.250 pan steel zinc)

::'1] NOTE Reassembly is the reverse of disassembly for each board.

Remove the communications board

The monitor is configured with one of the following communications boards: wireless radio, Bluetooth wireless
technology, or none. Proceed with the disassembly steps that apply to your device.
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Remove the wireless radio board from the main PCA board

1. Remove the 2 T-10 Torx screws from the wireless radio board attached to the pump assembly.

Reassembly notes
Kit items:

105936, Wireless radio board, antenna, and 2 T-10 Torx screws
105938, Antenna board

::'1] NOTE Reassembly is the reverse of disassembly.
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Remove the Bluetooth board from the main PCA board

1. Remove the T-10 Torx screw from the Bluetooth radio board.
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Reassembly notes
Kit items:

105937, Bluetooth board and a T-10 Torx screw

:-‘l NOTE Reassembly is the reverse of disassembly.

Remove the touchscreen and display ribbon cable
separately from the main PCA board

::'B NOTE The touchscreen contains a serial number: TFC-K9700RTWV37TR or TFC-K9700RTWV55. Removal

T and Reassembly steps are the same for both serial numbers, except that the TFC-K9700RTWV37TR serial
number has an integrated (soldered) LCD flex cable.

::'B NOTE The TFC-K9700RTWV55 touchscreen and display ribbon cable (available as service kit item:

t 108241, Srv Kit HW A-F, LCD with Touchscreen) works with the 409703-16 CSM Main Board and with
existing software versions. When using the TFC-K9700RTWV37TR touchscreen and display ribbon cable
(available as service kit item 108121, Srv Kit CSM, LCD with Touchscreen New), you are required to
upgrade your device with the newer 409703-18 CSM Main Board, the new LCD Touchscreen, and
upgrade the software to 1.41 or greater.
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1. For the TFC-K9700RTWV55 serial number, carefully separate the LCD flex cable from its connector on the
main PCA board by pulling the cable straight up.

3. On the side of the main PCA board with the notch, carefully lift the LCD past the tabs, and tilt the LCD
upward.

4. Remove the Gaff tape covering the bale connector and set it aside for reassembly.

57
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5. Carefully lift the bale (locking mechanism) of the LCD flex cable connector on the main PCA board and
remove the LCD.

NS

)

Reassembly notes

Kit item:

108241, Srv Kit HW A-F, LCD with Touchscreen
108121, Srv Kit CSM, LCD with Touchscreen New

NOTE The TFC-K9700RTWV55 touchscreen and display ribbon cable (108241, Srv Kit HW A-F, LCD with
Touchscreen) works with the 409703-16 CSM Main Board and with existing software versions.

=117
>

NOTE When using the TFC-K9700RTWV37TR touchscreen and display ribbon cable (available as service
kit item 108121, Srv Kit CSM, LCD with Touchscreen New), you are required to upgrade your device with
the newer 409703-18 CSM Main Board, the new LCD Touchscreen, and upgrade the software to 1.41 or
greater.

=117
>

NOTE Reassembly is not the reverse of disassembly.

NOTE Use the Gaff tape set aside during disassembly to reassemble the LCD.

(= [

Attach the touchscreen and display ribbon cable separately to
the main PCA board

L‘l NOTE The touchscreen contains a serial number: TFC-K9700RTWV37TR or TFC-K9700RTWV55.
Reassembly steps are the same for both serial numbers, except that the TFC-K9700RTWV37TR serial
number has an integrated (soldered) LCD flex cable.

:'1] NOTE The TFC-K9700RTWV55 touchscreen and display ribbon cable (available as service kit item:

T 108241, Srv Kit HW A-F, LCD with Touchscreen) works with the 409703-16 CSM Main Board and with
existing software versions. When using the TFC-K9700RTWV37TR touchscreen and display ribbon cable
(available as service kit item 108121, Srv Kit CSM, LCD with Touchscreen New), you are required to
upgrade your device with the newer 409703-18 CSM Main Board, the new LCD Touchscreen, and
upgrade the software to 1.41 or greater.
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1. With the LCD frame facing up, carefully insert the LCD flex cable into the connector.

2. With two fingers, press down the bale to secure the LCD flex cable

G
S

Apply the Gaff tape (removed during disassembly) to the connector bale and the LCD flex.

NOTE Do not allow the tape to touch the board or the ferrite to touch the end of the flex cable when
assembled.
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4, For the TFC-K9700RTWV55 serial number, insert the small touchscreen flex cable into the hole on the main
PCA board.

5. Place the LCD at an angle under the tabs on the flex cable side of the LCD.

6. Lower the LCD into place and carefully move the tabs on the opposite side just enough to catch and secure
the LCD in the frame.

55'1] NOTE Ensure that the tabs hold the LCD securely.

7. Turn over the main PCA board.
8. For the TFC-K9700RTWV55 serial number, insert the flex cable into its connector.
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Remove the pump assembly

1. Remove the pump manifold from the main PCA board transducers.




62 Disassembly and repair Connex Spot Monitor

4, Separate the pump assembly from the main PCA board.

Reassembly notes

Kit items:
+ 105920, Pump assembly and 2 T-10 Torx screws

m NOTE Reassembly is not the reverse of disassembly.

Attach the pump assembly to the main PCA board

1. Place the pump manifold onto the main PCA board transducer. Ensure that the pump manifold is fully seated
on the transducer.
(See "Remove the pump assembly," step 1.)

2. Connect the pump to the main PCA board.
(See "Remove the pump assembly," step 2.)

3. Turn over the main PCA board.

4. Secure the pump assembly to the main PCA board with 2 T-10 Torx screws (see the Torque Value Table).

(See "Remove the pump assembly,” steps 3 and 4.)

Replace the main PCA board

Replace the main PCA board as needed after removing all other components.

L‘l NOTE New PCA boards must be prepared for first use after installing them. Perform an NIBP board
T initialization during the full device functionality and calibration using the Welch Allyn Service Tool, Gold
edition. See "Initialize the NIBP board" in the "Full functional verification and calibration" section.

:'1] NOTE When repairs are complete and the device is calibrated, the Welch Allyn Service Tool CSM

T Configuration screen includes a tab for "First Boot Settings" that allows you to place the device into the
following First Boot states: Production Complete (formerly described as 'State when it leaves the factory').
On boot up the language and date/time are shown.
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Disassemble the front housing

Remove the bezel from the front housing

Lift the rubber bezel up and over the power switch cable and the 6 bosses on the housing.

B

Reassembly notes

Kit items:

105922, Bezel
105921, Front housing (housing, power switch, and 6 Phillips screws)

:-'1] NOTE Reassembly is not the reverse of assembly.

Attach the bezel to the front housing

1. Align the bezel with the front housing and feed the power switch flex cable through the slot in the bezel.

2. Place the bezel onto the 6 bosses on the housing.

Accessory Power Management (APM) work surface

This section applies only to devices with an APM stand.



64 Disassembly and repair Connex Spot Monitor

Remove the APM work surface from the stand

Before removing the APM work surface, power down the monitor, disconnect the power and communication
cables from the monitor, and disconnect the power cord from the wall.

1. Using a 3mm hex key, remove the 4 screws from the stand bracket and put them aside.

55'1] NOTE Save the screws for reassembly.

2. Lift the APM work surface off the stand.

3. Ifreplacing the APM, remove the battery and put aside for reassembly.

Reassembly notes
Kit item:

. 105943, APM work surface

:_]] NOTE Reassembly is the not the reverse of disassembly.

Attach the APM work surface to the stand

1. Take the 4 screws used to attach the APM work surface to the stand and partially screw them into the APM
work surface with your fingers. Do not tighten.

2. Lower the screws into the stand bracket keyholes.

3. Slide the APM work surface backward on the stand bracket.
4. Tighten the 4 screws using a 3mm hex key.
5. Insert the battery.
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Remove the APM work surface battery

Before removing the APM work surface battery, power down the monitor and disconnect the power cord from
the wall.

:-"_] NOTE You do not have to remove the APM work surface from the stand to remove the APM work
T surface battery.

1. Loosen the captive screw on the bottom of the APM work surface that secures the battery door.

2. Remove the battery door and put it aside.
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3. Gently lift the latch with one hand and pull the tab on the top of the battery with your other hand to remove
the battery from its slot.

Reassembly notes

Kit items:

« Batt99, 9-cell Lithium-ion battery, single pack
« 105972, APM work surface, battery door (if needed)

:_'1] NOTE Reassembly is the reverse of disassembly.

Disassembly and assembly notes for mobile stands
and power supplies

The following table provides an at-a-glance view of the service kits that are compatible with the combination
of mobile stand and power supply based on the date of manufacture. This section is divided into four major
subsections, defined in the table below.

Section A CSM devices with a 4400-MBS or 7000-MS3 mobile stand meeting these criteria:

+  4400-MBS or 7000-MS3 mobile stand manufactured before 02/2022" or earlier.

. 7000-PS power supply manufactured before 02/2022" or earlier
+  Power supply model: MENB1035A1500F02
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Section B CSM devices with 4400-MBS or 7000-MS3 mobile stand meeting these criteria:

«  4400-MBS or 7000-MS3 mobile stand manufactured after 02/2022" or later

« 7000-PS power supply manufactured after 02/2022" or later
+  Power supply model: FW8031M/DT/15

CSM devices with a 4400-MBS or 7000-MS3 mobile stand meeting these criteria:

«  4400-MBS or 7000-MS3 mobile stand manufactured before 02/2022" or earlier
«  7000-PS power supply manufactured after 02/2022" or later

« Power supply model: FW8031M/DT/15

« Adapter plate kit REF 411626

CSM devices with a 4400-MBS or 7000-MS3 mobile stand meeting these criteria:

«  4400-MBS or 7000-MS3 mobile stand manufactured after 02/2022" or later

. 7000-PS power supply manufactured before 02/2022" or earlier
+  Power supply model: MENB1035A1500F02

1 See the model number and label for further information.

Examine your mobile stand and power supply to determine which section you should follow to complete
disassembly and assembly procedures.
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Many service kits are backward-compatible and/or interchangeable, while others are compatible with only one
or two of the stand and power supply combinations.

Section A, remove the power supply from the mobile stand

This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured before 02/2022.
« 7000-PS power supply manufactured before 02/2022.
+  Power supply model: MENB1035A1500F02

if'l] NOTE See the model number and label for further information.

1. Power down the device.
2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power supply to the
bracket.

if'l] NOTE Set the screws aside for reassembly.

/

/

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with local regulations.
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Section A, attach the power supply to the stand
This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

«  7000-MS3 mobile stand manufactured before 02/2022.
« 7000-PS power supply manufactured before 02/2022.
«  Power supply model: MENB1035A1500F02

55'1] NOTE See the model number and label for further information.

Kit item:
« 7000-PS, Connex Spot Power Supply

1. Ensure that the side with the screw holes is facing upward, and then insert the power supply socket into the
support frame.

/

/

2. Holding the power supply unit snugly to the frame, attach the power supply to the bracket using the 2
Phillips screws.

3. Thread the power cable from the power supply through one of the spaces next to the pole to reach the
device, and then connect the power cable to the device.

4. Connect the power cord to the mains outlet.
5. Power up the device.
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Section B, remove the power supply from the mobile stand
This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured after 02/2022
« 7000-PS power supply manufactured after 02/2022

i:'l] NOTE See the model number and label for further information.
+  Power supply model: FW8031M/DT/15

1. Power down the device.
2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power supply to the
bracket.

55'1] NOTE Set the screws aside for reassembly.

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with local regulations.

Section B, attach the power supply to the stand
This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured after 02/2022
«  7000-PS power supply manufactured after 02/2022
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«  Power supply model: FW8031M/DT/15

i:'l] NOTE See the model number and label for further information.

Kit item:
« 7000-PS, Connex Spot Power Supply

1. Holding the power supply unit snugly to the support bracket, attach the power supply to the bracket using
the 2 Phillips screws.

2. Thread the power cable from the power supply through one of the spaces next to the pole to reach the
device, and then connect the power cable to the device.

3. Connect the power cord to the mains outlet.
4. Power up the device.

Section C, remove the power supply from the mobile stand

This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured before 02/2022
« 7000-PS power supply manufactured after 02/2022
«  Power supply model: FW8031M/DT/15
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5;_'] NOTE See the model number and label for further information.

1. Power down the device.
2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power supply to the
bracket. With the other hand, hold the adapter plate and the well nuts.

-
5:_'] NOTE Set the screws, adapter plate, and well nuts aside for reassembly.

4
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4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with local regulations.

Section C, attach the power supply to the stand
This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured before 02/2022
+ 7000-PS power supply manufactured after 02/2022
Power supply model: FW8031M/DT/15
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EE'B NOTE See the model number and label for further information. To install the new power supply onto
an existing stand, you need to use the adapter plate kit REF 411626.

Kit item:

« 7000-PS, Connex Spot Power Supply
+ 411626, MS3 Power Supply Bracket Kit

1. Install the 2 nuts by placing each nut into the adapter plate well. With one hand holding the power supply,
use the other hand to close up the power supply onto the adapter plate.

2. Flip the power supply over to ensure that the side with the screw holes is facing upward,
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and then attach the power supply to the adapter plate by aligning the holes and then tighten using the 2
Phillips screws.

4. Thread the power cable from the power supply through one of the spaces next to the pole to reach the
device, and then connect the power cable to the device.

5. Connect the power cord to the mains outlet.
6. Power up the device.

Section D, remove the power supply from the mobile stand
This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured after 02/2022
« 7000-PS power supply manufactured before 02/2022
«  Power supply model: MENB1035A1500F02
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1. Power down the device.
2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power supply to the
bracket.

5:_|] NOTE Set the screws, adapter plate, and well nuts aside for reassembly.

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with local regulations.

Section D, attach the power supply to the stand
This section applies to CSM devices with a 7000-MS3 mobile stand meeting these criteria:

« 7000-MS3 mobile stand manufactured after 02/2022
«  7000-PS power supply manufactured before 02/2022
+  Power supply model: MENB1035A1500F02
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L‘l NOTE See the model number and label for further information.

Kit item:
« 7000-PS, Connex Spot Power Supply

1. Install the adapter plate onto the wire bracket of the mobile stand.
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3. Holding the power supply unit snugly to the support bracket, tighten the 2 Phillips screws.

4. Thread the power cable from the power supply through one of the spaces next to the pole to reach the
device, and then connect the power cable to the device.

5. Connect the power cord to the mains outlet.
6. Power up the device.
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Field replaceable units

This listing includes only field-replaceable service parts. Product accessories—including patient sensors, probes,
cables, batteries, probe covers, and other consumable items—are listed separately in the accessories list in the
Appendix of the Instructions for use or at Hillrom Parts Store.

This section begins with an illustration of the entire device followed by lists of service kits.
Repair parts/kits can be purchased through Welch Allyn sales channels.

L‘l NOTE Welch Allyn may limit availability of certain parts to Authorized Service Personnel only. These
T limitations are required to maintain product safety, or maintain current regulations. After the End of
Manufacturing (EoM) date, repair and service parts will be provided for 5 years or until parts are no
longer available. The Expected Service Life, per IEC60601-1 3rd Edition Sub-clause 4.4, is defined as a
period of 5 years.

L
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2
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https://parts.hillrom.com/hillromUS/en/Products/Patient-Monitoring/Vital-Signs-Devices/CONNEX-VITAL-SIGNS-MONITOR/p/BAB11824-3C0B-4B0C-B839-C5EDA4A0CB7B
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Device serial number and model label

The model number and serial number can be found on a label on the back housing.

Serial number and format code

Serial number MMMMXXXXWWYY
MMMM Manufacturing plant
XXXX Sequential number
ww Week of manufacture
YY Year of manufacture

About 4th edition service kits

The table describes the components of the device and APM and the associated service kits for replaceable parts
for devices manufactured per IEC60601-1 4th edition from 2019 and later. To determine which year your device
was manufactured in, refer to the serial number. The year of manufacture is listed as the last two digits of the
serial number.

Future revisions of a part might not always be backwards compatible with a legacy part.

List of 4th edition service kits

To determine the correct replacement part for your unit, always provide the serial number and model when
ordering.

Service Kit Number Material Number Description

1 105945 Srv Kit CSM, Battery Door

2 Batt22 Srv Kit 2 Cell Lithium-ion Battery
105923 Srv Kit CSM, Back Housing’

4 105939 Srv Kit CSM, End Cap

5 105942 Srv Kit CSM, Speaker

6 105920 Srv Kit CSM, NIBP Pump Assembly

7 105933 Srv Kit CSM, Nonin SpO2 PCBA

8 105931 Srv Kit CSM, Masimo SpO2 PCBA
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Service Kit Number Material Number Description

9 105932 Srv Kit CSM, Nellcor SpO2 PCBA

10 105925 Srv Kit CSM, Main PCA, and LCD
Frame

11 105930 Srv Kit CSM, Power Harness

12 105938 Srv Kit CSM, Newmar Antenna PCBA

13 105936 Srv Kit CSM, Newmar Radio PCBA

14 105937 Srv Kit CSM, Bluetooth Radio PCBA

15 105926 Srv Kit CSM, Masimo SpO2 Insert

16 105927 Srv Kit CSM, Nellcor SpO2 Insert

17 105928 Srv Kit CSM, No SpO2 Insert

18 105929 Srv Kit CSM, Nonin SpO2 Insert

19a 108241 Srv Kit HW A-F, LCD with
Touchscreen

19b 1081211 Srv Kit CSM, Combined LCD with
Touchscreen New

20 105922 Srv Kit CSM, LCD Bezel

21 105921 Srv Kit CSM, Front Housing

22 105941 Srv Kit CSM, Braun ThermoScan
PRO 6000 Module?

23 105940 Srv Kit CSM, Sure Temp Plus Module

24 105943 Srv Kit CSM, APM Work Surface

25 Batt99 Srv Kit 9 Cell Lithium lon Battery

26 105972 Srv Kit CSM, APM Work Surface,

Battery Door

27 7000-PS Connex Spot Power Supply

1

T When using the 108121 (Srv Kit CSM, Combined LCD with Touchscreen New), you are required to upgrade
your device with the newer 409703-18 CSM Main Board, the new LCD Touchscreen, and to upgrade the
software to 1.41 or greater. Contact Welch Allyn for further details.

2When using a replacement service kit (Srv Kit CSM, Braun ThermoScanPRO 6000 Module) in China substitute
108189 for 105941. This kit contains the new software version 5.28.

T Not available for direct purchase.

About 3rd edition service kits

The tables describes the components of the device and APM and the associated service kits for replaceable parts
for devices manufactured per IEC60601-1 3rd edition from 2015 through 2018. To determine which year your
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device was manufactured in, refer to the serial number. The year of manufacture is listed as the last two digits of
the serial number.

Future revisions of a part might not always be backwards compatible with a legacy part. To determine the
correct replacement part for your unit, always provide the serial number and model when ordering.

To repair a 3rd edition device component, you might need to use a service kit to upgrade the component. To
determine whether you need to use an upgrade kit to replace a component for the first failure, consult the 3rd
edition service kits for the first component failure table to locate the correct service kit to use with your device.

::'1] NOTE Upgrading a component does not make the device 4th edition compliant.

If the device encounters a failure after you upgrade a device component, consult the 3rd edition service kits for
subsequent component failure table to determine which service kit to use.

3rd edition service Kits for first component failure

Use this table to determine the correct part to order for the first component failure.

Device Main Board SureTemp Masimo Nellcor Nonin Braun Dock Braun
Model Plus Thermomet
Number er
7'CE 107156 - - 107156 - 107156 107156
7'CT 107155 107155 - 107155 - - -
7'CX 107162 - - 107162 - - .
7'ME 107157 - 107157 - - 107157 107157
7'MT 107154 107154 107154 - - - -
7TMX 107158 - 107158 - - - -
7XE 107153 - - - - 107153 107153
7'XT 107152 107152 - - - - -
71XX 107163 - - } j i _
7'WE 107153 - - - 105933 107153 107153
7'WT 107152 107152 - - 105933 - -
7'WX 107163 - - - 105933 - -

3rd edition service Kits for a subsequent component failure

Use this table to determine the correct part to order if you encounter a component failure after upgrading using
the components in the 3rd edition service kit for first component failure.

w NOTE For a first component failure, refer to the 3rd edition service kits for a first component failure
table.

1 Varies depending on the model number of your device.
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SureTem Masimo

p Plus

Device Main
Model Board
Number

Nellcor

Braun Braun Thermometer

Dock

Nonin

72CE, 72CT,
72CX, 72ME,
72MT, 72MX,
72XE, 72XT,
72XX, 72WE,
72WT, 72WX

105925 105940 105931

105932

105933 105941 105948

List of 3rd edition service kits

To determine the correct replacement part for your unit, always provide the serial number and model when

ordering.

Service Kit Material Description

Number Number

1 105945 Srv Kit CSM, Battery Door

2 Batt22 Srv Kit 2 Cell Lithium-ion Battery

105923 Srv Kit CSM, Back Housing’

4 105939 Srv Kit CSM, End Cap

5 105942 Srv Kit CSM, Speaker

6 105920 Srv Kit CSM, NIBP Pump Assembly
7 105933 Srv Kit CSM, Nonin SpO2 PCBA

8 105931 Srv Kit CSM, Masimo SpO2 PCBA

9 105932 Srv Kit CSM, Nellcor SpO2 PCBA

10 105925 Srv Kit CSM, Main PCA, and LCD Frame
11 105930 Srv Kit CSM, Power Harness

12 105938 Srv Kit CSM, Newmar Antenna PCBA
13 105936 Srv Kit CSM, Newmar Radio PCBA
14 105937 Srv Kit CSM, Bluetooth Radio PCBA
15 105926 Srv Kit CSM, Masimo SpO2 Insert
16 105927 Srv Kit CSM, Nellcor SpO2 Insert
17 105928 Srv Kit CSM, No SpO2 Insert

18 105929 Srv Kit CSM, Nonin SpO2 Insert
19a 108241 Srv Kit CSM, LCD with Touchscreen

2 Varies depending on the model number of your device.
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Service Kit Material Description

Number Number

19b 108121 Srv Kit CSM, Combined LCD with Touchscreen New
20 105922 Srv Kit CSM, LCD Bezel

21 105921 Srv Kit CSM, Front Housing

22 105941 Srv Kit CSM, Braun ThermoScanPRO 6000 Module?
23 105940 Srv Kit CSM, Sure Temp Plus Module

24 105943 Srv Kit CSM, APM Work Surface

25 Batt99 Srv Kit 9 Cell Lithium lon Battery

26 105972 Srv Kit CSM, APM Work Surface, Battery Door

27 7000-PS Connex Spot Power Supply

1

T When using the 108121 (Srv Kit CSM, Combined LCD with Touchscreen New), you are required to upgrade
your device with the newer 409703-18 CSM Main Board, the new LCD Touchscreen, and to upgrade the
software to 1.41 or greater. Contact Welch Allyn for further details.

1 Not available for direct purchase.
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Cleaning requirements

This section presents procedures for cleaning the Connex Spot Monitor (including the monitor, stands, APM
work surface, accessories, and accessory basket and bins).

Welch Allyn has validated these instructions to be capable of preparing your Connex Spot Monitor devices and
above accessories for re-use. Clean on a routine basis according to your facility's protocols and standards or local
regulations. If the monitor is on, lock the display.

C WARNING Patient injury risk. Clean all accessories, including cables and tubes, before storing the

accessories on the device or stand. This helps reduce the risk of cross contamination and nosocomial
infection.

C WARNING Electric shock hazard. Before cleaning the monitor, disconnect the AC power cord from the

mains outlet and the power source.

C WARNING Electric shock hazard. DO NOT immerse or autoclave the monitor or accessories. The monitor

and the accessories are not heat-resistant.

C WARNING Liquids can damage electronics inside the monitor. Prevent liquids from spilling on the

monitor.

Q CAUTION Do not sterilize the monitor. Sterilizing the monitor could harm the device.

If liquids are spilled on the monitor:

H W=

Power down the monitor.

Disconnect the power cord from the mains outlet and the power source.
Remove battery pack from the monitor.

Dry off excess liquid from the monitor.

i:_l] NOTE If liquids possibly entered the monitor, remove the monitor from use until it has been properly
dried, inspected, and tested by qualified service personnel.

Reinstall battery pack.

. Reconnect the power cord.

Power on the monitor and verify that the monitor functions normally before using it.

Prepare to clean the equipment

Q CAUTION Some cleaning agents are not appropriate for all components of the device. Use only

approved cleaning agents, and observe restrictions noted for some components in the following table.
Using unapproved cleaning agents may cause damage to components.

Q CAUTION Do not use bleach solutions of any kind when cleaning metal electrical contacts. They will

damage the device.

Select a cleaning agent from the following table.

Section 1. Approved for all CONNEX SPOT Monitor components

Cleaning agent Additional information

Accel INTERVention

Accel TB
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Cleaning agent

Additional information

CaviWipes

Clinell Universal Wipes

Oxivir TB

Sani-Cloth Plus

Super Sani-Cloth

70 percent isopropyl alcohol solution

Applied to a clean cloth

T with the Braun ThermoScan® PRO 6000.

Section 2. Not approved for all CONNEX SPOT Monitor components

:_'1] NOTE The following cleaning agents are NOT approved for cleaning Connex Spot Monitors equipped

Cleaning agent

Additional information

Bacillol AF Wipes

Not approved for use on the display

CleanCide

Clinitex Detergent Wipes

Not approved for use on the display

Clorox Dispatch Wipes

Not approved for use on the display

Clorox Fuzion

Not approved for use on the display

Clorox Healthcare Bleach Germicidal
Cleaner

Mikrozid AF Wipes

Not approved for use on the display

Oxivir 1 Wipes

Not approved for use on the display

Oxivir Plus 1:40 Solution

Not approved for use on the display

Reynard Neutral Detergent Wipes

Not approved for use on the display

Reynard Premier Disinfectant Wipes

Not approved for use on the display

Sani-Cloth Active Wipes

Not approved for use on the display

Sani-Cloth Bleach

Not approved for use on the display

Sani-Cloth Prime Wipes

Not approved for use on the display

Sekusept Plus 1.5% Solution

Not approved for use on the display

Super HDQL10

Dilution rate of %2 oz per gallon of water (1:256) applied to a clean

cloth

Tuffie5 Cleaning Wipes

Viraguard Wipes

Not approved for use on the display

Virex Il (256)

Dilution rate of V2 oz per gallon of water (1:256) applied to a clean

cloth

10 percent bleach solution

(.5% - 1% sodium hypochlorite) applied to a clean cloth
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Remove liquid spills from the monitor

Liquids can damage electronics inside the monitor. Follow these steps if liquids spill on the monitor.

Power down the monitor.

Disconnect the power cord from the mains outlet and the power source.
Remove battery pack from the monitor.

Dry excess liquid from the monitor.

Reinstall battery pack.

ok W=

Reconnect the power cord.
7. Power on the monitor and verify that the monitor functions normally before using it.

If liquids possibly entered the monitor, remove the monitor from use until it has been properly dried, inspected,
and tested by qualified service personnel.

Clean the equipment

The screen lock blocks the display of patient information and prevents any input, which may be useful when
cleaning the display.

Follow the cleaning agent manufacturer's instructions to prepare solution, if applicable, and clean all exposed
surfaces of the monitor, APM work surface, accessory bin(s) and basket, cords and cables, and stand. Wipe all
surfaces until no visible soil remains. Change the wipe or cloth throughout the cleaning procedure as needed.

& WARNING Electric shock hazard. Do not open the monitor or attempt repairs. The monitor has no
user-serviceable internal parts. Only perform routine cleaning and maintenance procedures specifically
described in this manual. Inspection and servicing of internal parts shall only be performed by qualified
service personnel.

Q CAUTION Sterilizing the monitor could damage the device.

Disconnect the AC power cord from the mains outlet.
Wipe the top of the monitor.
Wipe the sides, front, and rear of the monitor.

HwnN =

Avoid residual film buildup on the LCD screen. After cleaning and disinfecting, wipe the LCD screen with a
clean cloth dampened with water, and then wipe the screen dry with a dry clean cloth.

Wipe the bottom of monitor.

Wipe the APM work surface.

Wipe the accessory bins or basket.

Wipe the AC power cord and the APM work surface power/USB cable assembly.

© ® N o w;

Wipe the stand from top to bottom.

Dry the equipment

1. Allow all components except the LCD screen to air dry.
2. Wipe the LCD screen dry with a clean cloth.

Store the device

Store the device according to facility guidelines to keep the device clean, dry, and ready for service.
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Cleaning accessories

Accessories include components like blood pressure cuffs and hoses, SpO2 sensors and cables, thermometers,
and the barcode scanner. Follow accessory manufacturer’s instructions for cleaning and disinfection.

For cleaning the wallboard and VESA mount, use only 70 percent isopropyl alcohol solution applied to a clean
cloth.

For the Braun ThermoScan® PRO 6000 thermometer, use only the approved cleaning agents published
in the manufacturer's instructions for cleaning. Unapproved cleaning agents can damage the device and
interfere with data transmission.

Clean the Braun ThermoScan® contacts

Debris that accumulates on the Braun ThermoScan® PRO 6000 electrical contacts can interfere with data
transmission. Baxter recommends cleaning the contacts on the thermometer and the dock once every 4 months
to maintain optimal performance.

CAUTION Do not use bleach solutions of any kind when cleaning metal electrical contacts. They will
damage the device.
1. Slightly dampen a cotton swab with 70% isopropyl alcohol.

2. Remove the thermometer from the dock and clean the metal electrical contacts on the thermometer with
the cotton swab.

3. Place the thermometer aside for 1 minute, allowing the contacts to air dry.
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4. Clean the metal electrical contacts on the device dock with the cotton swab.

Q
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5. Allow the contacts to air dry for 1 minute.

6. Return the Braun thermometer to the dock.

Decontamination and cleaning requirements for
returns

As a general safety precaution, the monitor must undergo decontamination before being returned to Welch
Allyn for service, repair, inspection, or disposal. Cleaning is an essential prerequisite for effective disinfection or
decontamination. Follow the cleaning instructions presented earlier in this section.

::'1] NOTE Contaminated items must not be returned without prior, written agreement.

L‘l] NOTE Decontaminate the monitor according to your facility’s procedures and local regulations.
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Device configuration and setup

Configuration overview

A configuration file can be created that specifies preferences for all Connex Spot Monitor options. When
powered on, the monitor recognizes all available options and features and applies the associated configuration
file preferences.

If no customized configuration file has been loaded onto the device, the device applies factory defaults to all
available options. See "Factory defaults" in the Appendix.

In addition to creating or modifying a configuration file, it is possible to change some settings by navigating to
Advanced settings. Changes made in Advanced settings take effect immediately on the device, but they do not
change the configuration file.

::l NOTE The device does not support configuration filenames that include parentheses. If these are

T present in the filename, the device will not recognize the file. This is a common issue if you've
downloaded the same file multiple times from your web browser. For example, the web browser may
automatically rename "MyFile.config" to "MyFile.config(2)" if you download it a second time. If this
happens, rename the file by deleting the parentheses; then it will appear in the list on the CSM.

The remainder of this section instructs you how to do the following:

- Edit a configuration file

« Copy a configuration file

«  Download a configuration file to install on another device
Create a new configuration file

« Install a configuration file

Edit a configuration file

To edit a saved configuration file, complete the following steps:

1. Access the Configuration Tool at http://config.welchallyn.com.
2. Log in with a username and password.
3. Click List Configurations on the navigation bar.

\)
4. Locate the configuration file to be edited in the list, and click the L on the right side of the table to
launch the editor.

5. Under Progress Summary, locate the section you want to edit (Clinical, Informatics, IT, or Biomed) and click
the specific step you want to edit.

6. Review the selections in each step and modify them as desired.
7. Click SAVE AND CONTINUE to accept the changes or BACK to return to the previous screen without saving.
Clicking SAVE AND CONTINUE automatically moves you to the next step in that section of the Progress

Summary. When you reach the last step in a section, clicking SAVE AND CONTINUE returns you to the
Progress Summary.

8. Repeat steps 5 through 7 until you complete all desired edits.

9. Click List Configurations on the navigation bar to see a new date stamp in the Updated column for your
configuration file.
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Copy or restore a saved configuration file

To copy or restore a saved configuration file, complete the following steps:

1. Access the Configuration Tool at http://config.welchallyn.com.
2. Log in with a username and password.
3. Click List Configurations on the navigation bar.

4. Locate the configuration file to be copied in the list, and click the L on the right side of the table.
5. Either accept or enter a new name for the copied file in the Copy Configuration dialog, then click Copy.
6. Observe your new configuration file on the List Configurations tab.

Download a configuration file to install on another device

::‘l NOTE Before you use a USB flashdrive to download a configuration file, ensure the flashdrive is free from

T malware and unnecessary data.
To download a saved configuration file, complete the following steps:
From the Configuration Tool

1. Access the Configuration Tool at http://config.welchallyn.com.
2. Log in with a username and password.
3. Click List Configurations on the navigation bar.

4. Locate the configuration file to be downloaded in the list, and click the @ on the right side of the table.

The configuration file downloads to the tray on your PC.
5. Using the dropdown menu on the right side of the downloaded file, select Show in folder.

Windows Explorer opens the Downloads folder with the most recent download selected.
6. Copy the downloaded configuration file to a USB flash drive.
7. See"Install a configuration file" for instructions to load this configuration on another device.

Create a new configuration file

To create a new configuration file, complete the following steps:

Access the Configuration Tool at http://config.welchallyn.com.

Log in with a username and password.

Click New Configuration on the navigation bar.

Select Connex Spot Monitor as the product you would like to configure.

LA

Enter a user-friendly name for your configuration, then click CONTINUE.
The Configuration Tool advances to the Product Use Location screen.

6. Select your location type, then click SAVE AND CONTINUE.

The Progress Summary screen appears.
7. Under Progress Summary, click the first step you want to configure.
8. Review the selections in each step and modify them as desired.


http://config.welchallyn.com
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9. Click SAVE AND CONTINUE to accept the selections or BACK to return to the previous screen without saving.

Clicking SAVE AND CONTINUE automatically moves you to the next step in that section of the Progress
Summary. When you reach the last step in a section, clicking SAVE AND CONTINUE returns you to the
Progress Summary.

10. Repeat steps 7 through 9 until you configure each section.
11.When you are finished, click List Configurations on the navigation bar to see your configuration file.

Install a configuration file

To install a configuration file, you must first download the configuration file to a USB flash drive. If you have
not done so already, complete the steps in "Download a configuration file to install on another device," then
complete the following steps:

1. Insert the flash drive into the device which needs to have the configuration loaded onto it.

A pop-up dialog appears listing the configuration file(s) on your flash drive.

2. Select the desired configuration file and touch Load. (Depending on your facility's configuration, selecting
"Load" may require you to enter the Advanced Settings Password.)

3. Repeat this process on as many devices as you wish.
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overview

Functional verification tests

The functional verification tests help to confirm the proper operation of the device and its options. The tests may
also be useful as a diagnostic tool to help isolate a malfunction. It is not necessary to disassemble the device to
perform these tests.

For periodic service, you can—at a minimum—perform the basic functional verification tests described in
this manual. If you have the Gold edition of the service tool, you have the additional capability to perform

a complete functional verification and calibration of the device, but this is not required for minimal periodic
service.

In contrast, any time you open the device case, you must use the Welch Allyn Service Tool, Gold edition, to
perform a complete functional verification and calibration of the device before returning the device to service.

::'1] NOTE For instructions on using the Gold edition, see the service tool help files.

About the Welch Allyn Service Tool

The service tool is required to complete functional verification and calibration tests. The service tool is available
in the following editions:

« Standard unlicensed edition: Enables NIBP functional verification tests to satisfy the recommended annual
service. If any Standard unlicensed edition testing shows an out-of-specification result, use the Gold edition
to perform a full calibration.

« Gold edition: Checks the functionality and calibration of the device. As it checks the device, the Gold edition
also performs any needed calibration to bring the device within specifications. This full suite of tests is
required to complete a repair. Each time you open the case, you must use the Gold edition to test the device
before returning the device to normal use.

m NOTE Verify that the final test service record from the Service Tool shows evidence that each of the tests

T required for a given model number are present and the test was performed.
For information about the service tool, see the following:

« Forinstructions on installing and using the service tool, see the Installation and Configuration Guide.
- To use the Standard unlicensed edition to test the NIBP module, follow the instructions in this service manual.
« Forinstructions on using the Gold edition, see the service tool help files.

Standard unlicensed edition service tool tests performed

The service tool performs the following functions on the host device and installed options.

Test Description NIBP Temp Sp02 Host

Reads firmware  Displays the v v v v
firmware version

Firmware Loads the latest V4

upgrade firmware into the

module
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Test Description NIBP Temp Sp02 Host
Leak test Verifies leaks 7
using 100 cc
volume
Accuracy test Checks the J
(NIBP) accuracy of
transducers
across the
pressure range
Overpressure Verifies the v
test maximum cuff
pressure
Gold edition service tool tests performed
The service tool tests the host device and installed options as listed in the following table.
Test Description NIBP Temp Sp02 Host
POST Performs the v v v v
power-on self
test (POST)'
Firmware version Checks the v v v v
firmware version
Firmware Loads the latest N4
upgrade firmware into the
module
Leak Verifies leaks J
using 100 cc
volume
AD noise Checks noise on J
the pressure
channel
Calibration Calibrates 7
pressure
transducers
Accuracy (NIBP)  Checks the J
accuracy of
transducers
across the
pressure range
Dump Checks dump v
valves
Pump inflation Verifies the v
pneumatic

pump
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Test Description NIBP Temp Sp02 Host
Overpressure Verifies pump J
limits
Probe detect Verifies the 4
operation of the
probe detect
switch?
Accuracy (Temp) Verifies the v
accuracy of the
thermometer
across range
Temperature Verifies v
functional check temperature
module with cal-
key?
SpO2 functional Verifies module J
check operation with
an Sp0O2
simulator
Display Verifies video V4
output
Back light Verifies display J
interface LED back light
Touchscreen Verifies v
interface touchscreen
calibration
LED Verifies the LED 7
Beeper Verifies the J
buzzer
Battery Verifies the 7
operation internal battery

' POST testing checks the following:

« NIBP:ROM, RAM, A/D channels, calibration, and user configuration.
Temperature: ROM, RAM, calibration, and heater.
Sp02: ROM and RAM, and connection to the SpO2 board.

? SureTemp Plus only.

Electrical safety testing

Baxter recommends performing ground continuity and leakage current tests after all open-case repairs and
dielectric strength testing is not recommended.

::"_‘J NOTE Perform dielectric strength testing only if there is a reason to doubt the integrity of the electrical
T insulation (for example, multiple trips of a residual-current device or liquid ingress of a saline solution). If
you determine this test should be performed, return the device to Baxter for service.
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These recommendations trace to EN/IEC 60601-1 — Medical Electrical Equipment — Part 1: General Requirements
for Basic Safety and Essential Performance or EN/IEC 62353 - Medical Electrical Equipment - Recurrent Test and
Test After Repair of Medical Electrical Equipment.

Because of the variability of test equipment in the field, Baxter does not include specific instructions to perform
electrical safety tests. When performing electrical safety tests, refer to your test equipment manuals for detailed
instructions to ensure proper test equipment setup that aligns with the appropriate standard. The following
table provides connections and test limits to assist you in performing these tests.

Test Limits

Ground continuity (see Note  Ground continuity from EP stud (equipotential terminal)! to the Gnd pin of the
above) IEC power connector shall be no greater than 0.1 ohms.

Leakage current (see Note Leakage current shall be less than 500 pA from EP stud’ to mains (Line and
above) Neutral pins of the IEC power connector).

Insulation resistance Dielectric strength shall be 500 V (DC) EP stud’ to IEC mains (Line and Neutral
pins of the IEC power connector), and insulation resistance is measured.

1 To locate the equipotential terminal, see “Controls, indicators, and connectors.”

Devices with an external power supply

The power bricks are CB Certified and UL Listed; they meet ALL of the requirements that the Medical Device
standard requires for power supplies. The manufacturer is required to perform 100% electrical safety testing on
all of their power bricks prior to shipment. Baxter does not perform nor recommend testing on these external
power bricks because additional testing would put undue stress on the insulation system and possibly cause
premature failures in the field. Open case repairs of devices with external power supplies are only dealing with
DC circuitry and robust isolation circuits built into the printed circuit boards. No additional after-servicing testing
is required in that instance. The patient isolation systems within the device (Temperature Probe, SpO2 sensor,
etc.) all have visible isolation gaps built into the printed circuit board. The quality control on the PCB and the
thorough type-testing performed by the testing agency (ETL) eliminates the need for further testing on the
devices that are downstream from the mains isolation device.

Devices with an internal power supply

The internal power supplies are CB Certified and UL Registered. These power supplies are an open frame style
(no protective enclosure). Therefore, the products that contain an internal power supply require electrical safety
testing. Open case repairs of devices with an internal power supply require the recommended testing because
those devices contain the open frame power supply, and the testing involves the manipulation of wiring that
carries 120 or 240 volts AC. Baxter does not recommend HiPot / Dielectric Withstand testing because of a
potential stress on the insulation system, which could cause premature failures.

Basic functional verification

Basic functional verification checks

:-‘I NOTE Calibration is available only with the service tool, Gold edition.

These tests verify basic functionality of the NIBP, Sp0O2, and thermometry parameters. These tests support the
requirements of routine preventive maintenance. However, they are not a substitute for the complete functional
tests available with the service tool, Gold edition. Welch Allyn recommends using the service tool, Gold edition,
to perform preventive maintenance and verification of the device when completing a repair.
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Basic functional verification tools

The list of tools below is what Welch Allyn uses to perform a basic device functionality check. Most facilities use
a device simulator or equivalent products to perform this test.

Material no. Description Qty Component
407672 BP test volume repair 1 NIBP
fixture 113670
N/A Sp02 simulator 1 Sp02
DOC-10 Nellcor SpO2 extension 1 Nellcor SpO2
cable
06138-000 Cal-key, assembly, 1 SureTemp Thermometry
M690/692 Module
N/A Pressure meter (must 1 NIBP
include at least two
decimal points and be
accurate to within 0.5
mmHg)
6000-30 Single-tube blood 1 NIBP
pressure hose, 5 feet
N/A PC running Windows 10 1 All

web download

Welch Allyn Service Tool

https://
www.hillrom.com/en/
services/welch-allyn-
service-tool/

NIBP, Software updates

N/A

Blood Pressure Y-tube

NIBP

620216

Fitting "Y" 1/8 X 1/8 X 1/8

NIBP

NIBP test setup

For the NIBP leak test, overpressure test, or accuracy check, connect the test equipment shown below. Connect
the manifold to the volume repair fixture as indicated by the service tool or the test procedure.



http://welchallyn.com/en/service-support/service-center/service-tool.html
http://welchallyn.com/en/service-support/service-center/service-tool.html
http://welchallyn.com/en/service-support/service-center/service-tool.html
http://welchallyn.com/en/service-support/service-center/service-tool.html
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No. Item No. Item

1 Test volume repair fixture with test manifold, 4 Device
bulb, and valve

2 Pressure meter (must include at least two 5 USB 2.0/5-pin type A to mini-B cable
decimal points and be accurate to within
+0.5 mmHg)

3 Blood pressure Y-tube 6 PC

Create a blood pressure Y-tube

=

The blood pressure Y-tube is a piece of custom test equipment that connects the device to the test setup. The
Y-tube is composed of a modified blood pressure hose and a Y-type fitting. Follow these instructions to create a
Y-tube.

1. Cut a 4500-30 blood pressure hose approximately 6 inches from the connector that connects to the device.
2. Split the end of the dual-lumen hose to create two separate hoses. Make sure not to puncture either hose.
3. Insert one end of the Y-type fitting into each end of the hose.

NIBP tests

For the NIBP leak test, overpressure test, or accuracy check, connect the test equipment according to the test
setup diagram for your configuration presented in the next section. Connect the manifold to the volume repair
fixture as indicated by the service tool or the test procedure.

NIBP leak test (Standard unlicensed edition)

The NIBP leak test is performed automatically using the service tool. The leak test pressurizes the system with a
start pressure (P,) of 250 mmHg + 10 mmHg. After 15 seconds (T;) the end pressure (P,) is measured. The leak

rate is calculated using the formula L = (P — Pc)/ T;. The test fails if the leak rate exceeds 5 mmHg in 15 seconds.

Perform an NIBP leak test

Set up the test equipment.

Launch the service tool on the PC.

If the simplified interface is active, choose the Service option.
Log in as ADMIN or any account with Admin privileges.
Power on the device.

Select the device you want to test from the device list.

Click NIBP Sensor under the Device Information tab.

© No vk W=

Click Leak Test in the NIBP Sensor pane on the right side of the window.

9. Follow the prompts until the test completes.

10. Click Close.

11. To view the results, open the active log file by selecting File > View Log File > Active log file > Ok.
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12.To record the results of your test, go to the NIBP tests in the "Service record" section.

NIBP overpressure test

The NIBP overpressure test is performed automatically using the Embedded Service Tool. The overpressure test
verifies that the NIBP system will prevent the pressure from exceeding 329 mmHg in adult mode and 164 mmHg
in neonate mode. To pass this test, the device must shut down the pump and open the valves when the pressure
is between 280 mmHg and 329 mmHg in adult mode, or 130 mmHg to 164 mmHg in Neonate mode.

Perform an NIBP overpressure test
:_'1] NOTE If you are performing this test after performing the NIBP leak test, skip to step 7.

Set up the test equipment.

Launch the service tool on the PC.

If the simplified interface is active, choose the Service option.
Log in as ADMIN or any account with Admin privileges.
Power on the device.

Select the device you want to test from the device list.

Click NIBP Sensor under the Device Information tab.

© Ny A W=

In the NIBP Sensor pane on the right side of the window, click Over Pressure Test.

9. Follow the prompts until the test completes.

10. Click Close.

11. To view the results, open the active log file by selecting File > View Log File > Active log file > OK.
12.To record the results of your test, go to “Service record.

NIBP accuracy check (Standard unlicensed edition)

The NIBP accuracy check is performed manually using the service tool to control the valves. The accuracy check
compares the reading from the primary transducer pressure shown in the service tool window with the reading
from an external calibrated digital pressure meter. The results of this check are not recorded in the service tool
log file. To record the results for your records, copy the table in the service record section of the service manual. If
a calibration is required, run the NIBP calibration included with the Gold edition of the service tool.

m NOTE The APM must be connected to AC power 15 V while calibrating NIBP.

WARNING Patient safety risk. If the primary transducer fails, the system might not identify an
overpressure condition at the right limit, causing injury when the device is re-connected to a patient.

To ensure patient safety, Baxter recommends that a qualified service technician perform a full functional
verification and calibration on an annual basis.

& CAUTION Equipment calibration error can occur. This accuracy check verifies only the accuracy of the
primary transducer. If the safety transducer is out of calibration, a calibration error can occur due to the
pressure difference between the primary transducer and the safety transducer. To avoid equipment
calibration errors, Baxter recommends that a qualified service technician perform a full functional
verification and calibration on an annual basis.

Perform an NIBP accuracy test without the Welch Allyn Service Tool
The following tools are required to perform this test:

«  CSM with SWF ver. 1.33.00 -X0006 or greater
Blood Pressure Bulb
«  Pressure Meter
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+ Dual Lumen Pressure Tubing
+ Pressure Test Box

1. Navigate to the Advanced tab.
2. Inthe Advanced settings code box, enter your advanced settings password.
3. Navigate to Service > General.

The NIBP Pressure Verification feature is located in the bottom right of the screen.
4. Connect the dual lumen tubing to the device.

5. Connect one end of the tubing to the pressure meter and the other end to the test box. Ensure each end is
connected tightly and there are no leaks.

6. To initiate the verification process, touch Close Valve.
7. Use the blood pressure bulb to adjust the pressure to each threshold of 20/50/100/150/250 mmHg.
8. Compare the pressure displayed on the NIBP Pressure Verification screen and the pressure meter.

Perform an NIBP accuracy check

n you are performing this test after performing a previous check, skip to step 7.
f NOTE |If formi hi f formi i NIBP check, ski 7

Set up the test equipment.

Launch the service tool on the PC.

If the simplified interface is active, choose the Service option.
Log in as ADMIN or any account with Admin privileges.
Power on the device.

Select the device you want to test from the device list.

Click NIBP Sensor under the Device Information tab.

©® N U W=

Click Accuracy Check in the NIBP Sensor pane on the right side of the window.

9. Connect the 500 CC volume.

10. Turn on the pressure meter and zero if necessary.

11. Check the accuracy at 0 mmHg.

12. Record the reading on the pressure meter and the service tool and compare the results.

13. Using the hand bulb, pressurize the NIBP system to 50 mmHg + 5 mmHg and allow 10 seconds for the
pressure to stabilize.

14. Record the reading on the pressure meter and the service tool and compare the results.

15. Using the hand bulb, pressurize the NIBP system to 150 mmHg + 5 mmHg and allow 10 seconds for the
pressure to stabilize.

16. Record the reading on the pressure meter and the service tool and compare the results.

17. Using the hand bulb, pressurize the NIBP system to 250 mmHg + 5 mmHg and allow 10 seconds for the
pressure to stabilize.

18. Compare the reading on the pressure meter to the service tool reading and record the results.

19. Click Open valve to open the NIBP valves. Verify that the pressure on the meter and service tool change to
zero.

20. Click Done to complete the check.
21.To record the results of your test, go to “Service record.”

SpO2 test

Select the procedure here that applies to your configuration to test the device's SpO2 function. Connect the test
equipment according to the test setup diagram for your configuration presented here.
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Perform an SpO2 test

Use this procedure to test only the device SpO2 function.

1. Power on the device.

Connect the SpO2 functional simulator to the SpO2 input connector.

-
%ﬂ NOTE In the following tests, if the simulator defaults are outside the device alarm limits, adjust the
limits or silence the alarms.

Adjust the simulator settings as follows:
For Nonin and Nellcor configurations, set the simulator SpO2 saturation to 90% and pulse rate to 60 bpm.

For Masimo configurations, set the simulator SpO2 saturation to 80% and pulse rate to 61 bpm.

4. Give the device up to 30 seconds to stabilize.

6.

Verify the displayed saturation and pulse rate as follows:

For Nonin and Nellcor configurations, saturation should be 90% +1 sat point, and pulse rate should be 60 +1
bpm.

For Masimo configurations, saturation should be 80% +3 sat point, and pulse rate should be 61 +1 bpm.

Disconnect the simulator.

SpO2 test setup

For the SpO2 test, connect the test equipment as shown below.

D@
e

P e e L Xy I

No. Item

Connex Spot Monitor

SpO2 simulator

Power supply
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Thermometry tests
Thermometry test setup

For the thermometry test, connect the test equipment shown below.

::'1] NOTE The drawing shows a SureTemp Plus configuration, but the setup for a Braun ThermoScan®
T PRO 6000 configuration is identical minus the Cal-key.

® ®
:
@

No. Item No. Item

1 Connex Spot Monitor 3 Tester, calibration, 9600
Plus

2 Power supply 4 Cal-key, assembly,
M690/692

(used only with SureTemp)

SureTemp temperature system test

The SureTemp temperature system test is performed using a calibration key (cal-key). The calibration key tests
the system using a fixed resistance to display a temperature of 97.3 + 0.2 °F (36.3 £ 0.1 °C).

::'1] NOTE If your facility requires you to test the temperature probes, you will also need to have heaters at
T three temperature settings to test the probes. See "SureTemp temperature probe and system test."

Perform a SureTemp temperature system test

1. With the system power on and the temperature probe in the well, disconnect the probe cable from the
temperature input connector on the bottom of the device.

2. Connect the calibration key to the temperature input connector.
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3. Remove the probe from the well.
4. Verify that the displayed temperature is 97.3 £ 0.2 °F (36.3 + 0.1 °C).
SureTemp probe and system test

Use this procedure to test the temperature function while verifying the temperature probe. To achieve accurate
results, you must perform this test with the device in Direct mode.

Test each probe at the low, medium, and high set points on the tester. Repeat the procedure for each
thermometer and temperature to test.

Set up the 9600 Plus calibration tester

Place the tester on a level surface away from sunlight, drafts, and other sources of heat or cold.
The tester takes approximately 20 minutes to heat to the lowest set point.

To expedite testing, recommends the following practices:

« To eliminate waiting for the tester to heat to the next set point, use three testers, each set to one of three
different set points.

«  When using only one tester to test several thermometers at all three temperatures, test all thermometers at
one set point before proceeding to the next set point.

« To eliminate waiting for the tester to cool down, start at the lowest set point. Because the tester does not
have an internal fan, it requires more time to cool down than to heat up.

Change the 9600 Plus set point
To scroll from one set point to the next, press and hold the Temperature Selection button until a beep sounds.

The new set point appears in the upper left corner of the display. The device’s current temperature appears,
flashes, and continues flashing until the cavity reaches equilibrium at the new set point. The 9600 Plus beeps
when the set point is reached.

Perform a SureTemp temperature system test

1. With the system power on and the temperature probe in the well, disconnect the probe cable from the
temperature input connector on the bottom of the device.

2. Connect the calibration key to the temperature input connector.

3. Remove the probe from the well.

4. Verify that the displayed temperature is 97.3 £ 0.2 °F (36.3 0.1 °C).

Braun ThermoScan® PRO 6000 thermometer test

This explains how to perform a functional verification on the Braun ThermoScan®PRO 6000 thermometer using
the 9600 Plus Calibration Tester.

m NOTE Use this procedure with the Welch Allyn Service Tool version 1.8.0 and later.

CAUTION Before the test, place thermometers and tester in the same room for approximately 30
minutes so that they adjust to the ambient temperature.

For more information, see the Welch Allyn9600 Plus Calibration Tester Directions for use.
Perform a Braun ThermoScan PRO 6000 functional verification test

Complete the preliminary checks as described in step 1, then test each thermometer at the low, medium, and
high set points on the tester. After placing the thermometer in calibration mode, repeat the procedure from step
4 for each thermometer and temperature to be tested.

1. Before testing the thermometer verify the following:
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a. The sensor (probe tip) is functional. Check the position of the sensor with a magnifying glass if necessary.

If the sensor is displaced, the unit is damaged and must be replaced. There should be no visible gap
between the bezel and the lens.

b. The sensor is clean. Clean the sensor using a Q-tip lightly moistened with isopropyl alcohol, using a
minimum amount of pressure to avoid displacing the sensor. Use a dry Q-tip to remove any excess
alcohol. Allow 5 minutes for any remaining alcohol to evaporate.

¢. The room temperature is within the range of 65.0 °F (18.3 °C) to 80.0 °F (26.7 °C).

d. The thermometer is allowed to reach the ambient room temperature. Remove the thermometer from the

product packaging and wait at least 30 minutes before beginning the test.
e. The thermometer is fully charged.
2. Place the thermometer from sleep mode into calibration (CAL) mode as follows:
a. Remove the device from the dock.
. Wait for 20 seconds for the device to go into sleep mode (the display goes blank).
Press and release the C/F button.

b
C
d. When the self check/startup display appears, press and hold the C/F and Mem buttons for 5 to 7 seconds.
e

. When the device beeps, release the C/F and Mem buttons.

If the device is in CAL mode, the display will alternate between the ’- -’ lines and “CAL"

f. If the device doesn't enter CAL mode, wait for the device to return to sleep mode and repeat from substep

C.
3. Apply a new probe cover. Place the probe firmly into the Ear Device Port.
4. Wait approximately 3 seconds, and then press the thermometer Measure button.

The ExacTemp light flashes.
5. Leave the thermometer in the tester until a long beep sounds.

6. Remove the thermometer from the tester and read the temperature in the thermometer’s display. If the
temperatures are within +£0.2 °C (£0.4 °F) of the tester’s set point, the thermometer is within calibration.

7. Record the results in the thermometer service record.
8. Press the Measure button once to clear the previous reading.
9. Wait 1 minute, and then take another reading with the same thermometer.

Repeated measurements in short sequence might cause higher readings.

I I NOTE If using only one tester, test all available thermometers for calibration verification at the
current set point, before raising the set point.

10. Repeat the procedure from step 3 as necessary until all thermometers are tested at each temperature.
11. Exit CAL mode using one of the following methods:

+ Press and hold the C/F and mem buttons until you hear the beep and the display is blank.
Wait and don't press any buttons for 10 minutes. The thermometer automatically exits CAL mode.

To record the results of your test, go to “Service record.”

Full functional verification and calibration

Functional verification test setup

Connect the test equipment to your device as shown in these drawings to complete the functional tests
described in this section.

Option 1. Configurations with Accessory Power Management (APM)



104 Functional verification and calibration overview Connex Spot Monitor

@®) ®

2l

®

&@
NIBP o< | =2 & Sp02
T&m :

\

R
J [

-----------

Option 2. Configurations without Accessory Power Management (APM)
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Required Welch Optional Welch
Allyn purchase Allyn purchase

Item No. Material No. Description Qty (see Notes)
1 Varies Connex Spot 1 X
Monitor
2 N/A Wireless router, 1
a/b/g or
equivalent
3 N/A Ethernet cable 1
4 N/A Ethernet cable 1
5 N/A PC running the 1
Welch Allyn
Service Tool on
Windows 10
6 N/A SpO2 simulator 1
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Connex Spot Monitor

Item No.

Material No.

Description

Qty

Required Welch Optional Welch
Allyn purchase Allyn purchase

(see Notes)

7

Doc-10

Nellcor Sp0O2
extension cable

8

Varies

(Option 1)

APM
(configurations
with Accessory
Power
Management)

8

Varies

(Option 2)

Power supply
(configurations
with no APM)

9

106270

Service test box

10

106275

Micro USB cable

1

N/A

Pressure meter
(must include at
least two
decimal points
and be accurate
to within +0.5
mmHg)

12

407672

Test volume
repair fixture
(113670) with
test manifold,
bulb, and valve

13

N/A

Blood pressure
Y-tube

See instructions for creating the
Y-tube in the Basic functional
verification section.

14

01802-110

Tester,
calibration, 9600
Plus, SureTemp

X

15

06138-000

Cal-key,
assembly,
M690/692

NOTE All items listed in this table are required to complete a full functional verification and
calibration. If Welch Allyn does not make an item available for purchase, you must provide it yourself.

NOTE You may substitute items marked as an optional Welch Allyn purchase with comparable OEM

products.

Full functional verification check and calibration tools

The list of tools below is what is required to perform a full device functionality check and calibration. The tools
are used in conjunction with the Welch Allyn service tool, Gold license, to perform a device calibration.
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Material no. Description Qty Component
01802-110 Tester, calibration, 9600 3 Braun ThermoScan PRO
Plus 6000 & SureTemp Plus
probes
407672 BP test volume repair 1 NIBP
fixture 113670
N/A SpO2 simulator 1 Sp02
06138-000 Cal-key, assembly, 1 SureTemp Plus
M690/692 Thermometry Module
N/A Pressure meter (must 1 NIBP
include at least two
decimal points and be
accurate to within +0.5
mmHg)
DOC-10 Nellcor SpO2 extension 1 Nellcor Sp0O2
cable
106270 Service test box 1 Nurse Call, USB ports
N/A Ethernet cable 1 Ethernet Test
106275 Micro USB cable 1 All
6000-30 Single tube blood 1 NIBP
pressure hose, 5 feet
N/A Wireless router, a/b/g or 1 Wired & Wireless Test
equivalent
N/A PC running the Welch 1 All
Allyn Service Tool on
Windows 10
1001120 Welch Allyn Service Tool 1 NIBP, Software updates

Gold license

web download

Welch Allyn Service Tool

https://
www.hillrom.com/en/
services/welch-allyn-
service-tool/

NIBP, Software updates
and calibration

4500-30

Blood pressure hose, 5 ft.

NIBP

620216

Fitting "Y" 1/8 X 1/8 X 1/8

NIBP

Initialize the NIBP board

Functional verification and calibration must be performed each time the device is disassembled or more
frequently if your facility’s procedures require a full calibration on a specified basis. If you have just replaced a
Main PCA board, your first step before performing a full verification and calibration is to initialize the NIBP Board.

1. Set up the equipment for full functional verification as shown earlier in this section.


http://welchallyn.com/en/service-support/service-center/service-tool.html
http://welchallyn.com/en/service-support/service-center/service-tool.html
http://welchallyn.com/en/service-support/service-center/service-tool.html
http://welchallyn.com/en/service-support/service-center/service-tool.html
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Log in to the Welch Allyn Service Tool, highlight your device in the Device list, and click Select.

This action opens the Connex Spot Monitor > Device information subtab. Depending on your
configuration, it could take 30-45 seconds to populate this subtab.

Select the Verify and calibrate subtab.

4, Select NIBP sensor in the Device field.
5. Click Calibrate.

0.

This opens the Verify and calibrate NIBP Sensor dialog.
Click Begin.

A list of tests appears in the left pane of the dialog along with three controls in the right pane.

Click Initialize NIBP Board in the right pane.

A confirmation window appears with the message, "Are you sure you want to reset the calibration offsets of
the NIBP Board?"

Click Yes.

This action places two tests in the queue for initialization: the Power Calibration Test — Primary/Safety and the
Pressure Calibration - Primary/Safety.

L l NOTE A message appears in the right pane to indicate the first test is in progress. If the test passes,
a green check appears to the left of the test name, and the second test begins. If the test fails, a

red check appears to the left of the test name, followed by a prompt to rerun the test. You cannot
proceed to the second test until the first test passes.

Rerun the Power Calibration Test as needed until the test passes.

10. If you did not set up your equipment for a full calibration initially, connect the 500cc volume to the device

11.

when prompted and then click Next.

?ﬂ NOTE Your cannot initialize the board without setting up the equipment for the Pressure Calibration
test.

Observe the pressure calibration messages onscreen and follow the onscreen prompts to manually adjust
device pressure with the hand bulb to 250 + 5 mmHg.

12. Once you reach the targeted pressure, enter the exact value on the pressure meter in the Meter pressure

field, then click Next to record this value.

If the test passes, a green check appears to the left of the test name. If the test fails, a red check appears to the
left of the test name, followed by a prompt to rerun the test.

13. Rerun the Pressure Calibration test as needed until the test passes.

14. If the second test passes, click Close.

The NIBP board is now initialized.
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Options and upgrades

Welch Allyn supports option and software upgrades for most models.

::'1] NOTE Software in the Braun ThermoScan® PRO 6000 is not upgradable in the field when installed in
T the Connex Spot Monitor. To upgrade the Braun ThermoScan® PRO 6000 software, return the monitor
to a service center.

Option upgrades for devices still under warranty that require any installation inside the device must be
performed by a Welch Allyn service center unless you participate in the Partners in Care Biomed Partnership
Program. If you want to install the options, we recommend you attend either the classroom or online technical
training course for the device. The training is required to be eligible to receive the Welch Allyn Service Tool
Gold edition. The Gold edition is required to verify that the device is functioning correctly after it has been
serviced. Although all of the option upgrades are calibrated and tested before leaving the factory, Welch Allyn
recommends performing a complete functional test whenever the device is serviced.

T'__] NOTE For the Welch Allyn Service Tool to support updates and upgrades, adjust your firewall settings
T to permit access for IP address 169.254.10.10 (the local feed server for the software upgrade process).

Software upgrades, when available, can be purchased or provided at no charge if your device is covered by a
Welch Allyn Service Agreement. The upgrades can be installed by either a Welch Allyn service center or by
using the service tool, Standard unlicensed or Gold edition.

If you choose to install software upgrades on your own, you will receive the software through the internet. When
ordering software, provide the serial number of the device you want to install the software on.

EI NOTE The device must be plugged in to AC power and have at least 15 minutes of battery charge
; remaining to execute software upgrades. You can download software upgrades on battery power, but
you cannot implement them without AC power.

Available options

The following options can be added to each model’s base configuration.

Q CAUTION Before installing any option, disconnect the patient from the monitor and power down the
device.

:-'l NOTE Some model numbers and product features described in this publication might not be available
T in your country. For the latest information about products and features, please contact Welch Allyn
Customer Care.

Options

Model 7100 7300 7400 7500
Masimo X O1 .1 3 .1 3

Masimo SpO2 with RRp

N
N
N

Nonin

Nellcor OxiMax

SureTemp Plus

OO x| O] x
Ol0|0|0

Braun ThermoScan® PRO 6000
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Model 7100 7300 7400 7500
Wireless radio X X O [ )
Bluetooth radio X [ ] X O

! Contact Welch Allyn Customer Care to purchase the optional respiration rate software license: 7000-RRP
Masimo MX5 RRp CSM license.

2 Configurations 73RE, 73RT, 73RX, 74RE, 74RT, 74RX , 75RE, 75RT, and 75RX come with Masimo SpO2 and RRp.
3 This configuration comes with either Masimo, Nonin, or Nellcor.

4 Contact Welch Allyn Customer Care to purchase the optional Bluetooth Low Energy software license:
108060BLE

CSM 7300 BLE license.

@ standard with this model. O software upgrade available X No software upgrade available for this
for this model. Hardware model. Hardware upgrade available only
upgrade available only on a on a case-by-case basis.
case-by-case basis.

Install options

All internal option installations entail opening the device case and performing some disassembly. Because
this process requires disconnecting internal components, Welch Allyn requires that the device undergo a full
functional test after reassembly and before placing the device back in service.

Before installing a new option, read information about removing the option in “Disassembly and repair.” After
familiarizing yourself with the process, follow the instructions in the disassembly section.

Upgrading software with the Welch Allyn Service
Tool

The Connex Spot Monitor and the Service Tool (WAST) interact through Ethernet over USB technology, enabling
the monitor to function as a USB device with both a network and an IP address. This connection separates
logically into two distinct interfaces: a generic USB serial connection and a Remote Network Driver Interface
Specification (RNDIS) network interface, which is a Microsoft Windows driver. Most interactions between the
WAST and the Connex Spot Monitor take place over the generic USB serial connection. In contrast, software
upgrades require the RNDIS interface for the device to connect the WAST and download the firmware.

During software upgrade, the Ethernet over USB interface with the WAST is auto-configured with the
specifications noted in the table below. When the Connex Spot Monitor reaches out to the WAST for

the firmware package, it uses TCP port XXXX. Be prepared to modify any firewall(s) that prevent incoming
connections to allow this traffic. The WAST attempts to configure the Windows firewall by opening this specific
port on the RNDIS interface. If administrative controls such as a Group Policy Object (GPO) or third-party
software have been implemented to prevent this change, the WAST attempts to diagnose the problem and then
inform you of possible remediation steps. Work with your IT staff or Network Administrator as needed to enable
this functionality
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Interface specifications IP address Network mask
Device Ethernet over USB interface 169.254.10.10 255.255.255.255
WAST RNDIS interface 169.254.10.1 255.255.255.255

At the start of a software upgrade, the Service Tool creates a local HTTP server and uses the USB connection to
transfer necessary file package to the Connex Spot Monitor. Once the file package is on the device, it launches
the installation of host controller firmware and reboots the device immediately following the installation.
When the device auto-reboots, the software upgrade of individual modules and sensors (NIBP, Sp0O2, and/or
Temperature) is complete.

Software upgrade availability for the Connex Spot Monitor can be checked directly within the Service Tool
(WAST). Availability of software upgrades is also communicated via the Customer Service Bulletin on s website at

https://www.welchallyn.com/content/welchallyn/emeai/in/products/categories/patient-monitoring/vital-signs-
devices/connex-spot-monitor/documents.html#customerservicebulletin.

Software rollback capability

The Connex Spot Monitor utilizes a primary and secondary software structure. In the final step of the software
upgrade, the device rolls the previous firmware package to a secondary image and identifies the newly installed
firmware as its primary image. This structure allows rollback to previous versions as needed. For example, if you
performed a software upgrade and then determined that it didn't meet your expectations or conform to your
workflow, you can execute a software rollback in seconds and limit device downtime.

m NOTE When operating with software version 1.53.00, the software will not allow rollback to an older

T version.
To roll back your software, follow these steps:

Connect the device to your laptop and open the Welch Allyn Service Tool.
Click the Configure tab.

In the Current settings window, click Change....

Click the Device Software Rollback tab.

Click Rollback.

In the Confirm Device Software Rollback dialog, click Yes to confirm.

o Uk wnN =

In addition, because the software upgrade is already loaded on your device, you can use the rollback capability
at a later time to implement the upgrade and complete the associated setup activities. Follow the same steps
presented above to activate the new firmware

Upgrade the device firmware

Updating a device requires a PC, a USB cable, and an Internet connection. See the Service Tool Installation Guide
for Admin password information.

SmartCare services for maintenance and repair

SmartCare protection plans

Part number Description

S1C-SM-PRO-1 CSM SmartCare Protection 1YR



https://www.welchallyn.com/content/welchallyn/emeai/in/products/categories/patient-monitoring/vital-signs-devices/connex-spot-monitor/documents.html#customerservicebulletin
https://www.welchallyn.com/content/welchallyn/emeai/in/products/categories/patient-monitoring/vital-signs-devices/connex-spot-monitor/documents.html#customerservicebulletin
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Part number

Description

S1-CSM-PRO-3

CSM SmartCare Protection 3YR

S1-CSM-PRO-PS

CSM SmartCare Protection 3YR POS

SmartCare protection plus plans

SmartCare protection plus plans include onsite repair.

Part number

Description

S9-CSM-PROPLUS-1

CSM SmartCare Protection Plus 1YR

S9-CSM-PROPLUS-3

CSM SmartCareProtection Plus 3YR

S9-CSM-PROPLUS-PS

CSM SmartCare Protection Plus 3YR POS

SmartCare biomed plansi

Part number Description

S1-CSM CSM, Comprehensive partnership program, 1 year

S1-CSM-2 CSM, Comprehensive partnership program, 2 years

S1-CSM-5 CSM, Comprehensive partnership program, 5 years

S1-CSM-C CSM, Comprehensive partnership program, 1 years +
Calibration

S1-CSM-2C CSM, Comprehensive partnership program, 2 years +
Calibration

S1-CSM-5C CSM, Comprehensive partnership program, 5 years +
Calibration

S$2-CSM CSM, Biomed partnership program, 1 year

S52-CSM-2 CSM, Biomed partnership program, 2 years

$2-CSM-5 CSM, Biomed partnership program, 5 years

SmartCare biomed plans (available only in selected international

countries)

Part number Description

S4-CSM CSM, Warranty Extension, 1 year
S4-CSM-2 CSM, Warranty Extension, 2 years
S4-CSM-5 CSM, Warranty Extension, 5 years
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Service and repair training

::'1] NOTE Required to be eligible to receive the service tool, Gold edition.

Part number Description
CSMREP-TRN CSM repair training
CSMREPW-TRN

CSM repair web training
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Specifications

Physical specifications

Protection classifications, all monitor configurations

Characteristic

Specification

Electrical rating

Power supply model: FW8031M/DT/15
Input: 100 - 240V AC, 50 -60Hz, 0.6 A-0.3 A
Output: 15V DC,2.0A

Power supply model: MENB1035A1500F02
Input: 100 - 240 V AC, 50 - 60 Hz, 0.8 A- 0.5 A
Output: 15V DC, 2.33 A

Duty cycle

Continuous operation

Type of protection against electric
shock

Class l internally powered

Degree of protection against electric
shock, for parts applied to patients

Type BF defibrillator proof
IEC EN 60601-1, 2nd and 3rd Editions

Recovery time following defibrillator
discharge

Less than or equal to 15 seconds

Flammable anesthetics

C WARNING Not suitable for use with flammable anesthetics.

Degree of protection provided by
the enclosure with respect to
harmful ingress of liquids

IPX2 Protection against vertically falling water drops when enclosure
tilted up to 15°

Height

Standard chassis: 6.3 in. (16.1 cm)
Extended chassis: 6.5 in. (16.5 cm ) with Braun

Extended chassis: 6.4 in. (16.3 cm ) with SureTemp

Width

Standard chassis: 9.2 in. (23.4 cm)
Extended chassis: 11.7 in. (29.8 cm ) with Braun
Extended chassis: 11.7 in. (29.8 cm ) with SureTemp

Depth

Standard chassis: 2.3 in. (5.8 cm)
Extended chassis: 4.4 in. (11.0 cm ) with Braun

Extended chassis: 4.2 in. (10.6 cm ) with SureTemp
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Protection classifications, all monitor configurations

Characteristic Specification

Weight (including battery) Standard chassis: 2.9 1b (1.3 kg )
Extended chassis: 3.7 b (1.7 kg ) with Braun
Extended chassis: 3.5 b in. (1.6 kg ) with SureTemp

Graphical display resolution

Dimensional outline 6.5in. (W) x4.1in.(H) x 0.13in. (D) (164.9 mm [H] x 103.8 mm [W] x 3.40
mm [D])

Active area 6.1in. (W) x3.4in. (H) (154.08 mm [W] x 85.92 mm [H])

Resolution 800 x 480 pixels

Pixel arrangement RGB (red, green, blue)

Pixel size 63.2 um (W) x 179 um (H)

Luminance 530 cd/m2

Speaker volume

Minimum Output sound pressure 60 dB at 1.0 meter

Alarm and pulse tones per IEC 60601-1-8

Pulse frequency (fo) 150 - 1000 Hz

Number of harmonic components in minimum of 4
the range 300 Hz to 4000 Hz

Effective pulse duration (tg) high priority: 75 -200 ms

medium and low priority: 125 - 250 ms

Rise time (t,) 10 - 20% of t4

Fall time 1(tf) <ttt

T a minimum of at least 53 dBa and a maximum of at least 80 dBa at the pulse frequency.

:-'1] NOTE The range of the relative sound pressure level of the harmonic components should be between

1 Prevents overlap of pulses

Battery specifications

2 Cell battery specifications’

Hours of use

Continuous run time (Nellcor) 522
6 patients/hour - 41 patient cycles (Nellcor) 6.83
8 patients/hour - 54 patient cycles (Nellcor) 6.78
8 patients/hour - 55 patient cycles (Nonin) 6.90

Acute care continuous 10 minute cycles - 49 patient cycles - BP, temp, SpO2, no radio, no scanner 8.22

(Nellcor)
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2 Cell battery specifications’ Hours of use

Acute care continuous 10 minute cycles - 50 patient cycles - BP, temp, SpO2, no radio, no scanner 8.37
(Nonin)

Acute care continuous 10 minute cycles - 49 patient cycles - BP, temp, Sp0O2, no radio, no scanner 8.29
(Masimo)

Acute care continuous 10 minute cycles - 41 patient cycles - BP, temp, SpO2, radio, scanner 6.84
(Nellcor)

Acute care continuous 10 minute cycles - 41 patient cycles - BP, temp, Sp0O2, radio, scanner 6.96
(Nonin)

Acute care continuous 10 minute cycles - 41 patient cycles - BP, temp, SpO2, radio, scanner 6.90
(Masimo)

T Nellcor is the default for these examples.

Mobile stand specifications

Mobile stand Basket/bins maximum weight limit Mobile stand maximum weight limit
7000-MS3 2.01b/0.9kg 221b /10 kg
7000-MWS Front bin: 5.0 Ib /2.27 kg 441b /20 kg

Rear bin: 4.0 Ib /1.81 kg

7000-APM Front bin: 5.0 Ib /2.27 kg 441b /20 kg
Rear bin: 4.0 Ib /1.81 kg

Nurse Call connection specifications

Nurse Call 24V at 500mA maximum

NIBP specifications

NIBP specifications

Cuff pressure range Meets or exceeds IEC/ISO 80601-2-30 standards for cuff pressure range

Systolic range Adult: 30 to 260 mmHg (StepBP, SureBP)
Pediatric: 30 to 260 mmHg (StepBP, SureBP is the default for these examples.)
Neonate: 20 to 120 mmHg (StepBP)

Diastolic range Adult: 20 to 220 mmHg (StepBP, SureBP is the default for these examples.)
Pediatric: 20 to 220 mmHg (StepBP, SureBP is the default for these examples.)
Neonate: 10 to 110 mmHg (StepBP)
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NIBP specifications

Cuff Inflation Target

Adult:160 mmHg (StepBP)
Pediatric: 140 mmHg (StepBP)
Neonate: 90 mmHg (StepBP)

Maximum Target Pressure

Adult: 280 mmHg (StepBP, SureBP is the default for these examples.)
Pediatric: 280 mmHg (StepBP, SureBP is the default for these examples.)
Neonate: 130 mmHg (StepBP)

Blood pressure determination
time

Typical: 15 seconds

Maximum: 150 seconds

Blood pressure accuracy

Meets or exceeds ANSI.AAMI SP10:2002 standards for noninvasive blood
pressure accuracy (=5 mmHg mean error, 8 mmHg standard deviation)

Mean Arterial Pressure (MAP)
range

The formula used to calculate
MAP yields an approximate
value.

Adult: 23 to 230 mmHg (StepBP, SureBP is the default for these examples.)
Pediatric: 23 to 230 mmHg (StepBP, SureBP is the default for these examples.)
Neonate: 13 to 110 mmHg (StepBP)

Pulse rate range (using blood
pressure determination)

Adult: 30 to 200 bpm (StepBP, SureBP is the default for these examples.)
Pediatric: 30 to 200 bpm (StepBP, SureBP is the default for these examples.)
Neonate: 35 to 220 bpm (StepBP)

Pulse rate accuracy (using
blood pressure determination)

+5.0% (+3 bpm)

Overpressure cutoff

Adult: 300 mmHg +15 mmHg
Pediatric: 300 mmHg +15 mmHg

Neonate: 150 mmHg maximum

SureTemp Plus temperature module specifications

SureTemp Plus temperature module specifications

Temperature range

80 °F to 110 °F (26.7 °C to 43.3 °C)

Calibration accuracy

+0.2 °F (0.1 °C) (Direct mode)

Braun ThermoScan® PRO 6000

Braun ThermoScan® PRO 6000 thermometer specifications (refer to Braun ThermoScan® PRO 6000's
Instructions for use for additional information)

Temperature range

68 °F to 108 °F (20 °Cto 42.2 °C)
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Braun ThermoScan® PRO 6000 thermometer specifications (refer to Braun ThermoScan® PRO 6000's
Instructions for use for additional information)

Calibration accuracy «  +0.4 °F (0.2 °C) for temperatures ranging from 95 °F to 107.6 °F (35.0
°Cto 42°Q)

« 0.5 °F (+0.25 °C) for temperatures outside of this range

Display resolution 0.1 °For°C

SpO2 specifications

Refer to sensor manufacturer's instructions for use for additional information.

:—'1] NOTE Functional testers cannot be used to assess the accuracy of a pulse oximeter monitor.

While functional testers may be useful for verifying that the pulse oximeter sensor, cabling, and monitor

are functional, they are incapable of providing the data required to properly evaluate the accuracy of a

system's SpO2 measurements. Fully evaluating the accuracy of the SpO2 measurements requires, at a minimum,
accommodating the wavelength characteristics of the sensor and reproducing the complex optical interaction
of the sensor and the patient’s tissue. These capabilities are beyond the scope of known bench-top testers.
Sp0O2 measurement accuracy can only be evaluated in vivo by comparing pulse oximeter readings with Sa02
measurements obtained from simultaneously sampled arterial blood made using a laboratory CO-oximeter.

:_'B NOTE Contact the sensor manufacturer for further SpO2 clinical testing information.

L‘I] NOTE Refer to sensor manufacturers' instructions for use for further accuracy information.

Sp02 specifications (Masimo specifications! 23456

Sp02 performance measurement range 1to 100%

Masimo SpO2 specifications Accuracy specified when used with Masimo SET pulse oximetry
monitors or with licensed Masimo SET pulse oximetry modules using
PC series patient cables, during no motion. Numbers present £ 1
standard deviation. Plus or minus one standard deviation represents
68% of the population.

Masimo Sp0O2, No Motion 60 - 80 + 3%, adults/pediatrics/infants

70 - 100 + 2%, adults/pediatrics/infants; + 3%, neonates

Masimo Sp0O2, Motion 70 - 100 + 3%, adults/pediatrics/infants/neonates
MasimoSpO2, Low perfusion 70 - 100 + 2%, adults/pediatrics/infants/neonates
Perfusion 0.02 % to 20 %

Masimo pulse rate, No Motion 25 — 240 + 3 bpm, adults/pediatrics/infants/neonates
Masimo pulse rate, Motion 25 - 240 + 5 bpm, adults/pediatrics/infants/neonates
Masimo pulse rate, Low perfusion 25 - 240 + 3 bpm, adults/pediatrics/infants/neonates
Pulse rate 25 to 240 beats per minute (bpm)

No motion: + 3 digits

Motion: £ 5 digits
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Sp02 specifications (Masimo specifications! 23456

Saturation

:-‘I NOTE Saturation accuracy
T varies by sensor type. Refer
to the sensor Instructions for
use for additional accuracy
information.

60% to 70%

Adults, Neonates: + 3 digits

Masimo respiration rate specifications

4 to 70 respirations per minute (rpm),
3 RPM ARMS
1 RPM Mean Error

Adult and pediatric patients

Nellcor sensor accuracy guide’ 8

Sp0O2 measurement accuracy can only be evaluated in vivo by
comparing pulse oximeter readings with SpO2 measurements
obtained from simultaneously sampled arterial blood made using

a laboratory CO-oximeter. SpO2 accuracy was validated through
breathe-down-equivalent testing by Covidien using electronic
measurements to prove equivalence to the Nellcor N600x predicate
device. The Nellcor N600x predicate device was validated by
performing human-subject, “breathe-down” clinical trials.

Pulse rate

25 to 240 beats per minute (bpm) + 3 digits (no motion)

Saturation

::'1] NOTE Saturation accuracy
T varies by sensor type.

70% to 100%
Adult, neonate: + 3 digits
Low Perfusion: 0.02 % to 20 % + 2 digits

Detected pulse rate

20 to 250 beats per minute (bpm) + 3 digits

Nonin sensor accuracy guide

SpO2 accuracy testing is conducted during induced hypoxia studies
on healthy, non-smoking, light-to-dark-skinned subjects during
motion and no-motion conditions in an independent research
laboratory. The measured arterial hemoglobin saturation value
(Sp02) of the sensors is compared to arterial hemoglobin oxygen
(Sa02) value, determined from blood samples with a laboratory
co-oximeter. The accuracy of the sensors in comparison to the co-
oximeter samples measured over the SpO2 range of 70 - 100%.
Accuracy data is calculated using the root-mean-squared (A, value)
for all subjects, per 1ISO 9919:2005, Standard Specification for Pulse
Oximeters for Accuracy.

Perfusion

40-240 BPM. Adult/Ped = +/- 3 digits; Neonate = +/- 3 digits

Pulse rate

18 to 321 beats per minute (bpm)
No motion (18 to 300 bpm): + 3 digits
Motion (40 to 240 bpm): + 5 digits
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Sp02 specifications (Masimo specifications! 23456

Saturation 70% to 100%
:-'1] NOTE Saturation accuracy Adult/Pediatrics
T varies by sensor type.

No Motion

Finger Clip: £ 2 digits
Flex: £ 3 digits

Soft Sensor: + 2 digits
8000R: + 3 digits
8000 Q: + 4digits
Motion

Finger Clip: £+ 2 digits
Flex: £ 3 digits

Soft Sensor: + 3 digits
Low Perfusion

All Sensors: + 2 digits

70% to 100%
Neonates

No Motion

Finger Clip: £ 3 digits
Flex: £ 3 digits

Soft Sensor: N/A
8000R: N/A

8000 Q: N/A

Motion

Finger Clip: £ 3 digits
Flex: £ 4 digits

Soft Sensor: *+ 4 digits
Low Perfusion

All Sensors: + 3 digits
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Sp02 specifications (Masimo specifications! 23456

1

Sp02, accuracy was determined by testing on healthy adult volunteers in the range of 60-100% SpO2
against a laboratory pulse oximeter. SpO2 accuracy was determined on 16 neonatal NICU patients ranging
in age from 7-135 days old and weighing between 0.5-4.25 kg. Seventy-nine (79) data samples were
collected over a range of 70-100% SaO2 with a resultant accuracy of 2.9% SpO2.

The Masimo sensors have been validated for no motion accuracy in human blood studies on healthy adult
male and female volunteers with light to dark skin pigmentation in induced hypoxia studies in the range
of 70-100% SpO2 against a laboratory pulse oximeter and ECG monitor. This variation equals plus or minus
one standard deviation. Plus or minus one standard deviation encompasses 68% of the population.

The Masimo sensors have been validated for motion accuracy in human blood studies on healthy adult
male and female volunteers with light to dark skin pigmentation in induced hypoxia studies in the range
of 70-100% SpO2 against a laboratory CO-oximeter and ECG monitor. This variation equals plus or minus
one standard deviation which encompasses 68% of the population.

The Masimo SET Technology has been validated for low perfusion accuracy in bench top testing against

a BioTek Index 2 simulator and Masimo'’s simulator with signal strengths of greater than 0.02% and
transmission of greater than 5% for saturations ranging from 70-100%. This variation equals plus or minus
one standard deviation which encompasses 68% of the population.

The Masimo sensors have been validated for pulse rate accuracy for the range of 25-240 bpm in bench
top testing against a BioTek Index 2 simulator. This variation equals plus or minus one standard deviation
which encompasses 68% of the population.

The following substances may interfere with pulse oximetry measurements:

+ Elevated levels of Methemoglobin (MetHb) may lead to inaccurate SpO2 measurements

« Elevated levels of Carboxyhemoglobin (COHb) may lead to inaccurate SpO2 measurements

« Severe anemia may cause erroneous SpO2 readings

« Dyes, or any substance containing dyes, that change usual blood pigmentation may cause erroneous
readings

« Elevated levels of total bilirubin may lead to inaccurate SpO2 reading

Some models of commercially available bench-top functional testers and patient simulators can be used

to verify the proper functionality of Nellcor pulse oximeter sensors, cables and monitors. See the individual

testing device's operator's instructions for use for the procedures specific to the model of tester being

used.

Many functional testers and patient simulators have been designed to interface with the pulse oximeter's

expected calibration curves and may be suitable for use with Nellcor monitors and/or sensors. Not all

such devices, however, are adapted for use with the Nellcor OxiMax digital calibration system. While this

will not affect use of the simulator for verifying system functionality, displayed SpO2 measurement values

may differ from the setting of the test device. For a properly functioning monitor, this difference will be

reproducible over time and from monitor to monitor within the performance specifications of the test

device.

Environmental specifications

Operating temperature 50 °F to 104 °F (10 °C to 40 °C)

Storage temperature -4 °F to 122 °F (-20 °C to 50 °C)

Operating altitude/atmospheric pressure

-1250 to 10,000 ft. (-381 m to 3,048 m)/70 kPa to 106 kPa

Operating humidity 15% to 90% noncondensing

Storage humidity 15% to 95% noncondensing
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USB flash drive requirements

The multiple vendor technologies used in the manufacture of USB flash drives make some of them incompatible
with this monitor. Common issues that cause flash drives not to function are NTFS formatting, proprietary drive
security, and the need for Windows drivers to run or access them.

The requirements for a USB flash drive to work with this monitor are the following:
+ Linux compatibility
+ Upto32GBstorage

FAT 32 formatting
+ USB 2.0 compliant

Dimensions: Assuming the USB flash drive will be inserted in the, the length of the stick does not matter. The
size of the stick surrounding the USB metal head should be no larger than 9.5 mm x 18.5 mm to fit in the USB
port.

Monitor radio

The monitor's radio operates on 802.11 networks.

Wireless network IEEE 802.11 a/b/g/n
interface
Frequency 2.4 GHz frequency bands 5 GHz frequency bands
2.4 GHz to 2.483 GHz 5.15 GHz to 5.35 GHz, 5.725 GHz to
5.825Ghz
Channels 2.4 GHz channels 5 GHz
Up to 14 (3 non-overlapping); country- Up to 23 non overlapping; country-
dependent, dependent
Authentication/ Wireless Equivalent Privacy (WEP, RC4 Algorithm); Wi-Fi Protected Access (WPA);
Encryption IEEE 802.11i (WPA2); TKIP, RC4 Algorithm; AES, Rijndael Algorithm; Encryption Key

Provisioning; Static (40-bit and 128-bit lengths); PSK; Dynamic; EAP-FAST; EAP-TLS;
EAP-TTLS; PEAP-GTC ' PEAP-MSCHAPv2; PEAP-TLS;

Antenna Ethertronics WLAN_1000146

Wireless data rates 802.11a (OFDM): 6, 9, 12, 18, 24, 36, 48, 54 Mbps
802.11b (DSSS, CCK): 1, 2,5.5, 11 Mbps
802.11g (OFDM): 6, 9, 12, 18, 24, 36, 48, 54 Mbps

802.11n (OFDM,HT20,MCS 0-7): 6.5,13,19.5, 26, 39,52, 58.5, 72.2 Mbps

Agency approvals US: FCC Part 15.247 Subpart C, FCC Part 15.407 Subpart E

Europe: EN 300 328 (EDR) (v1.8.1), EN 300 328 (LE) (v1.8.1), EN 301 489-1 (v1.9.2), EN
301 489-17 (v2.2.1), EN 301 489-17 (v2.2.1), EN 62311:2008, EN 60950-1

Canada: (IC) RSS-210 standard. IC 3147A-WB45NBT based on FCC testing
Singapore: Complies with IDS standard

Protocols UDP, DHCP, TCP/IP

Data transfer protocols UDP/TCP/IP

Output power 39.81mW typical, country-dependent
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Wireless network IEEE 802.11 a/b/g/n

interface

Ancillary IEEE 802.11d, 802.11¢,802.11h, 802.11i, 802.1X
standards

1 One time passwords are not supported.

Channel restrictions in the 5-GHz band are determined by country.

To ensure compliance with local regulations, be sure the correct country in which the access point is installed is
selected. This product can be used with the following restriction(s):

Norway - Does not apply for the geographical area within a radius of 20 km from the center of Ny-Alesund.
France - Outdoor use is limited to 10 mW EIRP within the band 2454 to 2483.5 MHz.
m NOTE Effective Isotropic Radiated Power (EIRP).

::'1] NOTE Some countries restrict the use of 5-GHz bands. The 802.11a radio in the monitor uses only the
T channels indicated by the access point with which the radio associates. The hospital IT department must
configure access points to operate with approved domains.

Bluetooth module

Category Feature Implementation
Wireless specification  Bluetooth 2.1+EDR
Frequency 2.402-2.480 GHz

Maximum transmit power  Class 1

+8 dBm from antenna

Receive sensitivity -89 dBm

Range Circa 100 meters

Data rates Up to 3 Mbps (over the air)
Host interface USB Full speed USB 2.0

GPIO Four configurable lines

(1.8V/3.3V configurable by VDD_PADS

Operational modes HCI Host Controller Interface over USB
HID proxy mode Human Interface Device

EEPROM 2-wire 64K bits

Coexistence 802.11 (WiFi) Three wire CSR schemes supported

(Unity-3, Unity-3e, and Unity+)

Supply voltage Supply 5V+10%

Power consumption Current Idle mode ~5 mA

File transfer ~58 mA
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Category Feature Implementation
Antenna option Internal Multilayer ceramic antenna with up to 41% efficiency
Physical Dimensions 8.5%x 13 x 1.6 mm (BT800 module)
16 x 43 x 11 (BT820 USB dongle)

Environmental Operating -30°Cto 85°C

Storage -40°Cto 85°C
Miscellaneous Lead free Lead-free and RoHS compliant

Warranty 1 year
Approvals Bluetooth Controller subsystem approved

FCC/IC/CE Al BT800 series

Factory defaults

m NOTE Factory defaults are the settings in the device when it comes off the manufacturing floor.
T Customized configuration files modify these defaults based on preferences for specific sites. Restoring

default settings on a device returns it to its manufacturing floor defaults, not the custom configuration.

Device

Settings Default value
Active Config file name Factory
Device location displayed Yes
First-time startup screen displayed Yes
Touchscreen lockout interval 2 minutes
Auto sleep mode allowed Yes

Sleep mode duration 2 minutes
Auto shutdown allowed Yes

Auto shutdown timeout 15 minutes
Display brightness 5

Touchscreen calibration

55, 57,4003, 3993, 193, 3910, 200, 3900

(array of 8 integers)

Splash screen logo

Load new software on power cycle enabled No

Load new software to device Greyed out
Screen off allowed Yes

Screen off timeout 1 minute
Power line frequency 60!
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Settings

Default value

Navigate to the Progress Summary page.
Select Custom.

Click DONE at the bottom of the page.
Click SAVE AND CONTINUE.

ok wnN =

Scroll down to Section: Biomed (Required) at the bottom of the page and click General Device Settings.

Scroll down to Other on the General Device Settings page and select the desired Power Line Frequency.

1 Power line frequency can be modified in the Configuration Tool to support specific parameters like
Masimo SpO2. With both new and existing configurations, follow these steps:

Data management

Settings Default value
Date format MM/DD/YYYY
Prevent date and time changes No

Display date and time Yes

Daylight savings time (DST) enabled No

Device time zone offset (minutes) 0

Configured language English

Office profile option enabled Yes

Intervals profile option enabled Yes

Spot Check profile option enabled Yes

Profile Spot Check
Automatically send confirmed readings on Save No

Delete confirmed readings after successful send No
Automatically send unconfirmed interval readings No

General alarms

Settings

Default value

Alarm volume

Medium

Audio pause time

120 seconds

Minimum alarm volume Low
Alarm condition priority to activate Nurse call Medium
Allow global audio off (Note: Must be enabled in configuration file for No

option to be available))

Alarm audio on and Alarm audio off controls available

Yes (if "Allow global audio off" is
enabled in configuration)
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Settings Default value

Allow alarms to be disabled Yes

Patient and Clinician information

Settings Default value
Patient

Default patient type Adult
Name format Full name
Primary label Name
Secondary label Patient ID
Require patient ID to save readings No

Clear patient information on manual save Yes

Patient ID match required for save No
Search/Query by patient ID No
Clinician

Clinician ID display format Clinician ID
Require clinician ID to save readings No

Require clinician ID match to save readings No
Retrieve clinician information from clinician ID No

Require password to save readings No

Clear clinician information on manual save No

Require entry of "required modifiers" to save readings No

Require prescribed login No

NIBP

Settings Default value
Systolic upper limit enabled Yes
Systolic: Upper limit Adult: 220 mmHg (29.3 kPa)

Pediatric: 145 mmHg (19.3 kPa)
Neonate: 100 mmHg (13.3 kPa)

Systolic lower limit enabled Yes
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Settings

Default value

Systolic: Lower limit

Adult: 75 mmHg (10.0 kPa)
Pediatric: 75 mmHg (10.0 kPa)
Neonate: 50 mmHg (6.7 kPa)

Diastolic upper limit enabled

Yes

Diastolic: Upper limit

Adult: 110 mmHg (14.7 kPa)
Pediatric: 100 mmHg (13.3 kPa)
Neonate: 70 mmHg (9.3 kPa)

Diastolic lower limit enabled

Yes

Diastolic: Lower limit

Adult: 35 mmHg (4.7 kPa)
Pediatric: 35 mmHg (4.7 kPa)
Neonate: 30 mmHg (4.0 kPa)

MAP upper limit enabled

No

MAP: Upper limit

Adult: 120 mmHg (16 kPa)
Pediatric: 110 mmHg (14.7 kPa)
Neonate: 80 mmHg (10.7 kPa)

MAP lower limit enabled

No

MAP: Lower limit

Adult: 50 mmHg (6. 7 kPa)
Pediatric: 50 mmHg (6.7 kPa)
Neonate: 35 mmHg (4.7 kPa)

Advanced

Default view sys_dia_map
Tube type 2 tubes

Unit of measure mmHg
Algorithm default SureBP

Cuff inflation target (step algorithm)

Adult 160 mmHg (21.3 kPa)
Pediatric 140 mmHg (18.7 kPa)
Neonate 90 mmHg (12.0 kPa)

Maximum cycle pressure

Adult

Automatic

Pediatric

Automatic
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Settings

Default value

Time between each Automatic interval

15 minutes

Intervals profile default intervals mode

Automatic

Office profile intervals mode

Averaging (fixed)

Selected interval parameter

NIBP

Automatic mode time interval

15 minutes

Sp02

Settings

Default value

Sp0O2 upper limit enabled

Yes

Upper limit

Adult: 100%

Pediatric: 100%
Neonate: 100%

SpO2 lower limit enabled Yes

Lower limit Adult: 90%
Pediatric: 90%
Neonate: 90%

Default view % Sp02

Advanced

Sp02 alarm condition delay 10 seconds

SatSeconds (Nellcor only) 25 seconds

RR

RRp alarm condition delay - The quickest detection of a change in respiratory rate would take at least two
breaths. Depending on respiratory rate, anything less than 6 breaths per minute must be greater than 10

seconds.
Settings Default value
RR upper limit enabled Yes
Upper limit Adult: 30
Pediatric: 30
Neonate: 80
RR lower limit enabled Yes
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Settings Default value
Lower limit Adult: 6
Pediatric: 6
Neonate: 12

Default view BPM
Temperature

Settings Default value
Temperature upper limit enabled No

Upper limit 101 °F (38.3°C)
Temperature lower limit enabled No

Lower limit 94 °F (34.4 °C)
Advanced

Unit of measure °F (Fahrenheit)
Display temperature conversion Yes

Default SureTemp Plus site Oral

Braun antitheft time undocked before alarm 2 hours

Braun temperature conversion enabled Yes

Braun timer icon enabled Yes

Braun technique compensation algorithm enabled Yes

Braun °F or °C hardware switch enabled (in the battery compartment) Yes

Braun unadjusted mode enabled No

Manual parameters

Settings Default value
Custom Score feature active No

Display height Yes

Display weight Yes

Display pain Yes

Display respiration Yes

Display BMI No

Height units in

Weight units Ib
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Settings Default value
Enable manual override NIBP Yes
Enable manual override Pulse rate Yes
Enable manual override Respiration rate Yes
Enable manual override Temperature Yes
Enable manual override Sp0O2 Yes

Network
Settings Options Selections Default value
ESSID selection Alphanumeric com.welchallyn
entry (32)
Radio mode a/b/g/n, a/b/g, a/b/g/n
a/n,aonly
Radio enabled Yes/No Yes
Radio alarms Yes / No No
enabled
Ethernet MAC  MAC address 00:1A:FA:FF:FC:00
address
Wireless MAC  Alphanumeric
entry (18)
Authentication/ Open, WPA WPA2-Personal
Encryption Personal(TKIP),
type WPA
Enterprise(TKIP),
WPA2-
Personal(AES/
CCMP), WPA2-
Enterprise(AES/
CCMP), WEP
n(could be
64(40), 128(104)
specific)
Authentication/ Alphanumeric 1234567890ABCDEF1234567890ABCDEF1234567890ABCDEF1234567890A
Encryption entry (64)
method
Enhanced Auth TLS, TTLS, PEAP- PEAP-MSCHAPv2

Protocol (EAP)
type

MSCHAPv2,
PEAP-GTC,
PEAP-TLS, EAP-
FAST

Enhanced Auth
Protocol (EAP)
identity

Alphanumeric
entry (32)

vitalsigns
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Settings Options Selections Default value
Enhanced Auth Alphanumeric password
Protocol (EAP)  entry (32)
password
Dynamic Yes / No Yes
Frequency
Selection
Roaming type  PMK Caching, OKC
OKC, CCKM
Server Yes / No No
validation
enabled
Auth server Type 1, Type 2 Type 2
type
Inner EAP Auto, PAP Auto
setting type
PAC Auto, Manual Auto
provisioning
field
Network Host IP, NRS, DNS
Connectivity DNS, DHCP
Method
Host IP Host IP address  127.0.0.1
Port 281
NRS Network 0.0.0.0
rendezvous
service (NRS) IP
address
(H4HE S 4 )
Port (#4###) 7711
DNS Network WANRS
rendezvous
service DNS
name
Port (####) 7711
DHCP DHCP vendor welchallyn-nrs

class identifier

Port (####) 7711

NRS IP addresses Those network rendezvous service (NRS) IP addresses used by your organiz:
(multiple)

Data Encryption No
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Settings Options Selections Default value
Radio Static IP No
Enabled
Radio Static IP 0.0.0.0
Address
Radio Static IP 255.255.255.0
Mask
Radio Static IP 0.0.0.0
Gateway
Radio Static IP 0.0.0.0
DNS
Ethernet Static No
IP Enabled
Ethernet Static 0.0.0.0
IP Address
Ethernet Static 255.255.255.0
IP Mask
Ethernet Static 0.0.0.0
IP Gateway
Ethernet Static 0.0.0.0
IP DNS
Time Zone GMT
Display Time GMT
Zone
NTP Enable No
NTP DNS Name blank
Patient Query No
and Vitals Send
HL7 Enable
HL7 DNS Name 127.0.0.1
HL7 IP port 281
Server No
Authentication
Enable
FIPS Enable No
WiFi Power Save Max
Poll Mode
Bluetooth
MAC address 00:1A:FA:FF:FC:00

for Bluetooth
pairing
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Settings Options Selections Default value
Bluetooth Yes /No No
configuration

allowed

Pairing new Yes /No No

laptop allowed

Name of device ###i#t##i#t# is
asshownona unique based
paired laptop ~ on serial #

WACSM - ##HH##HHH

Enable BLE Yes / No
( Bluetooth
Low Energy)

No

Install the Nurse Call cable

Use this drawing and the following table as a reference for the Nurse Call cable and wiring a Nurse Call system.

No. Cable connector Wires (terminate according to manufacturer's specifications)
1 Tip (red wire) Normally open wire (red)

2 Barrel (black wire) Arm wire (black)

3 Center (white wire) Normally closed wire (white)

Configure a remote VNC connection

To allow a view-only remote session to the device from a device on the same network, complete the following

steps:

Load the configuration file on to the device.
Connect the device to the network.

No v hscwbn =

Remote Screen Sharing box.

Create a configuration file with VNC enabled on the Config Tool.

On the device, navigate to Setting > Device, and click Authorize under Remote Screen Sharing.

Note the password in the Remote Screen Sharing box.

Navigate to Settings > Advanced. Locate the device's IP address under Ethernet IP or Radio IP.

Using VNC Remote Viewer app on the network, connect to the IP address. Enter the password noted from the

8. To end the remote session, navigate to Setting > Device, and click Stop Sharing.
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Troubleshooting

This section provides the following tables to help troubleshoot the device.

« Interpreting log file output: The tables and sample calculations in this topic show you how to parse and
interpret error log messages.

«  Symptoms and solutions: This simple table lists symptoms you might observe, possible causes, and suggested
actions that might eliminate the problem.

« Technical alarm messages: These tables list messages generated by the device software when a problem is
detected. The tables explain possible causes and suggest actions that can resolve the problem. Compared to
the Symptoms and solutions table, these tables are much more exhaustive.

These tables can help you diagnose and fix a problem. They do not replace basic troubleshooting skills. You must
still trace the source of the problem to the board or module level to decide the best course of action. Baxter

does not support component-level repair to the board or module. For available replacement parts, see “Field
Replaceable Units.”

C WARNING Do not perform troubleshooting on a device that is emitting smoke or exhibits other
signs of excessive overheating. Disconnect the device from AC power and call Baxter Technical Support
immediately.

& CAUTION Replace parts, components, or accessories only with parts supplied or approved by Baxter.
The use of any other parts can lead to inferior device performance and will void the product warranty.

Interpreting log file output

The device supports saving log files to a USB flash drive. You can then read saved log files on a PC to assist in
analysis. This method allows access to the log files without having to connect the device to a PC.

Save log files

Complete the following steps to save a log file to a USB flash drive:

1. Insert a compatible USB flash drive into the USB port of the monitor or the APM work surface if one is
configured for your device.

2. Access Advanced settings.
3. Navigate to Service > Log file.
4. Touch Save to USB.

A "Save successful" message appears after a successful save.
5. Remove the USB flash drive from the USB port.

Access log files

Complete the following steps to access and start working with log files saved to a USB flash drive:

1. Insert the USB flash drive into a USB port on your PC.
2. Open the USB flash drive and identify the saved log files.

Look for .zip files that resemble this example, with the first set of numbers being a datestamp in the
YYYYMMDD format:

| ogfiles 20150108 193903 179.zip
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3. Open the .zip file, and then open the desired messages .zip file.

Multiple messages files might be saved on the USB drive, so check the datestamp in the filename to select
the desired .zip file. For example,

nmessages_2015 01 08. zip

The available log files appear onscreen. The largest file is the latest file of the day. The filenames resemble this
example:

messages_2015_01_08_0000000008

4. Right-click on the desired log file, select Open, and then select WordPad as the program to open the file.

The log file opens and is ready for analysis.

Log message format

Knowing how to interpret log file output can help you to troubleshoot issues on the device. All log messages
follow this format:

<PRI >| SODATE( sp) MSGHDR: ( sp) M5 new- | i ne)

The following table defines each element of the log message.
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<PRI> The facility number and the severity number concatenated into an 8-bit value.

{l NOTE The PRI values and calculations performed with them are useful primarily to

T Welch Allyn engineers. Most biomeds and service personnel can focus on the other
details of log messages to complete their analysis.

ISODATE The date and time at which the message was generated in the ISO 8601 compatible standard

timestamp format (yyyy-mm-ddThh:mm:ss.mmm-+-ZONE). This is picked up from the CSM
device system time.

MSGHDR Message header: The name and the PID of the program or process that sent the log message
in PROGRAMIPID]: format. It includes a trailing whitespace.

MSG The text of the log message from the sending program or process. This is a free-format text
string, terminating with a new-line character.

(sp) A single-space character.

(new-line) A new-line character.

As noted above, the calculations performed using PRI values have little significance for most users but are

valuable for Welch Allyn engineers. Therefore, the following instructions for calculating facilty and severity
numbers target Welch Allyn engineers.

To obtain the facility number, divide the PRI value by 8 (dropping the fraction from the result). The facility
number is one of the following:

Facility Description
Number
0 Kernel messages

1 User-level messages
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Facility Description

Number

2 Mail system

3 System daemons

4 Security/authorization messages (auth)
5 Messages generated interally by syslogd
6 Line printer subsystem

7 Network news subsystem

8 UUCP subsystem

9 Clock daemon

10 Security/authorization messages (authpriv)
11 FTP daemon

12 NTP subsystem

13 Log audit

14 Log alert

15 Clock daemon (cron)

16 BioMed messages (aka local-0)

17 Manufacturing messages (aka local-1)
18 Service messages (aka local-2)

19 Engineering messages (aka local-3)

20 Not Used (aka local-4)

21 Not Used (aka local-5)

22 Not Used (aka local-6)

23 Not Used (aka local-7)

To obtain the severity number, subtract the (facility times 8) value from the PRI value. The severity number is one
of the following:

Severity Severity Name Description

Number

0 EMERG A panic condition

1 ALERT A condition that should be corrected immediately

2 CRITICAL Critical conditions, such as hard device errors

3 ERROR Error messages

4 WARNING Warning messages

5 NOTICE Conditions that are not errors but may require attention
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Severity Severity Name Description

Number

6 INFO Information messages
7 DEBUG Debug messages

Sample calculation/interpretation

For each of the sample error logs presented, we can determine the following:

<13>2014- 09- 26T12: 18: 45. 000+00: 00 wa_ni bpd[ 1326]: Ni bpManual BpCancel St at e-
>Ent er

<PRI>=13

ISODATE = 2014-09-26T12:18:45.000+00:00

MSGHDR = wa_nibpd[1326]:

MSG = NibpManualBpCancelState

Facility = <PRI> + 8 =13 + 8 = 1.625 = 1 when rounded down = User-level messages

Severity = <PRI> — (Facility x 8) =13 - (1 x8) =13 -8 =5 = NOTICE

<150>2014- 09- 08T05: 55: 00. 000+00: 00 wa_spo2noni nd[ 1521]: Code 1, SPQ2 sensor
not connect ed

<PRI>=150

ISODATE = 2014-09-08T05:55:00.000+00:00

MSGHDR = wa_spo2nonind[1521]:

MSG = Code 1, SPO2 sensor not connected

Facility = <PRI> + 8 = 150 + 8 = 18.75 = 18 when rounded down = Service messages (aka local-2)

Severity = <PRI> - (Facility x 8) = 150 - (18 x 8) = 150 - 144 =6 = INFO

General

Condition Cause Remedy

All tests for the device The device is not connected to a Plug the device into the electrical outlet
were not run with the power supply. and then connect the power supply to the
Welch Allyn Service Tool. device.

Initialization of the device and the Re-boot the device and the PC. Relaunch
Welch Allyn Service Tool is required.  the Welch Allyn Service Tool and retest the
device.
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Condition

Cause

Remedy

The device does not
power up.

A new battery was installed.

Connect AC power to wake up the battery.

The battery is discharged.

Connect AC power to charge the battery.

The power switch is defective.

Replace the power switch.

The power supply is defective.

Check the output voltage on the power
supply. The voltage should be 15V + 0.45V
DC. Ifitis not, replace the power supply.

The battery is dead or defective.

Charge the battery for 5 hours. If the
battery icon on the display still shows an
empty battery symbol, replace the battery.

The main board is defective.

Replace the main board.

The touchscreen is
unresponsive.

Touchscreen needs calibration.

Calibrate the touchscreen.

Run the Host Calibration Sequence from
the Service Tool.

Replace the LCD / touchscreen.

Replace the main board.

The device does not signal
alarm conditions for the
Nurse Call option.

Alarm limit settings are set too high
or too low.

Adjust the alarm limit settings.

Audio alarms have been silenced.

Turn on audio alarms.

A hardware component has failed.

Run the Host Calibration Sequence from
the Service Tool.

Replace the main board.

The device is powered on
but the display is blank.

The device is in Sleep mode.

Touch the screen.

A hardware component has failed.

Run the Host Calibration Sequence from
the Service Tool.

Replace the LCD / touchscreen.

Replace the main board.

Bluetooth
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Condition Cause Remedy
The monitor cannot A pairing issue occurred. Pair the monitor to the device.
;ZC:leeCt with a Bluetooth Ensure that the monitor and the device are

within range.

The Bluetooth device driver has not been
installed properly.

PC Service for the device has not started.
Perform a Bluetooth radio functional check.
Update the device software.

Replace the Bluetooth radio.

Replace the main board.

A connectivity issue occurred.

Configure monitor to network settings.
Verify local network settings.

Ensure that the monitor and the device are
within range.

Perform a Bluetooth radio functional check.
Update the device software.
Replace the Bluetooth radio.

Replace the main board.

A hardware component has failed.

Perform a Bluetooth radio functional check.
Replace the Bluetooth radio.

Replace the main board.

The software has failed.

Update the software.
Replace the Bluetooth radio.

Replace the main board.

Wireless radio

The monitor cannot A connectivity issue occurred. Configure monitor to network settings.
connect with a Wireless Verify local network settings.

network.

Ensure that the monitor and the device are
within range.

Perform a Newmar radio functional check.
Update the device software.
Replace the Newmar radio.

Replace the main board.
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Condition Cause Remedy

A hardware component has failed. Perform a Newmar radio functional check.
Replace the Newmar radio.

Replace the main board.

The software has failed. Update the software.
Replace the Newmar radio.

Replace the main board.

Attempt to upgrade the  The hardware or software between Retry software update.

software failed. the Host and the Newmar radio is .
) . Replace Newmar radio.
incompatible.
Replace main board.
The monitor lost communication Retry software update.

with the network or a timing issue

occurred during the upgrade. Replace Newmar radio.

Replace the main board.

The Newmar radio malfunctioned. Update the software.
Replace Newmar radio.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

Ethernet

The monitor cannot A connectivity issue occurred. Verify local network settings.
connect to the network.

Verify that the port on the network is
configured and functional.

Perform an Ethernet functional check.
Update the software.

Replace the main board.

A hardware failure occurred. Perform an Ethernet functional check.

Replace the main board.

A software failure occurred. Update the software.

Replace the main board.

Attempt to upgrade the ~ The hardware or software between Retry software update.
software failed. the Host and the Ethernet module is

incompatible. Replace the main board.
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Condition Cause Remedy
The monitor lost communication Retry software update.
with the netvyork or a timing issue Replace the main board.
occurred during the upgrade.
The Ethernet module malfunctioned. Update the software.
Replace the main board.
The main board malfunctioned. Update the software.
Replace the main board.
NIBP

Blood pressure readings
are inaccurate.

Incorrect cuff size, improperly placed
cuff, or incompatible cuff.

Determine correct cuff size by measuring
patient's arm circumference midway
between the elbow and the shoulder. Then
use a properly sized cuff.

Use reference markings on the cuff to place
it properly.

Use only Welch Allyn cuffs.

Patient's arm is not positioned
properly or moves during blood
pressure cycle.

Ensure patient's arm is resting on a surface
at heart level.

Keep arm still to reduce artifact.

Blood pressure cuff is placed over
clothing.

Take blood pressure on a bare arm.

The patient is experiencing
arrhythmia.

Check for regularity of heart rate (palpate
pulse or check device).

There is a leak in the pneumatic
system.

Ensure all cuff attachments are tight.
Carefully check for leaks in blood pressure
cuff and tubing attached to the device.

Replace the cuff.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.
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The NIBP module needs calibration.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.

The NIBP module malfunctioned.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.

The single or dual lumen switch

Ensure that the cuff is the properly sized.

failed. Clean the cuff connections.
Replace the cuff and tubing.
Replace the main board.
The NIBP cuff does There is a leak in the pneumatic Ensure all cuff attachments are tight.
not inflate. NIBP is not system. Carefully check for leaks in blood pressure

functioning.

cuff and tubing attached to the device.
Replace the cuff.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.

The NIBP module malfunctioned.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.

The main board malfunctioned.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.
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Condition

Cause

Remedy

The single or dual lumen switch
failed.

Ensure that the cuff is the properly sized.
Clean the cuff connections.
Replace the cuff and tubing.

Replace the main board.

The NIBP module needs calibration.

Update the software.

Perform NIBP functional checks.
Perform NIBP calibration checks.
Replace the pump assembly.

Replace the main board.

Attempt to upgrade the
software failed.

The hardware or software between
the Host and the Ethernet module is
incompatible.

Retry software update.

Replace the main board.

The monitor lost communication
with the network or a timing issue
occurred during the upgrade.

Retry software update.

Replace the main board.

Temperature

Temperature Probe is placed improperly. Ensure that the probe is properly placed in
measurements are the measurement site. For oral temps, place
inaccurate. the probe in the most posterior sublingual

pocket.

The probe malfunctioned.

Replace the probe.

Perform temperature functional checks.

The probe cover is faulty or
incorrectly attached.

Verify the condition of the probe cover and
that it covers the probe completely.

Replace the probe cover.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Replace the probe.

The temperature module
malfunctioned.

Update the software.
Replace the temperature module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.
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Condition Cause Remedy

Temperature The probe is disconnected from the  Ensure that the temperature probe is
measurements are not monitor. connected and seated in the probe well
displayed. before taking a measurement.

Probe is placed improperly. Ensure that the probe is properly placed in
the measurement site. For oral temps, place

the probe in the most posterior sublingual

pocket.

The probe malfunctioned.

Replace the probe.

Perform temperature functional checks.

The temperature module
malfunctioned.

Update the software.
Replace the temperature module.

Replace the main board.

A software issue occurred.

Update the software.
Replace the temperature module.

Replace the main board.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Replace the probe.

The main board malfunctioned.

Update the software.

Replace the main board.

Attempt to upgrade the
software failed.

The hardware or software between
the Host and the Ethernet module is
incompatible.

Retry software update.
Replace the temperature module.

Replace the main board.

The monitor lost communication
with the network or a timing issue
occurred during the upgrade.

Retry software update.
Replace the temperature module.

Replace the main board.

The temperature module
malfunctioned.

Update the software.
Replace the temperature module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

The thermometer is not in the cradle.

Placed the thermometer in the cradle.
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Cause

Remedy

The thermometer contacts are dirty.

Clean the thermometer contacts.
Replace the thermometer.

Replace the thermometer module.

The thermometer batteries are dead.

Place the thermometer in the cradle to
charge.

Clean the thermometer contacts.
Replace the thermometer batteries.
Replace the thermometer.

Replace the thermometer module.

The thermometer malfunctioned.

Place the thermometer in the cradle to
charge.

Clean the thermometer and module
contacts.

Clean the probe or window.

Replace the probe cover.

Perform temperature functional checks.

Update the software.

Replace the thermometer batteries.
Replace the thermometer.

Replace the thermometer module.

Replace the main board.

The temperature module
malfunctioned.

Perform temperature functional checks.

Update the software.
Replace the temperature module.

Replace the main board.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Perform temperature functional checks.

Replace the probe.

The main board malfunctioned.

Update the software.

Replace the main board.

Sp0O2
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Sp0O2 measurements are
not displayed.

The sensor is faulty or incorrectly
attached.

Connect the sensor to the patient and the
device.

Replace the sensor.

Perform SpO2 functional checks.

The sensor is contaminated or dirty.

Clean the optical area of the sensor.
Replace the sensor.

Perform SpO2 functional checks.

The SpO2 module malfunctioned.

Perform SpO2 functional checks.
Update the software.
Replace the SpO2 module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

SpO2 measurements are
inaccurate.

The sensor is faulty or incorrectly
attached.

Connect the sensor to the patient and the
device.

Replace the sensor.

Perform SpO2 functional checks.

The sensor is contaminated or dirty.

Clean the optical area of the sensor.
Replace the sensor.

Perform SpO2 functional checks.

The Sp0O2 module malfunctioned.

Perform SpO2 functional checks.
Update the software.
Replace the SpO2 module.

Replace the main board.

The main board malfunctioned.

Update the software.

Replace the main board.

Attempt to upgrade the
software failed.

The hardware or software between
the Host and the SpO2 module is
incompatible.

Retry software update.
Replace the SpO2 module.

Replace the main board.

The monitor lost communication
with the network or a timing issue
occurred during the upgrade.

Retry software update.
Replace the SpO2 module.

Replace the main board.
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The temperature module Update the software.

malfunctioned. Replace the SpO2 module.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

Technical alarm and information messages

This section presents tables of technical alarm and information messages to help you troubleshoot issues on the
monitor.

When the monitor detects certain events, a message appears in the Device Status area at the top of the screen.
Message types include the following:

« Information messages, which appear on a blue background.

+ Very low-priority alarms, which appear on a cyan background.

+ Low- and medium-priority alarms, which appear on an amber background.
 High-priority alarms, which appear on a red background.

Technical alarm messages are low or very low priority unless noted in the Message column.

Alarm logs are not viewable by clinicians. However, all logs are transferred to Welch Allyn on a regularly
scheduled basis. In the event of an unplanned power failure, all information, including device logs and patient
data, are retained on the system.

You can dismiss a message by touching the message on the screen, or, for some messages, you can wait for the
message to time out.

To use these tables, locate the message that displays on the monitor in the left column of the table. The
remainder of the row explains possible causes and suggests actions that can resolve the issue.

If you cannot resolve the issue, use the service tool to read the error log files or to perform a functional test on
the module reporting the message.

::'1] NOTE Performing functional tests on modules requires the service tool, Gold edition.

NIBP messages

Condition Cause Remedy Priority
User canceled NIBP The NIBP measurement  Clear the alarm and retry NIBP. Information
reading. was canceled by user

NIBP not functional. The NIBP measurement is Internal malfunction. If the problem Medium

050002 not available persists, replace the module.
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Unable to determine The NIBP measurement ~ Make sure the NIBP settings/patient Medium
NIBP; check connections; may be inaccurate, mode is appropriate. If the problem
limit patient movement. patient motion occurred, persists, replace the module.
050003 or the settings for patient
readings obtained might
not be accurate
Unable to determine Excessive artifact, Unable to determine blood pressure. Low
NIBP; check connections; no blood pressure Check connections; restrict patient
limit patient movement. parameters could be movement. If problem persists,
050004 calculated replace module.
Unable to determine Low inflation on blood Make sure the NIBP settings/patient Low
NIBP; check inflation pressure measurement  mode is appropriate. If the problem
settings. 050005 attempt persists, replace the module.
Unable to determine The NIBP tubing has a Internal malfunction. If the problem Medium
NIBP; check connections kink, or there is a NIBP persists, replace the module.
and tubing for kinks. transducer calibration
050006 failure
Unable to determine The blood pressure Make sure the NIBP settings/patient Low
NIBP; check connections; measurementdumped  mode is appropriate. If the problem
limit patient movement. too soon persists, replace the module.
050007
Unable to determine There were not Unable to determine blood pressure. Low
NIBP; check connections; enough steps on the Check connections; restrict patient
limit patient movement. measurement attempt movement.
050008
Unable to determine There is invalid patient Make sure the NIBP settings/patient Medium
NIBP; check inflation information for the mode is appropriate. If the problem
settings. 050009 selected mode persists, replace the module.
Unable to determine The re-inflation was too  Unable to determine blood pressure. Low
NIBP; check connections; late on the measurement Check connections; restrict patient
limit patient movement. attempt movement.
05000A
Unable to determine There were many re- Unable to determine blood pressure. Low
NIBP; check inflation inflate attempts onthe  Check connections; restrict patient
settings. 05000B measurement attempt movement.
Unable to determine Couldn't bleed pressure  Unable to release cuff pressure. Medium

NIBP; check connections
and tubing for kinks.
05000C

below safe venous return
pressure

Check tubing for kinks and
connection integrity.
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Condition Cause Remedy Priority
NIBP air leak; check cuff ~ Leak was detected in BP  Check the tubing and connections.  Low
and tubing connections. cycle.
05000D
No display The safety check failed Internal malfunction. If the problem

on the measurement persists, replace the module.

attempt
Unable to determine Auto Zero check failure.  The NIBP pressure is not stableand ~ Medium
NIBP; check connections; The NIBP pressureisnot the transducer zero value cannot
limit patient movement.  stable and the transducer be set. If problem persists, replace
05000F zero value cannot be set  module.
NIBP not functional. WACP message CRC Internal malfunction. If the problem Very low
050105 mismatch on NIBP persists, replace the module.

module
NIBP not functional. This message is not Internal malfunction. If the problem  Very low
050201 implemented by the persists, replace the module.

NIBP module
NIBP not functional. This message is not Internal malfunction. If the problem  Very low
050202 supported by the NIBP persists, replace the module.

module
NIBP not functional. The NIBP module has run Internal malfunction. If the problem Very low
050203 out of memory persists, replace the module.
NIBP not functional. The NIBP module has Internal malfunction. If the problem  Very low
050205 received a invalid persists, replace the module.

parameter
NIBP not functional. The parameter provided Internal malfunction. If the problem Very low
050206 by the NIBP module is persists, replace the module.

outside of the allowable

range for the specified

message
NIBP not functional. The NIBP module Internal malfunction. If the problem Very low
050207 message requires an persists, replace the module.

object, but did not

contain one
NIBP not functional. The NIBP module object  Internal malfunction. If the problem  Very low
050208 provided with the persists, replace the module.

message could not be

deserialized
NIBP not functional. The NIBP module object  Internal malfunction. If the problem Very low

050209

could not be serialized

persists, replace the module.
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Condition Cause Remedy Priority
NIBP not functional. The NIBP module Internal malfunction. If the problem  Very low
05020A message is performing persists, replace the module.

arequest or action

when the module state

prohibits the request or

action.
NIBP not calibrated. Factory EEPROM Internal malfunction. If the problem Very low
050503 checksum error on persists, replace the module.

NIBP. Units internal

configuration was

corrupted
NIBP not functional. User EEPROM checksum  Calibrate the NIBP Module. If Very low
050504 error. Configuration data  problem persists, replace module.

which can be setin

the user's configuration

menu was damaged or

lost on NIBP
NIBP not functional. Post failure of A/D Internal malfunction. If the problem Very low
050505 convertor persists, replace the module.
NIBP not calibrated. NIBP module calibration  Calibrate the NIBP module. Very low
Calibrate the module. failure, the calibration
050509 signature is zero
Invalid algorithm. Select  Invalid NIBP Algorithm.  Verify the correct algorithm. If Very low
correct algorithm and NIBP component the problem persists, replace the
retry. 05050A software tried to modaule.

configure the sensor in

anillegal manner
NIBP not functional. Invalid NIBP initiation Internal malfunction. If the problem  Very low
050513 code persists, replace the module.
Invalid patient mode. Invalid patient mode Verify correct patient mode. If Very low
Select correct patient on NIBP. The NIBP the problem persists, replace the
mode and retry. 050514  component software modaule.

tried to configure the

sensor in an illegal

manner
NIBP not functional. Invalid module Internal malfunction. If the problem  Very low
050515 configuration for NIBP persists, replace the module.
NIBP not functional. NIBP module Internal malfunction. If the problem Very low
050516 malfunction persists, replace the module.
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Condition Cause Remedy Priority
Ambient temperature Ambient temp out of Restore device to normal Very low
out of range. Clear error  range on NIBP temperature ranges and try again.
and retry. 050517
Low battery. Plug into The NIBP module power Plug device into an AC outlet to Very low
outlet. 050518 rail is too low charge the battery.
Battery overcharged. The NIBP module power Battery is overcharged. Remove Very low
Disconnect from outlet.  rail is too high. from charging source.
050519
NIBP not calibrated. NIBP failed to load safety Calibrate the NIBP module. If Very low
Calibrate the module. processors calibration the problem persists, replace the
050601 record from EEPROM module.
NIBP not functional. NIBP safety processor Internal malfunction. If the problem  Very low
050602 failed ROM checksum persists, replace the module.
NIBP not calibrated. NIBP safety processor Calibrate the NIBP module. If Very low
Calibrate the module. not calibrated, missing the problem persists, replace the
050603 calibration signature module.
Cuff pressure limits NIBP system failure. Restrict patient movement. Medium
exceeded. 050604 Overpressure
Premature auto cycle NIBP auto cycle skipped, Cuff pressure is not below safety Very low
skipped. 050605 SVRP requirement not return pressure long enough to

satisfied allow a cycle to occur.
Cuff pressure too high. NIBP cuff pressure above Verify cuff connections. If the Medium
Clear error to retry. SVRP for too long problem persists, replace the
050606 modaule.
NIBP not functional. NIBP cannot clear the Internal malfunction. If the problem Very low
050607 failsafe alerts persists, replace the module.
NIBP not functional. NIBP safety processor has Internal malfunction. If the problem Very low
050608 stopped responding persists, replace the module.
Stat mode requested NIBP excessive stat Internal malfunction. If the problem Very low

too soon. Clear to retry.
050609

mode time. The time
between readings is less
than one minute and
the readings plus time
between readings result
in the device taking over
15 minutes to complete
the averaging cycle.

persists, replace the module.
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Condition Cause Remedy Priority
Unable to determine NIBP transducers are not  The transducers are above 5 mmHg  Medium
NIBP; check connections matched and the difference in pressure is
and tubing for kinks. greater than 40 mmHg. Check cuff
05060A for pinched or obstructed tubing.
If the problem persists, replace the
module.

NIBP not calibrated. Factory EEPROM Calibrate the NIBP module. If Very low
Calibrate the module. checksum error on the problem persists, replace the
050608 NIBP. Units internal module.

configuration was

corrupted
NIBP not functional. NIBP command not Internal malfunction. If the problem Very low
05060C implemented persists, replace the module.
NIBP not functional. NIBP wrong data count  Internal malfunction. If the problem Very low
05060D persists, replace the module.
NIBP not functional. NIBP data range error Internal malfunction. If the problem  Very low
05060E persists, replace the module.
NIBP not functional. NIBP no POST error to Internal malfunction. If the problem  Very low
05060F clear persists, replace the module.
NIBP not functional. NIBP cannot clear this Internal malfunction. If the problem  Very low
050610 POST error persists, replace the module.
NIBP not functional. NIBP command not Internal malfunction. If the problem  Very low
050611 command type persists, replace the module.
NIBP not functional. NIBP communication Internal malfunction. If the problem  Very low
050612 timeout persists, replace the module.
NIBP not functional. NIBP response header Internal malfunction. If the problem Very low
050613 wrong persists, replace the module.
NIBP not functional. NIBP response checksum Internal malfunction. If the problem Very low
050614 wrong persists, replace the module.
NIBP not functional. Too much NIBP data was Internal malfunction. If the problem Very low
050615 received persists, replace the module.
NIBP not functional. NIBP FPROM erase error  Internal malfunction. If the problem Very low
050616 persists, replace the module.
NIBP not functional. NIBP FPROM Internal malfunction. If the problem  Very low
050617 programming error persists, replace the module.
NIBP not functional. Invalid NIBP target Internal malfunction. If the problem  Very low

050618

pressure

persists, replace the module.
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Check cuff inflation Cuff inflation target was ~ Change cuff inflation target or Information
settings. overridden due to max  maximum pressure so that the cuff

pressure being too low inflation target is at least 20 mmHg

lower than maximum pressure.

Tube type does Tube type settings and Change tube type setting to match  Information
not match device actual type do not match actual tube type
configuration.
NIBP not functional. Unrecognized WACP Internal malfunction. If the problem Very low
05FFO01 parameter received from persists, replace the module.

sensor
NIBP not functional. Timeout waiting for Internal malfunction. If the problem Very low
05FF02 sensor response persists, replace the module.
NIBP not functional. Error deserializing the Internal malfunction. If the problem  Very low
05FF03 WACP message received  persists, replace the module.

from the sensor
NIBP not functional. WACP stack send Internal malfunction. If the problem  Very low
05FF04 message failure persists, replace the module.
NIBP not functional. Timeout waiting for Internal malfunction. If the problem  Very low
05FF05 asynchronous sensor persists, replace the module.

message
NIBP not functional. One or more Check connections. Restrict patient ~ Very low
05FF06 undetermined numerics movement.

when reading status

indicates OK
NIBP not functional. Unrecognized sensor Internal malfunction. If the problem Very low
05FF07 reading status code persists, replace the module.
NIBP not functional. Sensor power up failure  Internal malfunction. If the problem  Very low
05FF08 persists, replace the module.
NIBP not functional. WACP rendezvous failure Internal malfunction. If the problem Very low
05FF09 persists, replace the module.
NIBP not functional. Application firmware Internal malfunction. If the problem Very low
05FFOA retrieval error during persists, replace the module.

POST
NIBP not functional. Upgrade .pimfileis Internal malfunction. If the problem Very low
05FFOB corrupt persists, replace the module.
NIBP not functional. Configured upgrade Internal malfunction. If the problem  Very low

05FFOC

firmware directory
cannot be accessed

persists, replace the module.
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Condition Cause Remedy Priority
Device configuration Configured parameter Use configured parameters for Very low
issue. 05FFOD (NIBP or Sp02) used in Intervals

Intervals is missing
NIBP not functional. The NIBP sensor Clear the error and try again Very low
05FFOE unexpectedly reset
NIBP not functional. The NIBP sensor firmware Internal malfunction. If the problem Very low
O5FFOF failed to upgrade persists, replace the module.
Tube type does The tube type settings Change the tube type setting to Information

not match device
configuration.

and the actual tube type
do not match

match the actual tube type.

SpO2 messages

General SpO2 messages

Condition

Cause

Remedy

Sp02 not functional.
044900

Alarm priority : Very low

SpO2 module is not responding

Internal Hardware malfunction in SpO2

module. Replace module.

SpO2 rebooting. 044a00

Alarm priority : Very low

SpO2 module is not responding

Informational error. Indicates that host

software is attempting to clear an error
by rebooting the SpO2 module. No action

required.

SpO2 rebooting. 044b00

Alarm priority : Very low

The SpO2 module stopped sending

data

attempting to clear an

Informational error. The host software is

error by rebooting

the SpO2 module. No action required.

SpO2 rebooting. 044c00

Alarm priority : Very low

Sp02 received a packet with bad CRC

from module

Informational error. The host has received

a packet with bad CRC from the Sp0O2
module. The packet in question is ignored.

No action required.

SpO2 rebooting. 044d00

Alarm priority : Very low

The SpO2 power on self test failed

Internal hardware malfunction in SpO2

module. Replace the module.

SpO2 rebooting. 044e00

Alarm priority : Very low

The SpO2 power on self test timed

out

Internal hardware malfunction in SpO2

module. Replace the module.
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Condition Cause

Remedy

Sensor not connected. The SpO2 cable is not connected
Clear to retry. 040600

Alarm priority : Very low

Connect Sp02 cable. If the problem is still
present, replace the SpO2 sensor. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Replace the SpO2 cable.  The Sp0O2 cable life has expired
040700

Alarm priority : Very low

Replace the Sp0O2 cable. If the problem

is still present, verify module functionality
by replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Replace the SpO2 cable.  The SpO2 cable is incompatible with
040800 the monitor

Alarm priority : Very low

Replace the Sp0O2 cable. If the problem

is still present, verify module functionality
by replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Replace the SpO2 cable.  The SpO2 cable is not recognized by
040900 the monitor

Alarm priority : Very low

Replace the SpO2 cable. If the problem

is still present, verify module functionality
by replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Replace the SpO2 cable.  The SpO2 cable is defective
040a00

Alarm priority : Very low

Replace the SpO2 cable. If the problem

is still present, verify module functionality
by replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Sensor not connected. The SpO2 sensor is not connected to
Clear to retry. 040b00 the monitor

Alarm priority : Very low

Connect SpO2 sensor. If the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

The sensor has expired. The SpO2 sensor has expired
Replace the SpO2 sensor.
040c00

Alarm priority : Very low

Replace SpO2 sensor. If the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.
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Condition Cause Remedy

Incompatible sensor. The SpO2 sensor is not recognized by Replace SpO2 sensor. If the problem is
Replace the SpO2 sensor.  the monitor still present, replace the SpO2 cable. If the
040d00 problem is still present, verify the module

functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Alarm priority : Very low

Incompatible sensor. The SpO2 sensor is not recognized Replace SpO2 sensor. If the problem is
Replace the SpO2 sensor. still present, replace the SpO2 cable. If the
040e00 problem is still present, verify the module

functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Alarm priority : Very low

Replace the SpO2 sensor.  The SpO2 sensor is defective Replace SpO2 sensor. If the problem is
040f00 still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Alarm priority : Very low

Replace the SpO2 sensor.  There was a fault with the SpO2 Check the sensor and cable connection.
Replace the SpO2 cable.  sensor and cable. If the problem is still present, replace the
041000 Sp02 sensor. If the problem is still present,

replace the cable. If the problem is still
present, verify the module functionality by
replacing the sensor with an applicable
SpO02 tester. If the message persists replace

Alarm priority : Very low

the module.
Sensor not connected. An adhesive SpO2 sensor is not Connect SpO2 sensor. If the problem is
Clear to retry. 041100 connected still present, replace the SpO2 cable. If the

problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Alarm priority : Very low

The sensor has expired. The adhesive SpO2 sensor is expired  Replace SpO2 sensor. If the problem is
Replace the SpO2 sensor. still present, replace the SpO2 cable. If the
041200 problem is still present, verify the module

functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Alarm priority : Very low

Incompatible sensor. The adhesive SpO2 sensor is Replace SpO2 sensor. If the problem is
Replace the SpO2 sensor.  incompatible still present, replace the SpO2 cable. If the
041300 problem is still present, verify the module

functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Alarm priority : Very low
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Condition

Cause

Remedy

Incompatible sensor.
Replace the SpO2 sensor.
041400

Alarm priority : Very low

The adhesive SpO2 sensor is not
recognized

Replace SpO2 sensor. If the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Replace the SpO2 sensor.
041500

Alarm priority : Very low

The adhesive SpO2 sensor is defective

Replace SpO2 sensor. If the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Searching for pulse signal.
041800

Alarm priority : High

Sp02 pulse search

Pulse search is part of normal operation,
and does not have an associated corrective
action.

Sp02 interference
detected. Clear to retry.
041900

Alarm priority : Very low

Sp02 module interference detected.

No action required.

Low perfusion index. Clear
to retry. 041a00

Alarm priority : Very low

There is marginal SpO2 pulse quality
or artifact.

Reapply the sensor to a better perfused
monitoring site. Assess the patient and,

if indicated, verify oxygenation status
through other means. If the problem is still
present, replace the SpO2 sensor. If the
problem is still present, replace the cable.
If the problem is still present, verify module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists replace the module.

Demo mode active.
041b00

Alarm priority : Very low

The SpO2 parameter is in demo mode

None.3

3 Demo mode is reported when you plug a Masimo demo tool into the patient cable connector. This tools
simulates a patient being connected, and is only used in a development environment. Because this tool
simulates a patient without a patient actually being connected, it should NEVER be present in a clinical

setting.
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Sensor not connected. Check the Sp0O2 sensor connection
Clear to retry. 041c00

Alarm priority : Very low

Check the sensor and cable connection.

If the problem is still present, replace the
Sp0O2 sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify the module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists replace
the module.

SpO2 rebooting. 041e00  There is an SpO2 raw queue overrun

Alarm priority : Very low

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 041f00  There is an SpO2 hardware failure

Alarm priority : Very low

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

Sp02 rebooting. 042000  There is an Sp0O2 MCU failure

Alarm priority : Very low

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.
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Condition

Cause

Remedy

SpO2 rebooting. 042100

Alarm priority : Very low

There is an SpO2 watchdog failure

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

Sp02 not functional.
042200

Alarm priority : Very low

There is an invalid SpO2 board type

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042300

Alarm priority : Very low

There is an invalid SpO2 master
control state

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042400

Alarm priority : Very low

There is an Sp0O2 SRAM transfer
failure

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.
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Connex Spot Monitor

Condition Cause

Remedy

SpO2 rebooting. 042500  There is an SpO2 SRAM task queue

. n
Alarm priority : Very low overru

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042600  There is an SpO2 database failure

Alarm priority : Very low

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042700  There is an invalid SpO2 flash

Alarm priority : Very low memory device

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042800  There is an SpO2 anode voltage

_ configuration failure
Alarm priority : Very low 9

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.
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Condition

Cause

Remedy

SpO2 rebooting. 042900

Alarm priority : Very low

There is a problem with the SpO2
analog ground

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042a00

Alarm priority : Very low

There is a problem with the SpO2
digital ground

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042b00

Alarm priority : Very low

There is a problem with the SpO2 LED
ground

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042c00

Alarm priority : Very low

There is a problem with the SpO2
reference voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.
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Connex Spot Monitor

Condition

Cause

Remedy

SpO2 rebooting. 042d00

Alarm priority : Very low

There is a problem with the SpO2 DSP
core voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 042e00

Alarm priority : Very low

There is a problem with the SpO2
filtered input voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

Sp02 rebooting. 04200

Alarm priority : Very low

There is a problem with the SpO2 DSP
I/0 voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043000

Alarm priority : Very low

There is a problem with the SpO2
positive detector voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.
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Condition

Cause

Remedy

SpO2 rebooting. 043100

Alarm priority : Very low

There is a problem with the SpO2
negative detector voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043200

Alarm priority : Very low

There is a problem with the SpO2
positive LED Voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043300

Alarm priority : Very low

There is a problem with the SpO2 LED
drive voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043400

Alarm priority : Very low

There is a problem with the SpO2
positive preamp voltage

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.
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Connex Spot Monitor

Condition

Cause

Remedy

SpO2 rebooting. 043500

Alarm priority : Very low

There is a problem with the SpO2
Sensor ID

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043600

Alarm priority : Very low

There is a problem with the SpO2
thermistor

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043700

Alarm priority : Very low

There is a problem with the SpO2 LED
current

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
module be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 043800

Alarm priority : Very low

There is a problem with the SpO2
preamp

A malfunction is detected. There are two
possible causes of these failures. First,

the power provided to the board is out

of specification. In this case, the failure
may be cleared once the underlying cause
is removed. Second, the board has an
actual hardware failure and recovery is not
possible. It is recommended that the SpO2
modaule be replaced, and if problem is still
present replace the monitor's main board.

SpO2 rebooting. 044300

Alarm priority : Very low

The SpO2 module received bad
packet

There is an internal software malfunction in
the main PCBA. Update the software. If the
problem persists, replace the module.

SpO2 rebooting. 044400

Alarm priority : Very low

The Sp0O2 module received an invalid
command

There is an internal software malfunction in
the main PCBA. Update the software. If the
problem persists, replace the module.
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Condition

Cause

Remedy

SpO2 rebooting. 044500

Alarm priority : Very low

The SpO2 module received a
command that would result in more
output than the baud rate can
support

There is an internal software malfunction in
the main PCBA. Update the software. If the
problem persists, replace the module.

SpO2 rebooting. 044600

Alarm priority : Very low

The SpO2 module received
a command that requires an
application that is not present

There is an internal software malfunction in
the main PCBA. Update the software. If the
problem persists, replace the module.

SpO2 rebooting. 044700

Alarm priority : Very low

The SpO2 module received a
command while still locked

There is an internal software malfunction in
the main PCBA. Update the software. If the
problem persists, replace the module.

SpO2 low signal quality.
Check sensor. 044f00

Alarm priority : Very low

Sp02 low Sat signal quality

Reapply the sensor to the patient. If the
problem is still present, replace the Sp0O2
Sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO02 tester. If the message persists, replace
the module.

SpO2 rebooting. 045000

Alarm priority : Very low

Low PR confidence

Reapply the sensor to the patient. If the
problem is still present, replace the Sp0O2
Sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Sp02 low signal quality.
Check sensor. 045100

Alarm priority : Very low

Low Pl confidence

Reapply the sensor to the patient. If the
problem is still present, replace the Sp0O2
Sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

RRp low confidence.
Check sensor. 045200

Alarm priority : Very low

Low RRp confidence

Reapply the sensor to the patient. Move
the sensor to a better perfused site, or a
site with less movement. If the problem is
still present, replace the SpO2 Sensor. If the
problem is still present, replace the cable. If
the problem is still present, verify module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.
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Nellcor messages

Connex Spot Monitor

Condition

Cause

Remedy

Sensor not connected.
Clear to retry. 043900

Alarm priority : Very low

The SpO2 sensor is not connected

Connect Sp0O2 sensor. If the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Searching for pulse signal.
043a00

Alarm priority : High

Sp02 pulse search

None 4

SpO2 interference
detected. Clear to retry.
043c00

Alarm priority : Very low

Sp02 module interference detected.

Reapply the sensor to the patient. If the
problem is still present, replace the Sp0O2
Sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

SpO2 rebooting. 043d00

Alarm priority : Very low

Sp02 module hardware error

A module hardware error is detected.
Replace module.

SpO2 rebooting. 043e00

Alarm priority : Very low

Sp0O2 module hardware error

A module hardware error is detected.
Replace module.

Sp02 rebooting. 04300

Alarm priority : Very low

Sp02 module software error

A module software error is detected. Wait
for module to reset itself.

SpO2 rebooting. 044000

Alarm priority : Very low

Sp02 module received a bad
message

None. Contact Welch
Allyn Technical Support:https://
www.hillrom.com/en/about-us/locations/.

Replace the SpO2 sensor.
044100

Alarm priority : Very low

Sp02 defective sensor.

Replace the SpO2 sensor. If the problem is
still present, replace the SpO2 sensor. If the
problem is still present, replace the cable. If
the problem is still present, verify module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

SpO2 rebooting. 044200

Alarm priority : Very low

The Sp0O2 module received a bad
message

None. Contact Welch
Allyn Technical Support:https://
www.hillrom.com/en/about-us/locations/.

4 Pulse search is a normal part of operation and does not have an associated corrective action.
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Condition

Cause

Remedy

Sensor not connected.
Clear to retry. 040100

Alarm priority : Very low

The SpO2 sensor is not connected

Connect Sp02 sensor, if the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, replace the module.

Searching for pulse signal.

040200
Alarm priority : High

None

None >

SpO2 interference
detected. Clear to retry.
040400

Alarm priority : Very low

The SpO2 interference detected.

Reapply the sensor to the patient. If the
problem is still present, replace the Sp0O2
Sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Low SpO2 perfusion
index. Clear to retry.
040500

Alarm priority : Very low

SpO2 marginal pulse quality or
artifact

Reapply the sensor to the patient. If the
problem is still present, replace the SpO2
Sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, replace
the module.

Temperature messages

SureTemp messages

Condition

Cause

Remedy

Temperature not
functional. 30105

Alarm priority: Very low

WACP message CRC mismatch on
temperature module

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30201

Alarm priority: Very low

This message is not implemented by
the temperature module

Internal malfunction. If the problem
persists, replace the module.

5 Pulse search is a normal part of operation and does not have an associated corrective action.
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Connex Spot Monitor

Condition

Cause

Remedy

Temperature not
functional. 30202

Alarm priority: Very low

This message is not supported by the
temperature module

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30203

Alarm priority: Very low

The temperature module has run out
of memory.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30205

Alarm priority: Very low

The temperature module received a
invalid parameter

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30206

Alarm priority: Very low

The parameter provided by the
temperature module is outside of
the allowable range for the specified
message.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30207

Alarm priority: Very low

The temperature module message
requires an object, but did not
contain one.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30208

Alarm priority: Very low

The temperature module object
provided with the message could not
be deserialized.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30209

Alarm priority: Very low

The temperature module object
could not be serialized.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3020A

Alarm priority: Very low

The temperature module message is
performing a request/action when
the module state prohibits the
request/action.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3020B

Alarm priority: Very low

The temperature module requested
item is not currently available due to
the module state.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30503

Alarm priority: Very low

The temperature module factory
settings, and calibration information
is corrupt.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30504

Alarm priority: Very low

The temperature module user
settings are corrupt.

Internal malfunction. If the problem
persists, replace the module.
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Cause

Remedy

Temperature not
functional. 30509

Alarm priority: Very low

The temperature module calibration
is not set.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3050C

Alarm priority: Very low

The temperature module error log is
corrupt.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30516

Alarm priority: Very low

A hardware malfunction on the
temperature module has been
detected.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30518

Alarm priority: Very low

The temperature module power rail is

too low.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30519

Alarm priority: Very low

The temperature module power rail is

too high.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3051A

Alarm priority: Very low

The temperature module reference
voltage circuit was detected to be
under voltage or unstable.

Internal malfunction. If the problem
persists, replace the module.

Ambient temperature out
of range. Clear to retry.
30801

Alarm priority: Very low

The temperature module
measurement is below the allowable
temperature values and beyond the
low ambient or patient limits.

Verify conditions are greater than 50 °F
or 10 °C. If conditions are valid and the

problem persists, replace the probe. If the
problem still persists, replace the module.

Ambient temperature out
of range. Clear to retry.
30802

Alarm priority: Very low

The temperature module
measurement is above the allowable
temperature values and beyond the
high ambient or patient limits.

Verify conditions are less than 104 °F or 40
°C. If conditions are valid and the problem
persists, replace the probe. If the problem

still persists, replace the module.

Temperature not
functional. 30803

Alarm priority: Very low

The temperature module internal
calibration resistor (RCAL) on the
board is damaged or contaminated
(pulse too long).

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30804

Alarm priority: Very low

The temperature module internal
calibration resistor (RCAL) on the
board is damaged or contaminated
(pulse too short).

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30805

Alarm priority: Very low

The temperature module internal

circuit validation resistor (PTB) on the

board is damaged (value is over).

Internal malfunction. If the problem
persists, replace the module.




170 Troubleshooting

Connex Spot Monitor

Condition

Cause

Remedy

Temperature not
functional. 30806

Alarm priority: Very low

The temperature module internal
circuit validation resistor (PTB) on the
board is damaged (value is under).

Internal malfunction. If the problem
persists, replace the module.

Ambient temperature out
of range. Clear to retry.
30807

Alarm priority: Very low

The temperature module A/D
measurement timed out

Verify conditions are greater than 50 °F
or 10 °C. If conditions are valid and the
problem persists, replace the probe. If the
problem still persists, replace the module.

Replace temperature
probe. 30808

Alarm priority: Very low

The temperature module probe was
not characterized/calibrated

Probe malfunction. Replace the probe. If
the problem persists, replace the module.

Insert correct color-coded
probe well. 30809

Alarm priority: Very low

The temperature module is missing
the probe well

Insert the probe well

Temperature not
functional. 3080A

Alarm priority: Very low

The temperature module has a
problem saving to the monitor
EEPROM in biotech mode

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3080B

Alarm priority: Very low

The temperature module error
detection mechanism detected an
error

Internal malfunction. If the problem
persists, replace the module.

Replace temperature
probe. 3080C

Alarm priority: Very low

The temperature module probe error
detection mechanism detected an
error

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Temperature not
functional. 3080D

Alarm priority: Very low

The temperature module log error
detection mechanism detected an
error

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Temperature not
functional. 3080E

Alarm priority: Very low

The temperature module calibration
error detection mechanism detected
an error

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Connect temperature
probe. 3080F

Alarm priority: Very low

The temperature module detected no
probe connected

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Replace temperature
probe. 30810

Alarm priority: Very low

The temperature module cannot read
the probe EEPROM correctly or the
probe left the factory without being
tested.

Probe malfunction. Replace probe. If the
problem persists, replace the module.
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Temperature not
functional. 30811

Alarm priority: Very low

The temperature module has an
invalid events index

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30812

Alarm priority: Very low

There is a problem reading the
temperature module EEPROM or
saving to the monitor EEPROM in
biotech mode.

Internal malfunction. If the problem
persists, replace the module.

Replace temperature
probe. Code 30813

Alarm priority: Very low

The temperature module has a
problem reading the probe EEPROM.

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Temperature not
functional. 30814

Alarm priority: Very low

The temperature module TEMP
CONFIG ACQUIRE FAILURE

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30815

Alarm priority: Very low

The temperature module TEMP
CONFIG RELEASE FAILURE

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30816

Alarm priority: Very low

The temperature module TEMP
CONFIG INVALID PTR FAILURE

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30817

Alarm priority: Very low

The temperature module internal
error. EEPROM not initialized

Internal malfunction. If the problem
persists, replace the module.

Unable to detect
new temperature. Retry
measurement. 30818

Alarm priority: Very low

The temperature module heater
indicates on when turned off.

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Unable to detect
new temperature. Retry
measurement. 30819

Alarm priority: Very low

The temperature module heater
indicates off when turned on.

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Temperature not
functional. 3081A

Alarm priority: Very low

The temperature module HTR_Q is on
and HTRC is off but still has voltage.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3081B

Alarm priority: Very low

The temperature module HTR_Q is
tri-stated with HTRC enabled and has
heater power.

Internal malfunction. If the problem
persists, replace the module.
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Cause

Remedy

Temperature not
functional. 3081C

Alarm priority: Very low

The temperature module turned Q&C
on and the heater voltage is not high

enough.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3081D

Alarm priority: Very low

The temperature module heater
hardware failsafe should have turned

off but did not.

Internal malfunction. If the problem
persists, replace the module.

Replace temperature
probe. 3081E

Alarm priority: Very low

The temperature module probe is

above 112°F or 43.3°C.

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Replace temperature
probe. 3081F

Alarm priority: Very low

The temperature module has

excessive heater energy

Probe malfunction. Replace probe. If the
problem persists, replace the module.

Temperature not
functional. 30820

Alarm priority: Very low

The temperature module host

interface error

Internal malfunction. If the problem
persists, replace the module.

Ambient temperature out
of range. Clear to retry.
30821

Alarm priority: Very low

The temperature module over

ambient 45 °C temp

Verify conditions are less than 104 °F or 40
°C. If conditions are valid and the problem
persists, replace the probe. If the problem
still persists, replace the module.

Ambient temperature out
of range. Clear to retry.
30822

Alarm priority: Very low

The temperature module under

ambient temp

Verify conditions are greater than 50 F
or 10°C. If conditions are valid and the
problem persists, replace the probe. If the
problem still persists, replace the module.

Temperature not
functional. 30823

Alarm priority: Very low

The temperature module has an

invalid SureTemp algorithm

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30824

Alarm priority: Very low

The temperature module is over max

battery volts

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30825

Alarm priority: Very low

The temperature module is under

min battery volts

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30826

Alarm priority: Very low

The temperature module battery

volts not set

Internal malfunction. If the problem
persists, replace the module.
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Cause
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Temperature not
functional. 30827

Alarm priority: Very low

The temperature module predict
algorithm is not set

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30828

Alarm priority: Very low

The temperature module ambient
temp is not set

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 30829

Alarm priority: Very low

The temperature module has a non-
responsive probe. The thermistor has
pulled away from the tip or the heater
is broken.

Probe malfunction. Replace probe. If the

problem persists, replace the module.

Temperature not
functional. 3082A

Alarm priority: Very low

The temperature module is
experiencing bad probe gain

Probe malfunction. Replace probe. If the

problem persists, replace the module.

Temperature not
functional. 3082B

Alarm priority: Very low

The temperature module has a bad
probe response value

Probe malfunction. Replace probe. If the

problem persists, replace the module.

Temperature not
functional. 03C800

Alarm priority: Very low

The temperature module is not
functional

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 03C900

Alarm priority: Very low

Unable to deserialize messages from
the temperature module

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 03CAQ0

Alarm priority: Very low

Unsupported message received from
the Temperature module

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 03CB00

Alarm priority: Very low

Unable to send message to the
Temperature module

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 03CC00

Alarm priority: Very low

Temperature module communication
times out

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 03CD00

Alarm priority: Very low

Failed to upgrade the temperature
module

Internal malfunction. If the problem
persists, replace the module.
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Cause

Remedy

Temperature not
functional. 03CE00

Alarm priority: Very low

Unable to read PIM file

Retry the device update.

Temperature not
functional. 03CEO1

Alarm priority: Very low

Upgrade file directory could not be
accessed

Retry the device update

Direct mode reading
timed out

Alarm priority:
Information

None

None

Tissue contact lost.

Alarm priority:
Information

Lost tissue contact while attempting
to acquire a temperature
measurement or acquired
measurement was performed with
limited tissue contact.

Check the tissue contact and try the
measurement again.

Temperature module Temperature sensor reset None
reset. 03D000 unexpectedly

Alarm priority: Very low

Braun 6000 messages

Condition Cause Remedy

Temperature not
functional. 3F0105

Alarm priority: Very low

WACP message CRC mismatch.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0201

Alarm priority: Very low

This message is not implemented by
the module.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0202

Alarm priority: Very low

This message is not supported by the
module.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0203

Alarm priority: Very low

The module has run out of memory.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0204

Alarm priority: Very low

No parameter provided for the
specified message.

Internal malfunction. If the problem
persists, replace the module.
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Condition

Cause
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Temperature not
functional. 3F0205

Alarm priority: Very low

The parameter provided is invalid for
the specified message.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0206

Alarm priority: Very low

The parameter provided is outside of
the allowable range for the specified
message.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0207

Alarm priority: Very low

The message requires an object, but
did not contain one.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0208

Alarm priority: Very low

The object provided with the
message could not be deserialized.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0209

Alarm priority: Very low

The object could not be serialized.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F020A

Alarm priority: Very low

The message is performing a request/
action when the module state
prohibits the request/action.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F020B

Alarm priority: Very low

The requested item is not currently
available due to the module state.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0503

Alarm priority: Very low

The factory settings, and calibration
information is corrupt.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0504

Alarm priority: Very low

The user settings are corrupt.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0509

Alarm priority: Very low

The calibration is not set.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3FO50C

Alarm priority: Very low

The error log is corrupt.

Internal malfunction. If the problem
persists, replace the module.
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Condition

Cause

Remedy

Temperature not
functional. 3F0516

Alarm priority: Very low

A hardware malfunction has been
detected

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0518

Alarm priority: Very low

The module power rail is too low.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0519

Alarm priority: Very low

The module power rail is too high.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3FO51A

Alarm priority: Very low

The reference voltage circuit was
detected to be under voltage or
unstable.

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0821

Alarm priority: Very low

The ambient temperature is too high

Temperature not
functional. 3F0822

Alarm priority: Very low

The ambient temperature is too low

Temperature not
functional. 3F0824

Alarm priority: Very low

The battery is over the maximum
voltage

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3F0833

Alarm priority: Very low

The sensor not functional

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3FOE04

Alarm priority: Very low

Low battery

Recharge the battery. If the problem
persists, check the battery.

Unable to detect
new temperature. Retry
measurement.

Alarm priority:
Information

No temperature measurement was
available from the thermometer at
the time it was docked.

If a measurement should have been
available, retry the measurement. If
problem the persists, replace the module.
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Condition

Cause

Remedy

Thermometer might be

docked improperly. Check
contacts and connections.

Alarm priority:
Information

Communication failure with docked
Braun

The thermometer might be docked
improperly. Check contacts and
connections. If problem the persists,
replace the module.

Temperature not
functional. 3FFFO1

Alarm priority: Very low

Unrecognized WACP parameter
received from sensor

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3FFF02

Alarm priority: Very low

Timeout waiting for sensor response

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3FFF03

Alarm priority: Very low

Error deserializing WACP message
received from sensor

Internal malfunction. If the problem
persists, replace the module.

Temperature not
functional. 3FFF04

Alarm priority: Very low

WACP stack send message failure

Internal malfunction. If the problem
persists, replace the module.

Re-dock Braun. 3FFF05

Alarm priority: Very low

Anti-theft timer expired

Re-dock the thermometer after taking a
measurement.

Patient and clinician data messages

Condition

Cause

Remedy

Unable to identify
clinician. No provider
configured at host.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify

clinician. Security provider

error.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify

clinician. User not found.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.
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Condition

Cause

Remedy

Unable to identify
clinician. Invalid ID or
system password.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify
clinician. Account
disabled/expired.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify
clinician. Password
expired/reset required.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify
clinician. Group
membership error.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify
clinician.

Touch Clear to delete all
data.

Alarm priority :
Information

Clinician authentication failure

Information status message; press OK
button to dismiss.

Unable to identify patient.

Touch Clear to delete all
data.

Alarm priority :
Information

Patient authentication failure

Information status message; press OK
button to dismiss.

Database schema out of

data; recreating.

Alarm priority :
Information

The database was cleared due to a
schema update

Information status message; press OK
button to dismiss.

Database is unreadable

The database was unreadable during

during startup; recreating. startup

1F0001

Alarm priority : Very low

Press OK button to dismiss.
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Cause

Remedy

Error accessing PDM
database; restarting PDM.
1F0002

Alarm priority : Very low

Database corrupted when device is in
operation

Press OK button to dismiss.

Maximum number of
patient records + Oldest
record overwritten.

Alarm priority :
Information

Data was deleted as it contained
more than 400 records

Information status message; press OK
button to dismiss.

No data saved.

Alarm priority :
Information

A manual save is not allowed

Information status message; press OK
button to dismiss.

Save successful.

Alarm priority :
Information

A manual record was saved

Information status message; press OK
button to dismiss.

Patient ID required to save
data.

Alarm priority :
Information

A Patient ID is required to save data

Information status message; press OK
button to dismiss.

Patient ID required to start
intervals.

Alarm priority :
Information

A Patient ID is required to start
intervals

Information status message; press OK
button to dismiss.

Clinician ID required to
save data.

Alarm priority :
Information

A Clinician ID is required to save data

Information status message; press OK
button to dismiss.

Clinician ID required to
start intervals.

Alarm priority :
Information

A Clinician ID is required to start
intervals

Information status message; press OK
button to dismiss.

Patient ID required to save
data.

Alarm priority :
Information

A Patient ID match is required to save
data

Information status message; press OK
button to dismiss.
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Cause

Remedy

Patient ID required to start
intervals.

Alarm priority :
Information

A Patient ID match is required to start

intervals

Information status message; press OK
button to dismiss.

Clinician ID required to
save data.

Alarm priority :
Information

A Clinician ID match is required to
save data

Information status message; press OK
button to dismiss.

Clinician ID required to
start intervals.

Alarm priority :
Information

A Clinician ID match is required to
start intervals

Information status message; press OK
button to dismiss.

Unable to auto save.

Alarm priority :
Information

The device was unable to auto save

Information status message; press OK
button to dismiss.

Barcode scan not
accepted.

Alarm priority :
Information

Barcode scanning is not available

Information status message; press OK
button to dismiss.

Invalid NIBP interval
parameter during interval
capture.

Alarm priority :
Information

An invalid interval parameter was
detected.

Information status message; press OK
button to dismiss.

Save successful.

Alarm priority :
Information

The auto save is successful in Office
Profile

Information status message; press OK
button to dismiss.

Unsent records: N of M

Alarm priority :
Information

There are unsent records waiting
when the device is powered down

Information status message; press OK
button to dismiss.

Barcode scanning is not
available. Enter patient
information manually.

Alarm priority :
Information

Barcode scanning is not available.
Enter patient information manually.

Information status message; press OK
button to dismiss.
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Condition Cause

Remedy

Invalid SpO2 interval
parameter during interval detected.
capture.

Alarm priority :
Information

An invalid interval parameter was

If SpO2 intervals are enabled and SpO2 clip
was removed, either stop the intervals or
reattach the SpO2 clip. Information status
message; press OK button to dismiss.

Radio messages

Condition Cause Remedy Priority
Radio not functional. Internal software error on Check for a software update and Very low
350000 the radio apply it. If still present, replace the

radio.
Lost network Radio lost association Ensure the access point is still Very low
communications. 350400 powered on and in range.

If your facility has turned off radio

alarms, an Information message will

display instead of an alarm message.
Invalid radio Radio configuration is Check the radio configuration. If Very low
configuration. invalid. problem is still present, reset the

Reconfigure and try
again. 350700

radio to factory defaults. If the
problem persists, check for software

update and apply it. If still present,
replace the radio.

Radio certificate is out of Indicates that the radio Date, time, or time zone needs to be Very low

date. 350800

certificate is out of date.  set properly, or the certificate needs

The date, time, or time to be updated.

zone may be incorrect
causing the certificate to
not be in the valid date
range.

Connectivity messages

Condition Cause

Remedy

Unable to obtain wired No wired connection
device IP address. 210000

Alarm priority : Very low

Verify DHCP functionality and
configuration.

Network not found; check Lost ethernet DHCP address
network cable connection.
210100

Alarm priority : Very low

Check wired connection into device
then verifiy DHCP functionality and
configuration.
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Cause
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Unable to communicate
with NRS. 360000

Alarm priority : Very low

Cannot communicate with NRS

Verfiy NRS IP configuration and
functionality.

Communication error with
host. TA0000

Alarm priority : Very low

Communication timeout failure with
external Host

Verify the external host services are loaded
and started on the server. If the problem
persists, check for available software
upgrades of the monitor or the system.

Data rejected. CRC
mismatch. TA0001

Alarm priority : Very low

The WACP stack has detected a CRC
mismatch in the message

Check the data and try again. If the
problem persists, contact your system
administrator.

Data rejected.
Unsupported message.
1A0002

Alarm priority : Very low

External Host NACK - The host does
not support the message/object.

Check the monitor and try again. If the
problem persists, contact your system
administrator.

Data rejected. Invalid
parameter. TA0003

Alarm priority : Very low

The message has an invalid
parameter.

Check the data and try again. If the
problem persists, contact your system
administrator.

Data rejected. Deserialize
the object. 1A0004

Alarm priority : Very low

The monitor failed to deserialize the
object.

Check the data and try again. If the
problem persists, contact your system
administrator.

Data rejected.
Unsupported message.
1A0005

Alarm priority : Very low

The host is in a state that cannot
accept the message.

Check the data and try again. If the
problem persists, contact your system
administrator.

Data rejected. Patient ID
required. TA0006

Alarm priority : Very low

The message has a missing patient ID

Add the patient ID to the record.

Data rejected. Clinician ID
required. TA0007

Alarm priority : Very low

The message is missing a clinician ID

Add the clinician ID to the record.

Data rejected. Time
mismatch. TA0008

Alarm priority : Very low

The message has a mismatched time

Ensure that the clock on the monitor and
the server match.




Service manual

Troubleshooting 183

Condition

Cause

Remedy

Unable to establish

network communications.

1A0009

Alarm priority : Very low

No network connection is available

Connect the device to an active network so
that the clinician ID can be imported.

No connection for send. No connection for send. None
Alarm priority :

Information

Send not successful. Send not successful. None

Alarm priority :
Information

Error in record. Try again

Alarm priority :

Connectivity NACK recieved for
NRS/ECS/CS/NCE

NRS/ECS/CS/NCE NACK that is record
specific and can be fixed by a clinician in
the next record

Information
Send successful. Data was successfuly sent over None
. USB/BT

Alarm priority :

Information
System messages

Condition Cause Remedy

000001 System failure Restart the monitor

Alarm priority: N/A

000002
Alarm priority: N/A

System failure

Restart the monitor

000003
Alarm priority: N/A

System failure

Restart the monitor

000004
Alarm priority: N/A

System failure

Restart the monitor

000005
Alarm priority: N/A

System failure

Restart the monitor

000006
Alarm priority: N/A

System failure

Restart the monitor

Internal hardware failure.

Alarm priority: N/A

The kernel image is corrupt, restart
not possible

Replace the main PCBA.
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Cause

Remedy

Internal hardware failure.

Alarm priority: N/A

The root file system is corrupted,

restart not possible

Restart the monitor. If the problem persists,
replace the main PCBA.

Internal hardware failure.
140100

Alarm priority: Very low

EEPROM access failed. The device

boot is possible, but wired

communications are disabled

Reprogram the EEPROM. If the problem
persists replace the main PCBA.

Internal hardware failure.

Alarm priority: N/A

SPL memory test failure, the monitor

will sound an SOS pattern

Restart the monitor. If the problem persists,
replace the main PCBA.

Internal hardware failure.
1C1000

Alarm priority: N/A

The monitor PIC communications

never starts or quits. The

communication won’t reasonably
recover at startup or during operation

Restart the monitor. If the problem persists,
replace the main PCBA.

Low battery 30 minutes or
less remaining. 1C1005

Alarm priority: Very low

The battery power is low

Connect the power supply to AC power to
charge the monitor.

Low battery 5 minutes or
less remaining. 1C1006

Alarm priority: High

The battery power is extremely low

Connect the power supply to AC power to
charge the monitor.

Battery is critically low;
plug into outlet. Device is
shutting down. 1C1007

Alarm priority: High

The battery power is critically low

Connect the power supply to AC power to
charge the monitor.

Update unsuccessful.
Reboot and retry. 1C1008

Alarm priority: Very low

The software update failed

Restart the monitor. If the problem is still
present, replace the main PCBA.

Host battery not charging.
1C100A

Alarm priority: Very low

The host battery is not charging

Restart the monitor. If the problem is still
present, check cable connections. If the
problem is still present, perform functional
checks for host. If the problem is still
present, replace battery. If the problem
persists, replace the main PCBA.

Factory default settings
now active. 3A0001

Alarm priority: Very low

The factory configuration settings are

active

The monitor has been configured to factory
defaults, any user settings have been reset.
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Condition

Cause

Remedy

Unable to read
configuration from USB.
3A0002

Alarm priority: Very low

Unable to load file from the external
USB memory device.

Retry the USB connection. If the problem is
still present, check for a proper format of
the USB drive. If the problem is still present,
replace the USB device. If the problem
persists, replace the main PCBA.

Internal hardware failure.

Device will shut down.
1C100D

Alarm priority: Very low

Power supply issue. The PMIC is too
hot

Check the operating environment
temperature. Allow the monitor to cool
down before operating again. If the
problem is still present, check the cable
connections. If the problem is still present,
perform functional checks for host. If the
problem is still present, replace the battery.
If the problem is still present, replace the
main PCBA.

Input voltage too low.
Device will shut down.
1C100C

Alarm priority: Very low

Power supply issue. The PMIC input
voltage is too low

Check the operating environment
temperature. Allow the monitor to cool
down before operating again. If the
problem is still present, check the cable
connections. If the problem is still present,
perform functional checks for host. If the
problem is still present, replace the battery.
If the problem is still present, replace the
main PCBA.

Unexpected restart
occurred. 1C1012

Alarm priority: High

The monitor unexpectedly restarted

Continue normal operation

Audio system not
functional 1D0100

Alarm priority: Very low

The speaker or audio codec is faulty

Replace speaker. If the problem is still
present, replace the main PCBA.

CSM battery is not
installed. 1C100E

Alarm priority: Very low

There is no battery in the monitor

Check the monitor for a battery and install
one if it is missing. If the problem is still
present, perform diagnostic checks on the
monitor. If the problem persists, replace the
main PCBA.

Device shutdown is not
available at this time

Alarm priority:
Information

System shutdown failure

Monitor cannot perform an immediate
shutdown. Disconnect AC power and
remove battery.

No valid files found

Alarm priority:
Information

No valid files were found on the USB
flash drive

Re-insert the USB flash drive with valid files.
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Cause

Remedy

Firmware update
successful.

Alarm priority:
Information

The software successfully updated

Information status message; press OK
button to dismiss.

Audio alarms are off.

Alarm priority:
Information

The monitor alarm audio is off

Information status message; press OK
button to dismiss.

Advanced settings
unavailable.

Alarm priority:
Information

The advanced settings are
unavailable because the monitor is

notin an idle state

Confirm that no sensors are attached to the
monitor, no alarms are active, and there is
no unsaved data in the Spot or Intervals
profile.

USB accessory
disconnected.

Alarm priority:
Information

The USB device was disconnected

from the monitor

Information status message; press OK
button to dismiss

Advanced settings

Alarm priority:
Information

The Advanced settings code was

entered correctly

Information status message; Exit Advanced
settings to dismiss.

Save not successful.

Alarm priority:
Information

The device configuration or logs were
not saved to the USB device

Information status message; press OK
button to dismiss

Save successful.

Alarm priority:
Information

The device configuration or logs were

saved to the USB device

Information status message; press OK
button to dismiss

Software upgrade is
downloading. Do not
shutdown.

Alarm priority:
Information

The monitor is downloading a

software update

Information status message; press OK
button to dismiss

Factory reset successful.

Alarm priority:
Information

The monitor was reset to factory

settings

Information status message; press OK
button to dismiss

Factory reset failed.

Custom configuration file

not deleted.

Alarm priority:
Information

The monitor factory reset has failed.

Information status message; Exit Advanced
settings to dismiss.
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Condition

Cause

Remedy

Configuration upload
successful.

Alarm priority:
Information

The device configuration has
successfully uploaded

Information status message; press OK
button to dismiss

Unable to load
configuration; using
factory defaults.

Alarm priority:
Information

The device configuration was not
successfully uploaded

Information status message; Exit Advanced
settings to dismiss.

Client certificate load
successful

Alarm priority:
Information

Client certificate was successfully
loaded.

None

Unable to load client
certificate.

Alarm priority:
Information

Unsuccessful load

Reinsert USB drive and try again.

Unable to load client
certificate.

Alarm priority:
Information

Invalid certificate format.

Corrupted certificate.

Unable to load client
certificate.

Alarm priority:
Information

Outside of valid date range.

Certificate dates misaligned.

No client certificate
loaded.

Alarm priority:
Information

Client authentication is enabled, but
no client certificate is loaded.

Load a valid client certificate.

Client certificate expires

within 30 days.

Alarm priority:
Information

Certificate close to expiration date.

Update the client certificate.

Unable to connect due

to invalid client certificate.

TAO00A

Alarm priority: Very low

Corrupted or invalid certificate.

Update the client certificate.
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Condition Cause Remedy Priority
Software Update: The manifest file Verify the connection and retry. Information
Manifest transfer timed  transfer timed out or
out. Verify connection connection was lost
and retry. during download
Software Update: The package file Verify the connection and retry. Information
Package file transfer transfer timed out or
timed out. Verify connection was lost
connection and retry during download
Software Update: Invalid There was an invalid Verify and update the token file. Information
token file. token file
Software Update: Unable The manifest file was not Verify the manifest file is on the Information
to find manifest file on found on the server server.
server.
Software Update: Unable The manifest file Regenerate the software package Information
to verify manifest file signature verification and retry.
signature. failed.
Software Update: The package file is Regenerate the software package Information
Package file corrupted.  corrupt, does not have and retry.
Regenerate package and expected SHA256 hash
retry.
Software Update: Unable The package file cannot  Verify the package file is on the Information
to find package file. be found server.
Software Update: Failure to install Restart the monitor. Information
Installation failed. Reboot subsystem
and retry.
Software Update: The partition is running  Free up adequate space neededto  Information
Upgrade unsuccessful. out of space perform the upgrade.
Insufficient disk space.
Software Update: The current firmware Try to update to an earlier software  Information
Update unsuccessful. version is lower than package.
Incompatible firmware.  the one required by the

token file
Software Update: SWUP  SWUP NIBP is not Information status message; click OK Information
internal error functional button to dismiss.
Software Update: Software update Information status message; click OK Information

Manager internal error

manager internal error

button to dismiss.
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Condition Cause

Remedy Priority

Radio software upgrade  The radio software was

Check for software update and apply Very low

failed. 350600 not upgraded. it. If message is still present, replace
the radio.

Bluetooth messages

Condition Cause Remedy

Bluetooth not functional. The monitor detected a Bluetooth Reboot the monitor. If the problem persists,

370001 device that is not functional replace the Bluetooth radio. If the problem

Alarm priority: Very low persists, replace the main PCBA.

Bluetooth not functional. The monitor cannot detect a Replace the Bluetooth radio. If the problem

370002 Bluetooth module persists, replace the main PCBA.

Alarm priority: Very low

Bluetooth device The Bluetooth device connected None.

connection successful

Alarm priority:

Information

N/A The Bluetooth device failed to pair Verify a successful pairing between the

Alarm oriority: Very low with the monitor. device and the PC. If the problem is

P y-very still present, verify the Bluetooth signal

strength. If the problem persists, verify
authentication code, verify the computer
hardware and configuration. If the problem
persists, verify if the computer has prior
pairing information for the monitor.

N/A The Bluetooth device failed to pair Version of stack on the PC does not support

Alarm oriority: Very low with the monitor. simple secure pairing. The device requires

P y-very 2.1+EDR Bluetooth stack on the host PC.
Bluetooth device The Bluetooth device connected None.

connection successful

Alarm priority:
Information
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Connex Spot Monitor

Condition

Cause

Remedy

N/A
Alarm priority: N/A

The Bluetooth device did not connect
with the monitor

BT device connection dropped due to
distance, application crash on host end.

OR
RF connection not possible
OR

RF connection possible, but cannot find
device

OR

BT connection was established, but WACP
connection not possible

Bluetooth device
disconnected
Alarm priority:
Information

The Bluetooth disconnected

None.

APM messages

Condition

Cause

Remedy

APM not functional.
1C1001

Alarm priority: Very low

The APM is detected as connected
but there is no communication
through the APM serial port

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace the APM.
If the message persists, replace the main
PCBA on the monitor.

APM not functional.
1C1008B

Alarm priority: Very low

The APM battery is installed, but does
not communicate with the monitor

Perform diagnostic checks on the monitor.
If the problem is still present, replace the
APM battery. If the problem still present,
replace the APM. If the message persists,
replace the main PCBA on the monitor.

APM battery is absent or
faulty. 1C100F

Alarm priority: Very low

The APM battery is not installed

Ensure than an APM battery is installed,
and install one if it is missing. If the
problem is still present, perform diagnostic
checks on the monitor. If the problem is still
present, replace the APM. If the message
persists, replace the main PCBA on the
monitor.

The APM is disconnected.
1C1002

Alarm priority: Very low

The APM is unplugged from the
monitor while the monitor is
powered on

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace the APM.
If the message persists, replace the main
PCBA on the monitor.
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Condition

Cause

Remedy

USB cable is disconnected.
1C1003

Alarm priority: Very low

The APM USB hub is unplugged from
the monitor while the monitor is
powered on

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace the APM.
If the message persists, replace the main
PCBA on the monitor.

APM is plugged in.

Alarm priority:
Information

The APM was plugged in while the
monitor is powered on.

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace the APM.
If the message persists, replace the main
PCBA on the monitor.

APM not functional.
1C1010

Alarm priority: Very low

The APM USB hub is plugged in while
the monitor communication cable is
disconnected

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace the APM.
If the message persists, replace the main
PCBA on the monitor.

APM not functional.
1C1004

Alarm priority: Very low

The APM PIC cannot communicate
with the accelerometer

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace APM.
If the message persists, replace the main
PCBA on the monitor.

APM not functional.
1C1009

Alarm priority: Very low

The APM PIC software update and
any retries have failed

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, retry the software
update. If still present, replace the APM.

If the message persists, replace the main
PCBA on the monitor.

APM not functional.
1C1008B

Alarm priority: Very low

The APM battery is not recharging

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, replace the APM.
If the message persists, replace the main
PCBA on the monitor.

APM not functional.

Alarm priority:
Information

The APM USB changes from
unplugged to plugged after monitor
startup

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, retry the software
update. If still present, replace the APM.

If the message persists, replace the main
PCBA on the monitor.
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Connex Spot Monitor

Condition Cause Remedy
Device is operating in AC power cord has been Information status message; press OK
battery mode. disconnected. button to dismiss.

Alarm priority:
Information

Sleep mode is unavailable. Sleep mode is not allowed when
Intervals monitoringisin  intervals are in progress

progress.

Alarm priority:
Information

Stop any active intervals.

Sleep mode is unavailable. Sleep mode is not allowed when

An alarm is active. alarms are active

Alarm priority:
Information

Clear all active alarms.

Display lock is unavailable. Lockout is not allowed without active
Missing patient context. patient information

Alarm priority:
Information

Enter patient information

Power cable is The APM communication cable is
disconnected. 1C1011 plugged in while the APM USB cable

. is disconnected
Alarm priority: Very low

Restart the monitor and the APM. If the
problem is still present, check the cable
connections from the monitor to APM. If
the problem still present, retry the software
update. If still present, replace the APM.

If the message persists, replace the main
PCBA on the monitor.
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Introduction for Connex Direct

Follow these steps to:

« setup an Active Directory connection for clinician authentication.
« set up an NTP connection for date/time synchronization.
- install wireless network radio certificates.
set up an HL7 Direct Connection to enable a device to directly send patient queries and vitals to an EMR.

Active Directory and HL7 (Direct EMR Connection) features are used to identify, authenticate, and authorize
users/clinicians via clinician query from the device.

These instructions apply to the following devices:

Connex Spot Monitor (CSM), Version 1.32.01 or higher

Related documents

When using this manual, refer to the following:

« Instructions for use for your Connex device
«  Wireless Best Practices Overview 80023689
«  Welch Allyn Network Installation Best Practices 80018745
Welch Allyn Vitals Device HL7 Interface 60080809 IDS
«  Welch Allyn Configuration Tool Reference guide 80027311
+  Welch Allyn Service Tool (WAST): www.hillrom.com/en/services/welch-allyn-service-tool/

« Welch Allyn Service Tool Installation and configuration guide: www.hillrom.com/en/services/welch-allyn-
service-tool/

Definitions

Acronym/Term Description

AD A directory service developed by Microsoft for providing tree-structured information.
Used for authenticating and authorizing users of the device.

Clinician Workflow feature where a clinician is required to log in to the device. The device will

Authentication assure a clinician’s credentials are valid by providing an interface where the clinician logs
in to the device using their ID and password, and the ID and password are validated by an
authority system on the network (for example, Active Directory).

Clinician Workflow feature where the clinician enters their ID into the device so the Clinician ID can

Identification be logged with the vitals.

Clinician Identifier ~ Configurable to be the clinician’s User name, Account name, or Employee ID.

CSM Connex Spot Monitor: A device that supports NIBP; Temperature (SureTemp Plus and
Braun); SpO2 (Nellcor; Masimo, and Nonin); Weight, Height, and BMI; Pain; and other
configured parameters.



https://www.hillrom.com/en/services/welch-allyn-service-tool/
https://www.hillrom.com/en/services/welch-allyn-service-tool/
https://www.hillrom.com/en/services/welch-allyn-service-tool/
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Acronym/Term Description

DC Domain Component — In LDAP servers and Active Directory, a dotted domain name is
split into domain components that form “dc=component” pairs separated by commas.

Example

ad.welchallyn.com in an AD server will be ““dc=ad ,dc=welchal lyn,dc=com”

FQDN Fully Qualified Domain Name. The complete domain name of a computer on the Internet.
Contains the host name and the full domain.

Gateway Software A software application that can receive data from a device and convert the data to HL7
messages and then transmit that data via a TCP/IP socket.

HL7 Health Level 7 — A framework for the exchange, integration, sharing, and retrieval of
electronic health information.

Host HL7 System or Software System that receives the HL7 data from the device.
Host Application

IDS Interface Design Specification

LDAP Lightweight Directory Access Protocol - An industry standard protocol for maintaining
distributed directory information. Often used for user names and password information.

NTP Network Time Protocol is a networking protocol for clock synchronization between
computer systems. It is used by the devices to maintain accurate date/time in the devices.

Patient The act of the device configuration/behavior ensuring that the vitals record contains the

Confirmation patient context.

Patient The act of the device configuration/behavior that displays the patient context on the

Identification device and that allows the clinician to ensure the right vitals go to the right patient.

SSL Secure Sockets Layer— A set of cryptographic protocols to provide security of
communications over a network. SSL is a predecessor to TLS.

Vitals Device Generic names for CSM, CVSM, and CIWS.

X.509 Certificate An X.509 certificate is a digital certificate that uses the widely accepted international
X.509 public key infrastructure (PKI) standard to verify that a public key belongs to the
user, computer or service identity contained within the certificate.
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Architecture for Connex Direct

- | lwa@l

Welch Allyn® Connex®  Welch Allyn® Connex® Welch Allyn® Connex®
Spot Monitor Vital Signs Monitor Integrated Wall System

Active
Directory
Server

— — — Optional

e— Required

Server

EMR Server

1 Patient Query HL7 (QRYAA19) AES-128'

2 Patient Demographics HL7 (RSPAK22) AES-128!

3 Vitals HL7 (ORUARO1) AES-128"
DNS Server

4 DNS Lookup

Active Directory Server

5 Clinician Authentication

NTP Server

6 Date/Time Synchronization

1 Optional setting within the device.

Technical Specifications

Ports

Listening Ports A single TCP/IP listening port on the EMR (or external server) needs to be
available to receive connections from multiple devices.

Computer Requirements
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NTP Message Frequency

Connex Spot Monitor

The NTP host solutions must be capable of processing time synchronization
requests every 36 seconds (see IDS for calculation details).

Active Directory Message
Frequency

The host solutions must be capable of processing clinician authentication
requests every 36 seconds (see IDS for calculation details).

Patient Lookup and/or Vitals
Send

The host solutions must be capable of processing patient lookup requests every
1.2 seconds (see IDS for calculation details).

Network

Internet Connection

An Internet connection may be required depending on how NTP is configured.
If NTP is configured to use an external time server (e.g., time.nist.gov), then the
device must be able to connect to the Internet.

Device Support

Quantity Some systems may scale up to and potentially beyond 400 devices, depending
on the clinical environment.

Devices

Connex Spot Monitor (CSM) with software version 1.30 or higher

Active Directory setup

Prerequisites:

Confirm that the Date and Time are set correctly on the device.

53'1] NOTE This ensures that the device Date and Time fall between the Certificate Authority (CA) root

certificate validity period for successful connection.
Load the CA root certificate on the device and the server certificate on the Active Directory server.

w NOTE The connection to the Active Directory server might fail due to a missing CA root certificate

on the device and a missing server certificate on the Active Directory server. (See: "Import or
install an Active Directory server certificate on the Active Directory server" and "Import or Install
a Certificate Authority (CA) root certificate on the Active Directory server"). A CA can be either:
Third-Party (GoDaddy, Symantec, Comodo) or Self-Signed - Internal CA (AD CS).

Check the DNS server IP assignment on the device via DHCP or static configuration.

> Make sure that the assigned DNS Servers on the device can successfully query for the Domain Name
entered on the Active Directory user interface.

CA Root Certificate format

« The CA root certificate can be either in PEM or DER format and can have extensions: “.pem", “der”, “.crt’, or “.cer”.

« These certificate files are converted into PEM format during the load process on the device.

Specify Active Directory settings

1.

Access the Advanced Settings.
a. Touch the Settings tab.

b. Touch the Advanced tab.
c. Enter your password and touch OK.

The General tab appears.
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2. Touch the Network tab.
3. Touch the Active Directory tab.

@ Advanced settings.

Radio N Authentication user name
{J Enable Active Directory
{ ) Administrator@bal...
Security
| | Domain name Authentication password
HOR KRR KK
P {east.ballard.com ] [ }
Group Search subtree
Bluetooth®
| [Gdins J [OU:OUcIIns, DC=... }
Device 1P
Clinician 1D type
Active Directory | |EMPloyee ID i Test network connection

Active Directory settings

« Enable Active Directory (Turn the feature On or Off).

NOTE The device always uses TLS to encrypt communications between the Active Directory server
and the device. If an encrypted connection cannot be established, the device will not communicate
with the server.

NOTE As part of establishing the TLS connection, the device software requests an X.509 certificate
from the Active Directory server and validates it against a stored CA root certificate. If the AD server
cannot be validated, the device will not continue communications with the Active Directory server.

Host name or IP address
Use the FQDN or the IP Address of the Active Directory.

1. Touch the keyboard in the Host name or IP address text field.
2. Enter a Host name (FQDN) or an IP address of the Active Directory Server in the text field.

1=1-q

l NOTE FQDN consists of the Host name and Domain name.
Example:
<Hostname>.<DomainName>
Example:

SomeActiveDirectoryhost.someDomain.com

Port

Use the standard LDAP Port “389” to authenticate and authorize clinicians.
1. Touch the keypad in the Port text field.
2. Enter the Port Number that is listening for the LDAP connection on the Active Directory Server.

::'1] NOTE Keep the default Port entry “389"
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Domain Name

The Domain Name is the domain namespace of the server.
Touch the keyboard in the Domain name text field.

FQDN consists of the Host name and Domain name.

Example

<DomainName>

Example

someDomain.com

Example

hillrom.com

Example

service.hillrom.com

Group

Select the Group to which the clinician must belong to be Authenticated.

+ Touch the keyboard in the Group text field.

If the Group field is blank, a group will not be checked.

If there is a value, the query will check for a Group match. This is an alpha-numeric string.
Example

ServiceGroup

Example

ServiceGroup1

Clinician ID type

Clinician ID type is selected from a dropdown menu of the 3 listed options. (User name, Account name, or
Employee ID). These options correspond to the common fields in the Active Directory.

«  Touch the dropdown menu in the Clinician ID type field.
The device performs a match by using the selected option when the Clinician logs into the device.

The setting for the Clinician ID type is based on the facility policy. The facility policy determines how employees
are expected to log into a device and what is encoded in a barcode if using barcodes.

Example

"userPrincipalName” (User name)

“SAMAccountName” (Account name)

"employeeid” (Employee ID)

User name

A string attribute that contains the user account name and DNS domain name combined.

Example

<UserAccountName>@<DomainName>
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Example

serviceUser@hillrom.com
Account name
A SINGLE-VALUE attribute that is the user account name only.

Example

<UserAccountName>

Example

serviceUser

Employee ID

The user’s employee ID stated on the Active Directory Server.
Example

<employeelD>

Example
1234567890

Authentication user name

Authentication user name Is the name of a user with authority to perform clinician searches on the Active
Directory Server. This is an alpha-numeric string.

Touch the keyboard in the Authentication user name text field.
Example
UserName@DomainName.com

Example

Administrator@hillrom.com

Authentication password

Authentication password is the password of the Authentication user name. This is an alpha-numeric string and
case sensitive.

Touch the keyboard in the Authentication password text field.

Example
PassWard!23

Search subtree

The Search subtree searches for a Clinician in an “Organizational Unit” (OU). An Organizational Unit (OU)
is a subdivision within an Active Directory into which you can place Users, Groups, Computers, and other
Organizational Units.

The Search subtree field should be empty if you are just querying for a Clinician in the Domain/SubDomain Users
or Group.

« Touch the keyboard in the Search subtree text field.
Example
OU=0Uname, DC=DomainPrefix, DC=DomainSuffix
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Example

OU=someOU, DC=someDomain, DC=com
Example

OU=serviceOU, DC=hillrom, DC=com

Example

OU=serviceOU, DC=eastcoast, DC=hillrom, DC=com

Test network connection

Perform a lookup of the Default Naming Context to test the network connection to the Active Directory Server
and to test the use of the Administrator user name and password, and domain lookup.

+  Touch Test network connection to test the connection from the device to the Active Directory Server.

CSM

Load CA Root Certificate via Configuration file (someConfigFile-signed.waconfig) generated by WA
Configuration Tool.

Log into the Configuration Tool
Log into the Configuration Tool at this link:

https://config.welchallyn.com/configurator/.

Enter your Email Address and Password and click SIGN IN.

WelchAllyn

Product
Configuration Tool
v19.3

Email Address
Password
SIGN IN

Don't have an account? Register Here

Forgot your password? Reset it here!

The My Configurations screen appears.

My Configurations e

Lookup by serial number [serial Number |[csm~

Lookup by service order number and ERN Service Order Number RRp ¥

JThere are ons.

Configure a CA Root certificate using the Configuration Tool

Select the product that you would like to configure.


https://config.welchallyn.com/configurator/
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You can now load self-signed security certificates onto the Connex Spot Monitor (CSM) to ensure secure
communication with an authenticated server on the network.

CSM is also pre-loaded with the following certificates:

Go_Daddy_Class_2_Certification_Authority.pem
Symantec_Class_3_Public_Primary_Certification_Authority_-_G6.pem
VeriSign_Class_3_Public_Primary_Certification_Authority_-_G4.pem
VeriSign_Class_3_Public_Primary_Certification_Authority_-_G5.pem
Veri_Sign_Class_3_Public_Primary_Certification_Authority_-_G3.pem
COMODO_ECC_Certificate_Authority.pem
COMODO_Certificate_Authority.pem
Symantec_Class_3_Public_Primary_Certification_Authority_-_G4.pem
Go_Daddy_Root_CertificateAuthority_-_G2.pem
COMODO_RSA_Certificate_Authority.pem
VeriSign_Universal_Root_Certification_Authority.pem

To add a certificate from your computer:

1. From the main screen, click the New Configuration tab.
2. Use the drop down menu to select CA Root certificate.

3. Provide a name for the configuration by typing in the field to enter a user friendly name and then click
CONTINUE.

List Configurations New Configuration Customer Verification

New Configuration

Select the product that you would like to configure.

[CA Root certificate ~

Provide a user friendly name for your configuration.

ICerts I

4. Select the Product Use Location. (Choices include: Hospital or Physicians Office or Clinic.)
5. Click SAVE AND CONTINUE.
6. Click CA Root Certificate.

Configuration Name:

CA Root Certificate Setting

Selected CA Root Certificate

201
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7. Click Select an optional CA Root Certificate.

CA Root Certificate Selection

CA Root certificate must be in PEM or DER formats Failure o abice by these restrictions wil
cause the certificate to be ignored by the device.

Avallable CA Root Certificate

Aad Certificate to Client Library

8. Click Add Certificate to Client Library.
9. Navigate to the .pem file, or .der file, location using your computer's Windows File Explorer window. (The
sample screen shows a .pem file type.)

| ] cacert.pem 3/19/2018 1:53 PM PEM File
(3} client.pi2 3/19/2018 1:53 PM Personal Inf
N
2s0
ive, ¢ >
File name: [cacert.pern vl All Files (%) V|
| Open I ‘ Cancel

Select the file and click Open.
10. Select DONE.

CA Root Certificate Selection

CA Root eertificate must B¢ in PEM or DER formats Failure 10 abick By INese restrctions wil
cause the certificate to Be KGNOred by the aevice

Avallable CA Root Certificate

Add Certiicate to Client Library
1), cacert pem

11.Click SAVE AND CONTINUE.
Active Directory - setup details (best practices)

Prerequisites
Set up the Active Directory and the DNS Servers and ensure that your version supports this feature.

The following sections describe how to configure and use the device's Active Directory feature for clinician
authentication.
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Configuration support for the Active Directory
Install required certificates

For the device to connect to Active Directory, you need to include the Active Directory CA (Certificate
Authority) root certificate in the device configuration.

m NOTE The connection to Active Directory server might fail because of: A missing CA root certificate on

0 the device, an incorrect format certificate on the device (cacert. cer certificates are not recognized by
the CSM wireless radio), or by a missing server certificate on the Active Directory server. To authenticate
with the Active Directory server, CSM should have a CA root certificate from the same Certificate
Authority (CA) that issued a server certificate to the Active Directory server.

m NOTE The CA root certificate must be in PEM or DER formats. Failure to abide by these restrictions
causes the device to ignore the certificate.

Examples of CA (Certificate Authority) include:

+ Third party (GoDaddy, Symantec, Comodo, etc.)

or

+ Internal CA (AD CS) - self-signed certificates

Import or install third-party or AD CS Certificate Authority certificates
Request and import/install the following AD CS Certificate Authority certificates:

« Server certificate on Active Directory server via Windows Certificate Store
CA root certificate on Active Directory server via Windows Certificate Store
CA root certificate on the CSM device via Config File generated by the Configuration Tool

Install wireless network radio certificates
Wireless network authentication - radio certificates

supports uploading your wireless certificates onto CSM, CVSM, and CIWS devices. Uploading certificates can be
done using different methods based on the product design; however the certificates must be in a specific format
and be named correctly for deployment on a device. This document does not specify instructions for a specific
server. However, it does provide information about wireless client certificates and wireless client certificates that
support server authentication. This support pertains to products using the Newmar 802.11 a/b/g/n radio card
and the Lamarr 802.11 a/b/g radio card.

::'1] NOTE Customer certificates that are uploaded to devices must adhere to the x.509 standard.

Supported radio certificate formats

The 802.11 a/b/g/n radio supports a DER or PEM file format containing the CA root certificate chain -
cacert.der or cacert.pem.

The 802.11 a/b/g/n radio also supports the P12, PFX, or PEM file formats containing the device’s client certificate
and private key - client.pl12,orclient.pfx orclient.pem.

::'1] NOTE If a P12 or PFX file is supplied, the Newmar radio automatically converts it to PEM format during
T installation.

No server validation - no certificates
Devices do not need to load the corresponding CA root certificate to authenticate.

A certificate does not need to be created for Server Validation (such as EAP-PEAP with Enable Server Validation -
Unchecked).

No certificates need to be loaded onto the devices for successful PEAP authentication. Only the following inputs
are required:
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« User name
. Password

The 'waclientcert.pim'’ file

For a certificate to be loaded to the 802.11 a/b/g/n radio using the Welch Allyn Service Tool (WAST), the
certificate must be formatted into the wacl ientcert.pimfile format. This . pimfile is a specific container
that includes the customer certificates, commands, information about how the certs are to be loaded, and
information about which folders the certificates will be written to on the radio file system.

You cannot rename an existing customer client certificate or ca certificate towaclientcert._pimand
upload it, because the certificate lacks information on where the certificates need to be deployed on the
radio and how the product should handle the file. You must use the Welch Allyn Service Tool to create the
waclientcert.pimfile.

Create a 'waclientcert.pim’ file using the Welch Allyn Service Tool

The Welch Allyn Service Tool can create the “waclientcert.pim” file using only a ‘ca cert’ (server
verification), or a ‘ca cert’ and ‘client cert’ (for client authentication).

1. Create a folder on the PC or thumb drive and place the ca cert, and if needed, the client cert in the same
folder.

2. Connect a device to the PC running the WAST and allow the device to come up to a usable state.

3. Click Select to choose the desired device from the WAST ‘Device list’.

S Welch Allyn Service Tool . [u] X

File Administration  Help
Welcome, Administrator
Thursday 2021/07/08 11:41

Device list

To view device details, click on the desired row, and then click Select.

[ Connex Spot Monitor 100001774714 HCA

» [ welch Allyn Connex Device 100011654619 0.0.0.0
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4, Click the Configure tab and then click Change... in the Current settings pane.

5] Welch Allyn Service Tool - 0O X
File Administration Help
co d trato i
dnesday 2021/07/21 0
Device | Jork | Welch Allyn Connex Device X
Device name  Welch Allyn Connex Device 1P address 0.0.00 Radio IP address  0.0.0.0
~ Serial number 100011654819 Ethemet MAC address  D0:1A:FA:2A:20:24 perilon
" -? REF VSM 6000 Series Assat tag
= i
Device information |  Reports | Upgrade | Verifyand calibrate | Configure |

5. Select the Network Policy Server Certificate tab.

Blustoath Dewice Configuration | Dewion Software Roltback |
Sertal number | Netwark Policy Server Certificate |

Ganearate:

Select Certificate Folder

cran ———

Hebwork Policy Server Cortilicale Password

M __ _-- ."_ L= M‘ﬂh - I_- ——

Seloct axisting packags

CSM device
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6. Use the Browse button to select the folder where the customer certs are kept - this step fills in the Select
Certificate Folder field with a path to the customer certificates.

Browse For Folder ﬁ

Please select a location where certificate package is
generated

~d Libraries
A User E
4 /B Computer
- £_, Local Disk (C:)
@. SRecycle.Bin

Axeda
J Boot
4 certs o
| « e b
[kenenroder | [ ok ][ concel |

‘d

Server validation only certificate

If the certificate created for Server Validation (such as EAP-PEAP with Enable Server Validation checked), the
folder created should only containa “ca cert.pem”. A client certificate is not required.

The Network Policy Server Certificate Password and Confirm Password fields are inactive for editing, however, the
device needs to load the corresponding CA root certificate to authenticate.

The CA root certificate needs to be loaded onto both the device for successful PEAP authentication.

User name
« Password
. CAroot certificate (Installed - via WAST)

Client authentication certificate

If the certificate to be created is for Client Authentication (such as EAP-TLS) the folder created should have a “ca
cert’ and a ‘client certificate’ The Network Policy Server Certificate Password field and Confirm Password field
need to be filled in with the password created for the client cert at creation time.

L‘l NOTE The WAST does not verify the client password is correct, it only loads to the CSM radio for

T authentication. This password must be known for the client to authenticate to the network.



Service manual Connex Direct 207

Bluetooth | Device Configuration | Device Software Rollback |
Serial number | Network Policy Server Certificate |
|
Generate
Select Certificate Folder

Network Policy Server Certificate Password

Confirm Password

sesessed

Load
Select existing package
T
" od Wetwrork Py Server Cortiicate |
CSM device

1. Once you enter the folder path of the certificates, (and choose the Server Verification Only or Client
Authentication), click Generate Network Policy Server Certificate Package and browse to the destination
folder where the written “waclientcert.pim” file will appear.

Browse For Folder g

Please select a location where certificate package is
generated

4 Libraries
B User
4 /M Computer
4:-’ Local Disk (C:)
3. SRecycle.Bin

m »

Axeda
Boot
” 4 certs N
4 mn L}
I [ MakeNewFoder | [__ok ][ coxel |
ﬁ]

For convenience, create the “waclientcert._pim’ file in the same directory as the certificate files.
2. After selecting the destination location and clicking OK, the ‘Compressing; ‘Generating;, and ‘Success’ status
windows appear.

The destination folder now contains the “waclientcert.pim” file along with the certificate files.

Load awaclientcert.pim file onto the device with a Newmar Radio via
the Welch Allyn Service Tool (WAST)

1. Disconnect the USB link between the PC and the device.

2. Launch the Welch Allyn Service Tool (WAST) on the PC.

3. Reboot the device and allow it to come up to a usable state.
4, Connect the USB link from the PC to the device.
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5. Click Select to choose the desired device from the WAST 'Device list’

i Welch Allyn Service Tool
File Administration Help

Welcome, Administrator
Wednesday 2021/07/21 09:17

Device list

To view device details, click on the desired row, and then dlick Select.

Devices Serial number Location Asset tag TP address
[ Welch Allyn Connex Device 100011654819
» [ Connex Spot Monitor 100001054614 0.0.0.0

5S¢/ Welch Allyn Service Tool

File Administration Help.

Welcome, Administrator
Wednesday 2021/06/30 20:22
s el (el Connex Spot Monitor %

—— Deviczname  Connex Spot Monitor 1P address 0.0.0.0 Radio MAC address  00:00:00:00:00:00

Ethemet MAC address  Q0:1A:FA:Z4:01:13 Radio [P address  0,0,0.0 penico

v Jﬁi Serial number 100001054614
| '\ | REF 7IMT Asset tag Bluetooth name WACSM - 01054614

Device information |  Reports | Upgrade | Verify and calibrate |  Configure |
[ Location 1D: (i
Asset tag

_— e

Connex Spot Monitor
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7. Select the Network Policy Server Certificate tab.

5S¢/ Change device configuration settings

Connex Direct

] X

Serial number | Network Falm?‘\erver Certificate | Bluetooth | Device Configuration | Device Software Rollback | First Boot Settings

Generate

Select Certificate Folder

e

Network Policy Server Certificate Password

Confirm Password

Load

Select existing package

e
8. Click Browse from the Load pane and navigate to where the waclientcert.pimfileis located.
The Select existing package field displays the path to the wacl ientcert.pimfile.
Bluetooth ‘ Device Configuration | Device Software Rollback
Serial number ‘ Network Policy Server Certificate
Tt
Generate
Select Certificate Folder
Network Policy Server Certificate Password
Confirm Password
Load -

Select existing package

C:\certs\waclientcert.pim

Click Load Network Policy Server Certificate to load the certificate to the device radio.

A message box displays the installation progress. The process should take a maximum of three minutes.

r
L

begin again.

I NOTE If the process moves past the 6-minute mark, disconnect the device from USB, reboot it and

209
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10. If the message box displays the message: Server certificate is successfully loaded on device, click OK.

Se

Network Policy Server Certificate | Bluetooth | Device Configuration | Device Software Rollback | First Boot Settings

Generate

Select Certificate Folder

Installation Status X

Network Policy Server Certificate Password Server certificate is suecesstully loaded on device,

Confiem Password

Load

Select existing package

11. Close the Welch Allyn Service Tool application.
12. Disconnect the USB connection.
13. Restart the device.

You can now configure the device to use certificates on the wireless network.

Import or install an Active Directory server certificate on the Active
Directory server

These instructions apply to Active Directory servers with Windows Server 2012 OS and above:
1. Press the Windows key + R to bring up the Run command.

2. Type nmt and press Enter to open the Microsoft Management Console.

4 Run X
=7 Type the name of a program, folder, document, or Internet
—=  resource, and Windows will open it for you.
Open: | [EEBE

Cancel Browse...

3. Click the File menu and then select Add/Remove Snap-in....
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4, Select Certificates from the list of Snap-ins, and click Add.

Add or Remove Snap-ins X

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Avalable snap-ins: Selected snap-ins:
Snapn Vendor ~ Zl Console Root Edit Extensions. .
G —— SR (3 Certificates - Current User .
[E3Authorization Manager Microsoft Cor... —
i Certificates Microsoft Cor....
. Component Services  Microsoft Cor...
;ﬁ Computer Managem... Microsoft Cor...
Booret e, W [LHAE
3] Event Viewer Microsoft Cor...

_|Folder Microsoft Cor...
-/ Group Policy Object ... Microsoft Cor...
EIP Security Monitor Microsoft Cor...
&, 1p security Policy M...  Mirosoft Cor....
‘“ | Link m Web Ad‘dr’ess !Wa'osofl (Ear... N Advanced...

Description:
The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer,

oK Cancel

5. Inthe next dialog box, select Computer account and click Next.
Select Local computer and click Finish.

7. From the “Add or Remove Snap-ins” window, click OK.
Click > to view the certificates folder. When you open any certificates folder, you will see certificates displayed
in the right pane.

8. Import/Install the AD server certificate into the following folder: Certificates (Local Computer) > Personal >
Certificates.

9. Right-click the Certificates folder under Personal and choose All Tasks > Import.

ET T T T T

Y olf=IR-I=T °]

Issued To B Issued By Status.
B Adobe Content Centficate 10-5 Adobe Intermediate CA 10-3 a/12025 <Al <Hone>

~ (] Pessonal

P A ) Adabe Content Certificate 10-6  Adobe Intermediate CA 10-4 <Al> <None>
- <All> <None>
Trusted Root ¢ All Tasks. » Request New Certificate... - (N" ‘!
Enterprise Tru Ieport. Ml lene:
Intermediate (V'O o Smant Card Logon, .. <None>
ActiveDirecte  Mew Window from Here. Advanced Opesations. > Client Authentication <Mone>
Trusted Publis F UTgEEETOT e Aceess (20.. Client Authentication <Mone>
Hew Taskpad View  Organization-P2P-, 2

Untrusted Cer ] MS-Organization-P2P-Access [20... Client Authentication  <None>
Third-Party Re Refresh
Tusted Peopl oo List
Client Authen
Other People. Help

10. Follow the Certificate Import Wizard and provide the Active Directory Server Certificate file path.

i:'l] NOTE An example Active Directory server certificate is shown below.
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n  Certificate X

General Details Certification Path

g Certificate Information

This certificate is intended for the following purpose(s):

* Proves your identity to a remote computer A
« Ensures software came from software publisher

* Protects software from alteration after publication

« Allows data on disk to be encrypted

* Protects e-mail messages

o Allows secure communication on the Internet -

Issued to: AAA Certificate Services

Issued by: AAA Certificate Services

Valid from 12/31/2003 to 12/31/2028

Issuer Statement

[ ]

Connex Spot Monitor

Import or install a Certificate Authority (CA) root certificate on the Active
Directory server

These instructions apply to Active Directory servers with Windows Server 2012 OS and above:

1. Press the Windows key + R to bring up the Run command.

2. Type nmt and press Enter to open the Microsoft Management Console.

% Run

[

Open:

X
Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.
mmc v

Cancel Browse...

3. Click the File menu and then select Add/Remove Snap-in....
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4. Select Certificates from the list of Snap-ins, and click Add.

Add or Remove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Description:

Available snap-ins:
Snap-in Vendor [l
=" ActiveX Control Microsoft Cor...
[EdAuthorization Manager Microsaft Cor...
G Certificates Microsoft Cor...
Component Services  Microsoft Cor...
&/ Computer Managem... Microsoft Cor...
% Device Manager Microsoft Cor...
% Disk Management Microsoft and. ..
{levent Viewer Microsoft Cor...
_| Folder Microsoft Cor...
.=/ Group Policy Object ... Microsoft Cor...
§IP Security Monitor Microsoft Cor...
8 1p security Policy M...  Micosoft Cor...
2|Link to Web Address  Microsoft Cor...
= . e . -

Selected snap-ins:
[] Console Root Edit Extensions...
(3 Certificates - Current User
Remove
Move Up
Move Down
Advanced...

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer,

In the next dialog box, select Computer account and click Next.

Select Local computer and click Finish.

From the “Add or Remove Snap-ins” window, click OK.

Connex Direct
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Click > to view the certificates folder. When you open any certificates folder, you will see certificates displayed

in the right pane.

Import/Install the CA root certificate into the following folder: Certificates (Local Computer) > Trusted Root
Certification Authorities > Certificates .

&
File Action View Favorites

| 2m G 6
| Console Root
v () Cerificates - Current User
w [ Personal
| Certificates
~ [ Trusted Roet Certification /
| Certificates
~| Enterprise Trust
_ Intermediate Certification ,
7] Active Directory User Obje
~ [ Trusted Publishers
1 Certificates
_ Untrusted Certificates
~ (7] Third-Party Roct Certificati
Certificates
Trusted People
| Client Authentication lssue
7| Other Pecple
7 CurrentUser
| Local NonRemovable Certi
1 LocalMachine
| MSIEHistoryJournal
1 Certificate Enrollment Reqy
| Smart Card Trusted Roots

Window  Help

|

Issued To Issued By Expiration Date  Intende
[ Entrust Root Certifi e = = S LSS e, ant A
[JEntrust Root Certifif & Certificate X hta
Entrust.net Certific ptA
ﬁEqulhx Secure Cerf General (Dt Certhsbon Bty leSi
53] GeoTrust Global CA ntA
5] GeoTrust Primary O § Certificate Information ntA
53] GeoTrust Primary ¢ nt &
5] GlobalSign This certi isi for the nt A
s oy
LslGlobalSign Root C4 + Protects saftware from alteration after publication ot
) Go Daddy Class 2 q * Protects e-mail S nt A
[521Go Daddy Root Cef . ﬁt;ﬁ;i:;m ofa remote computer nt A
[SJ GTE CyberTrust Glo| ntA
[L]GTS Root R1 ntA
() Hill-Rom IT Service| Issued to: Go Daddy Class 2 Certification Authority lesi
CalHotspot 2.0 Trust Ry nt#
j's"ﬁ Root X1 Issued by: Go Daddy Class 2 Certfication Autharity fer/
LynxRootCA >
j :i:i:‘; ::::h::: Valid from 6/25/2004 to 6/23/2034 - ]
i
5] Microsoft ECC Pros >
EdMicrosoft ECC TSR >
Sl Microsoft Root Autf >
S Microsoft Root Cer| >
S Microsoft Root Cerf >
EglMicrosoft Root Cer| >
CalMicrosoft Time Sta 1
Tasn 1 ani im sl o
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9. Right-click the Certificates folder under Trusted Root Certification Authorities and choose All Tasks > Import.

Li Consolel - [Console Root\Certificates - Current User\Trusted Root Certificstion Autharities) Centificates] -

@ Fle Action View

Favorites  Window  Help

Friendly Nan 7
Sectigo (AAX
Seetige (Add
Affrm st ¢
Digiert Balt

<None>
<None>
<hone>
<None>
<Nene>

Certum

Certum Trust
VeriSign Clas
Sectigo (fom
Microsch Tir

Digicert
Digicen

DigiCert Glol
DigiCert Glet

Digicen

>

les 2sEO0lcE Ba
Console Root Issued To . lseued By Expirstion Date  Intended Purpoze:
v G Cartificates - Cumen User [JJAAA Certficate Services ABA Certificate Services 1273172028 Client Authenticati..
. :ﬂ:;'lmm«.(mn puthoiies || 2T Extemal C oot Addrust External CA Root 573072020 Clent At
s CafirmTrust Cemmercial AffemTrust Commercial 12317200 Client Authenticati..
1 Emterprise T LA oS > import. Baltimore CyberTrust Root SN2 Clent Authenticat.
esmnedions (R A "s—/ biuschredd 32872031 <Al>
) Active iect RS 3 bivschred3 10872025 <All>
Tusted Publis 3 btvschred sna0n <Al
Untrusted Cer New Taskpad View... 2 btvschrel3 a0z <All>
Thied-Party Re 3 bruschre0s 382031 <A
TustedPeoph oSN A Certum CA ey Clent Autherticati..
Client Autherr  Export List.. Tusted Network CA~ Certum Trusted Network A 12317209 Client Authenticat
OtherPeople ublic Primary Certficat.. Class 3 Public Primary Certficatio... /112023 Client Authenti
1 CurrentUser e JO RSA Certification Au... COMODO RSA Certfication Auth...  1/18/2038 Clent Authenticst,
Local Nonflemovable Certificates. &) Copyright (c) 1997 Microsoft C... Copyright (c) 1987 Microsoft Corp.  12/30/1993 Time Stamping
1 LocalMachine ] DigiCert Assured ID Root CA DigiCert Assured ID Rect CA 1W/8/2031 Client Authenticati...
M ournal CylDigiCert Giobal Root CA DigiCet Global Root CA /803 Clent Autherticst,
d Certificat Iment Requests (55 DigiCert Global Root G2 DigiCert Global Root G2 11572038 Client Autherticati...
St Rusted ook L,]DigiCert Global Root G3 DigiCert Global Root 63 1Ns72038 Client Autherticati.
C,IDigiCert High Assurance EV Re... DigiCert High Assurance E Root .. 11/9/2031 Client Authenticat.
<
pods

10. Follow the Certificate Import Wizard and provide the CA root certificate file path.

:-'1] NOTE An example CA root certificate is shown below.

n Certificate

General Details Certification Path

ﬂ Certificate Information

This certificate is intended for the following purpose(s):

« Ensures software came from software publisher

* Protects software from alteration after publication
* Protects e-mail messages

* Ensures the identity of a remote computer

+ Allows data to be signed with the current time

« All issuance policies v

Issued to: DigiCert Assured ID Root CA

Issued by: DigiCert Assured ID Root CA

Valid from 11/9/2006 to 11/9/2031

Issuer Statement

[ |

X

Import or install a CA root certificate onto the device (includes CSM,
CVSM, and CIWS)

Use the CSM Configuration Tool web application to install or import a CA root certificate onto the device. The

Config file (*-signed.waconfigQ) is generated by the Configuration Tool.

https://config.welchallyn.com/configurator/common/authenticate.action

Create third-party AD CS Certificate Authority Certificates

You need to request third-party certificates (AD Server & CA Root) from the Third-Party Certificate Authority with
the required Active Directory server information.


https://config.welchallyn.com/configurator/common/authenticate.action
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AD CS certificates (AD server & CA root) are auto-generated during the AC CS Role Installation and Configuration
on the AD server. No specific process is required after the installation and configuration of the AD CS Role on the
AD server to generate these certificates.

HL7 - setup details

HL7 (Direct EMR connection) setup

1. Access the Advanced Settings.

a. Touch the Settings tab.
b. Touch the Advanced tab.
¢. Enter your password and touch OK.

The General tab appears.
Touch the Network tab.
Touch the Server tab.
Select Host IP from the drop-down list of the Network connectivity method.

uohA W

Select the Direct EMR connection radio button in the Server connectivity panel.

‘ @ Advanced settings.

Radio Network connectivity method Server connectivity
( > Welch Allyn host
Security o
Data encryption o
: QP Direct EMR connection
—
Server
Bluetooth® Host address
l172.21.5.38 ’
Device IP
Host Port
6201 ’ Test network connection
Active Directory

6. Select Data encryption to turn the Security on or off in the network connectivity method panel.

If Data encryption is enabled , then Server Authentication can be turned on or off. Data encryption is
intended to keep data secure while the data is transferred over a network.

i:_l] NOTE Check or Uncheck Data encryption per the intended Secure (TLS) or unsecure connection.

7. Select Server authentication to turn the server authentication on or off in the network connectivity method
panel.

-
T l NOTE Server Authentication is the process of confirming the identity of the EMR Server by receiving
a server certificate from the server and checking it against the installed CA Root certificates on the
device.

- If checked, confirm that CA Root Certificate is loaded on the device and that the Server Certificate
is loaded on the EMR Server for the successful connection.

- If unchecked, the CA Root Certificate on the device and Server Certificate on the EMR Server are
not required for the successful connection.
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8. Touch the keyboard to enter an IP Address or FQDN of the EMR Server in the Host address field.

9. If needed, touch the keypad to enter a Host Port number in the Host Port field for the EMR Server that is
listening for a connection.

10. Touch Test network connection to test the connection of the device to the EMR Server.

NTP server- setup details

Set up the NTP server

1. Access the Advanced Settings.
a. Touch the Settings tab.
b. Touch the Advanced tab.
¢. Enter your password and touch OK.
The General tab appears.
2. Touch the Date/Time tab.
3. Touch the Enable NTP checkbox to enable NTP.

é_l NOTE Check the Enable NTP option as the first step of connecting with the NTP server to
synchronize the device Date/Time clock over the internal or external (Internet) network.

4. Enter the Domain name or FQDN or IP address of the NTP server.
To enter this information, touch the keypad in the Domain text field and enter either the Domain name or
Host name (FQDN) or the IP address of the NTP server.

5. Touch Test network connection to test the connection of the device to the NTP Server and to synchronize
the device Date/Time.

@ Advanced settings.

Language Date format

mm/dd/yyyy
Profiles

Time zone

Date / Time [(GMT) Greenwich Mean Time: Dublin,...]

Open Source
[J] Enable NTP
Domain
[sknpdlab.com ] Test network connection

General If t | Networ! l i “
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Project workflow

Connex Direct

HL7 Out of the Box (OOB) Integration Project Workflow
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c .
2c S ¢ D‘SCUS_S_ Network Best
<238 onnectivity L Practices
= 5 Start Options and
L3 Technol 80018745 'y
v 3 & echnology
=
[
'8 Received
o Customer Yes- +
&5 PO? - -
c 0 Configure device
@
= c Collect Network " with configuration ety custc')mer
g ® Coordinate the device
= Data X . —»  tool (include  — < .
S Appendix A Project Meetings custom data, if configuration to
g PP required)l load onto devices
c
o Device in-service Connected device
< training training
ﬁ (Account (Clinical / Field
g Manager) Service)
Yes
h 4
Configure host
Load device side HL7 interface . Execute .
configuration onto [~ to receive device [~ intzdargglonftae:tdin - WelchAllyn Tesm:j%
a test device messages per e J Appendix B el
5 60080809
5 1 "
=
w
=1
o
Project Sign-off [4— Go-Live <

Troubleshooting network issues

Condition

Cause

Remedy

Date/Time “Test network
connection” failed

The device is not connected to a
network and therefore does not have
an IP address

Verify that the device has an IP address:
Settings > Advanced > “IP address”.

The device does not have a properly
configured NTP server

Review the NTP server configuration and
make sure NTP is properly configured.

The device does not have a properly

configured NTP connection

Verify the Date/Time configuration on the
device: Settings > Advanced > General >
Date/Time:

a. “Enable NTP” is checked.

b. The proper NTP server address appears
in the “Domain” field (Domain, FQDN, or IP
Address).
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Condition

Cause

Remedy

The device does not have Internet
connectivity

Connect the device to the Internet. (An
Internet connection is required when the
NTP server is outside the local network.

Your network firewall is blocking UDP
port 123

Verify that the network’s NTP port is open:
typically, UDP 123.

The path to NTP server cannot be
reached

The path to NTP server cannot be reached

Server “Test network
connection” failed

The device is not connected to a
network and therefore does not have
an IP address

Verify that the device has an IP address:
Settings > Advanced > IP address.

The device does not have a properly
configured HL7 server connection

Verify the server configuration on the
device: Settings > Advanced > Network >
Server:

a. Server connectivity = Direct EMR
Connection.

b. Host IP is selected.

. The proper address appears in the Host
Address field (FQDN or IP Address).

d. The proper port appears in the Host Port
field.

Server authentication failed

Load the proper Root Certificate on the
server and the proper CA Root Certificate in
the device using the device configuration
tools.

Your network firewall is blocking the
TCP port used for the HL7 host
connection

Verify that the network’s TCP host port is
open.

The path to EMR server cannot be
reached

Check network topology to ensure there's
a valid path from the device to the EMR
server.

Active Directory “Test
network connection”
failed

The device is not connected to a
network and therefore does not have
an IP address

Verify that the device has an IP address:
Settings > Advanced > IP address.
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Condition

Cause

Remedy

The device does not have a properly
configured Active Directory server
connection

Verify the server configuration on the
device: Settings > Advanced > Network >
Active Directory:

a. “Enable Active Directory” is selected.

b. The proper domain name appears in the
“Domain name” field.

. The proper group name appears in the
“Group” field.

d. You are using the proper Clinician ID
type, it matches what you are scanning,
and the clinician is in the Active Directory.

e. You are using the proper Authentication
User name.

f. You are using the proper Authentication
password.

Server authentication failed

Load the proper Root Certificate on the
server and the proper CA Root Certificate in
the device using the device configuration
tools.

Path to Active Directory server
cannot be reached

Check network topology to ensure there’s
a valid path from the device to the Active
Directory.

Date/Time is incorrect on
the device

Time zone is configured incorrectly

Confirm the device's time zone
configuration is set to the correct time
zone.

DST adjustment is not configured
correctly

Configure the DST setting appropriately
(enable or disable DST adjustment
depending on location).

The device is syncing time to a
different source than the rest of the
network

Configure the device to configure its date
and time to the same source as the rest of
the network.

Failed to identify a patient

The device is not connected to a
network and therefore does not have
an IP address

Verify that the device has an IP address:
Settings > Advanced > IP address.
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Condition

Cause

Remedy

The device does not have a properly
configured HL7 server connection

Verify the server configuration on the
device: Settings > Advanced >Network >
Server:

a. “Server connectivity” = Direct EMR
Connection.

b. “Host IP” is selected.

c. The proper address appears in the “Host
Address” field (FQDN or IP Address).

d. The proper port appears in the “Host
Port” field.

Scanned patient ID is not the proper
barcode

Verify the patient ID scanned is a valid
patient ID barcode.

Scanned patient ID could not
be found in the host database
containing the patient census

Verify the patient ID scanned is in the host
database.

The HL7 host is not properly
configured to receive census query
requests

Verify that the host is configured to receive
census query requests on the configured
port.

Your network firewall is blocking the
TCP port used for the HL7 host
connection

Verify that the network’s TCP host port is
open.

Server authentication failed

Load the proper Root Certificate on the
server and the proper CA Root Certificate in
the device using the device configuration
tools.

Failed to authenticate a
user

The device is not connected to a
network and therefore does not have
an IP address

Verify that the device has an IP address:
Settings > Advanced > IP address.

Scanned Clinician ID is not the proper
barcode

Verify the Clinician ID scanned is a valid
Clinician ID barcode.

Scanned Clinician ID is not contained
in the user authentication database

Verify the Clinician ID scanned is in the user
authentication database.
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Condition

Cause

Remedy

The device does not have a properly
configured Active Directory server
connection

Verify the server configuration on the
device: Settings > Advanced > Network >
Active Directory:

a. “Enable Active Directory” is selected.

b. The proper domain name appears in the
“Domain name” field.

. The proper group name appears in the
“Group” field.

d. You are using the proper Clinician ID
type, it matches what you are scanning,
and the clinician is in the Active Directory.

e. You are using the proper Authentication
User name.

User ID entered is not valid

Verify that the user ID entered is accurate
and a valid ID in the Active Directory.

Server authentication failed

Load the proper Root Certificate on the
server and the proper CA Root Certificate in
the device using the device configuration
tools.

Failed to send vitals

The device is not connected to a
network and therefore does not have
an IP address

Verify that the device has an IP address:
Settings > Advanced > IP address.

The device does not have a properly
configured HL7 server connection

Verify the server configuration on the
device: Settings > Advanced > Network >
Server:

a. Server connectivity = Direct EMR
Connection.

b. Host IP is selected.

. The proper address appears in the Host
Address field (FQDN or IP Address).

d. The proper port appears in the Host Port
field.

Your network firewall is blocking the
TCP port being used for the HL7 host
connection

Verify that the network’s TCP host port is
open.

Server authentication failed

Load the proper Root Certificate on the
server and the proper CA Root Certificate in
the device using the device configuration
tools.
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Condition Cause Remedy

The configured custom data cannot  Verify the custom data configuration and
be imported into the EMR make sure the fields going to the EMR
match what the EMR is expecting.

EMR response does not match device Verify EMR response to the device's HL7
interface interface specification.

The EMR rejected the Clinician ID Verify Clinician ID sent from the device is a
valid Clinician ID for the EMR.

EMR or interface engine is down Call your EMR or system administrator.
Data was rejected for one of the Check the EMR or interface engine
following reasons: message logs to determine root cause.

« Patient ID not found
Clinician ID not found

- vitals date/time in the future

« device received a message
timeout notification
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|dentifying the monitor and subsystems

This explanation of the monitor labeling is provided to assist you in identifying these particular parts by serial
number. The part numbers appearing on the labels are internal part numbers and will not be found in the list of
field replaceable units (FRUs) included in this manual.

Future revisions of a part may not always be backward compatible with a legacy part. To determine the correct
replacement part for your unit always provide the serial number and model when ordering.

Monitor serial number and model label

The model number and serial number can be found on a label on the back housing.
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Serial number and format code

Serial number MMMMXXXXWWYY
MMMM Manufacturing plant
XXXX Sequential number
WWwW Week of manufacture
YY Year of manufacture

Monitor circuit board and internal options label

Monitor circuit board and internal options label PCBA identifier

Circuit board and internal option labels

PCBA identifier XXXXXX BOM Y DWG Z
XXXXXX Baxter material number
Y Bill of material (BOM) revision

YA Assembly drawing version from current version of drawing
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Monitor circuit board and internal options label serial number

Circuit board and internal option labels

Serial number XXXXWWYYID

XXXX Sequential number

WWwW Week of manufacture
YY Year of manufacture

ID Unique vendor identifier

Model number format and code

Model configuration

m NOTE Some model numbers and product features described in this publication might not be available
in your country. For the latest information about products and features, please contact Customer Care.

The device has multiple configurations. Use the following table to determine 7100, 7300, 7400, and 7500 model
configurations. Not all configurations may be available. Model numbers include one item from each column.

NOTE For more configuration options, including approved accessories, see the accessories list in the
Instructions for use on the user documentation CD or https://direct.hill-rom.com/hillromUS/en.

NOTE If options have been added to the device, the actual configuration will not match the model
description.

Examples: 75CE-B (North America), 71XE-4 (United Kingdom)

Model Parameter Power cord
Sp02 Temperature
71=7100 Value series W = Nonin E = Braun ThermoScan PRO 6000 IR A = Denmark
X =Blank/None T =SureTemp Plus B = North America
X =Blank / None C=China

G = Argentina


https://direct.hill-rom.com/hillromUS/en
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Model Parameter Power cord
Sp02 Temperature
73 =7300 BlueTooth  C=Covidien/Nellcor E=Braun ThermoScan PRO 6000 IR K = South Korea
series M = Masimo T =SureTemp Plus N = India/UAE
R = Masimo SpO2/RRp X = Blank/None P =Thailand
W = Nonin T =Taiwan
X =Blank/None Y =ltaly
Z = Brazil
74 =7400 Wi-Fi-ready C = Covidien / Nellcor E = Braun ThermoScan PRO 6000 IR 2 = Europe
series M = Masimo T = SureTemp Plus 3=lsrael
R = Masimo SpO2/RRp X = Blank / None 4= United Kingdom
W = Nonin 5 = Switzerland

6 = Australia/New Zealand

7 = South Africa
75 =7500 Wi-Fi series C = Covidien/ Nellcor E=Braun ThermoScan PRO 6000 IR

M = Masimo T = SureTemp Plus
R = Masimo SpO2/RRp X =Blank/None
W =Nonin
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Interconnect diagram
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Service and maintenance toolset

Connex Spot Monitor

The following is the listing of tools and test equipment required to perform basic functional verification checks,
full functional verification checks and calibration, and service and maintenance on the Connex Spot Monitor.
Please refer to the device service manual for detailed instructions to service your device.

:-'1] NOTE Tools and test equipment must also be readily available to complete Baxter Technical Service
T Training for this device.

Usage
Material no. Description Qty Full Basic
General test equipment
106270 Service test box 1 X
106275 Micro USB cable 1 X
N/A Wireless router, a/b/g or 1 X
equivalent
N/A Ethernet cable 1 X
N/A PC running Windows 10 1 X X
web download Welch Allyn Service Tool 1 X X
1001120 Welch Allyn Service Tool, 1 X
Gold license
NIBP testing
407672 BP test volume repair fixture 1 X X
113670
N/A Pressure meter (must include 1 X X
at least two decimal points
and be accurate to within +0.5
mmHg)
N/A Blood pressure Y-tube 1 X X
6000-30 Single tube blood pressure 1 X X
hose, 5 feet
4500-30 Blood pressure hose, 5 ft. 1 X
620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 X X
SpO2 configuration testing
N/A SpO2 simulator 1 X X
DOC-10 Nellcor SpO2 extension cable 1 X X

SureTemp Plus configuration testing

06138-000 Cal-key, assembly, M690/692 1 X X
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Usage

Material no. Description Qty Full Basic

01802-110 Tester, calibration, 9600 Plus 3 X

Braun ThermoScan PRO 6000 configuration testing

01802-110 Tester, calibration, 9600 Plus 3 X

Notes:

« Allitems marked "N/A" in the Material no. column are OEM or off-the-shelf tools and equipment not
available from . The remaining items are available through Baxter or a Baxter distributor.

+ Allitems marked in the Full column are required for full functional verification checks and calibration. The
Welch Allyn Service Tool software and an active Gold license is also required to perform these checks. The
Gold license is obtained upon successful completion of Baxter Technical Service Training.

« Allitems marked in the Basic column are required for basic functional verification checks. The Welch
Allyn Service Tool software Standard unlicensed edition can be used to perform the NIBP checks and SWF
upgrades/updates.

Miscellaneous Tools

«  Phillips #1 screwdriver
T-10 Torx screwdriver
«  3mm hex key
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Installed Baxter service
component

Required outbound network
Domain name

IP address

Port

Service feature description

Welch Allyn Service Tool

(via Windows service
called PartnerConnect)

servicehub.iot.hillrom.com/
IP:52.224.38.138
HTTP/HTTPS port: 443

Inbound - Used by customers to
receive software/device firmware
upgrades.

Outbound - Used by customers to
send device service information.

IP: 12.38.86.181
TCP port: 5094

Used to activate the Service Tool
and enable device feature licenses.

(This IP address does NOT respond
to "ping.’)

PartnerConnect
software

servicehub.iot.hillrom.com/
IP:52.224.38.138
HTTP/HTTPS port: 443

Used by customers to receive
software/device firmware upgrades
from the Cumulocity platform.

Connex Server

(via Windows service
called PartnerConnect)

partnerconnect.iot.hillrom.com
IP: 52.224.38.138
HTTP/HTTPS port: 443

servicehub.iot.hillrom.com/

Inbound - Used by customers to
receive software/device firmware
upgrades.

Outbound - Used by customers to
send device service information.

Teamviewer Host

IP: multiple depending on geographic

location

Default TCP port: 80/443

(can be configured to use TCP port 5938)

Used by Baxter Service personnel to
access a customer's machine (with
customer's consent/permission) to
address device issues.

Welch Allyn Service Hub

servicehub.iot.hillrom.com/
IP:40.76.153.225 (inbound)
IP:52.224 .38.138 (outbound)
HTTP/HTTPS port: 443

Used by customers to view the
status of their devices and deploy
firmware upgrades and device
configurations. The portal requires
prior account setup.

File outbound types

Jog, xml, zip, .txt

File inbound types

tar.gz, .tar, .seq, .wsf, .pim, xml, *.txt, *.pdf



https://servicehub.iot.hillrom.com
https://servicehub.iot.hillrom.com
https://partnerconnect.iot.hillrom.com
https://servicehub.iot.hillrom.com
https://servicehub.iot.hillrom.com
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Date: Time:
Device name: Serial number:
Technician: Service tool version:

NIBP tests
Leak test

Specification Actual reading Pass Fail
Max: 5

Overpressure test

Mode Specification Actual reading

Adult mode: 280....329

Neonate mode: 130....164

NIBP accuracy check

Target pressure + 5 mmHg Pressure meter Service tool Specification Pass Fail
0 mmHg mmHg mmHg + 1 mmHg

50 mmHg mmHg mmHg + 3 mmHg

150 mmHg mmHg mmHg + 3 mmHg

250 mmHg mmHg mmHg + 3 mmHg
SpO2 tests
Masimo SpO2 tests

Test Specification Actual reading Pass Fail
SpO2 heart rate Pulse rate 61 £1 bpm bpm

61 bpm 59to 61 bpm
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Test Specification Actual reading Pass Fail
SpO2 saturation Saturation 80% £3% sat point %
80% 78 to 84%

Nonin or Nellcor SpO2 and pulse rate test

Test Specification

Actual reading Pass Fail
SpO2 pulse rate Pulse rate 60 £1 bpm bpm
60 bpm 591061 bpm
SpO2 saturation Saturation 90% +1 sat point %
90% 89t091%

Thermometry tests

Calibration key temperature test for SureTemp Plus

Temperature test Specification + 0.2°F (+ 0.1 °C)

Actual reading Pass Fail

97.3°F (36.3°C) 97.1t097.5°F 36.2t036.4°C °For°C

SureTemp Plus test

Temperature tested Specification = 0.2 °F (+ 0.1 °C) Actual reading Pass Fail
96.8 °F (36.0 °C) 96.6 °F t0 97.0 °F 35.9°Cto 36.1°C °F or°C
101.3 °F (38.5 °C) 101.1 °F to 101.5 °F 38.4°Ct038.6°C °F or°C
105.8 °F (41.0 °C) 105.6 °F to 106.0 °F 40.9°Cto 41.1°C °F or°C

Braun ThermoScan® PRO 6000 test

Temperature tested Specification = 0.4 °F (+ 0.2 °C) Actual reading Pass Fail
96.8 °F (36.0 °C) 96.4 °F t0 97.2 °F 35.8°Cto36.2°C °F or °C
101.3 °F (38.5 °C) 100.9 °F to 101.7 °F 38.3°Cto038.7°C °For°C
105.8 °F (41.0 °C) 105.4 °F to 106.2 °F 40.8°Cto 41.2°C °F or°C
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